
Welcome to Construction Application for Payment Solution  

Version 5.0  

by Sunburst Software Solutions, Inc.

Construction Application for Pay ment Solution (CAPS) is the quick and easy  way  to generate AIA
G-7 02/G-7 03 and G-7 02/7 03 CMa forms that y ou purchase and feed into y our printer OR any  of
thirteen different plain paper version of these forms.  In addition to these standard billing formats y ou
can create Retainage Applications, Billing Sheets, and standard or custom-designed Contract
Documents, 

QuickBooks Estimate, Progress Invoice, and Job information is imported from y our company  file and
with a few quick additions; these forms are generated, ready  for y our signature and mailing.

Version 5.0 is designed to interface with QuickBooks Pro/Premier 2002 through 2011  Editions as well
as Enterprise Solutions 1 .0 through 11 .0.  This includes ALL of the Premier Versions - Contractor,
Enterprise, etc.  

The original version of Construction Application for Pay ment Solution was developed in 2001; using
QuickBooks Pro 99 and 2000, and has prov ided an interface for QuickBooks since January  2002.  

Y ou will need Microsoft Office 97 , 2000, XP, 2007 , or 2010 - with appropriate updates - to generate
y our completed reports.  We have tested our program thoroughly  in all versions mentioned.

Refer to the Quick Start Guide for pointers to setting up y our new software.

Copy right 2000-2010.

No part of this manual or the contents of the in-program Help file may  be reproduced in any  form or
by  any  means (including electronic storage and retrieval or translation into any  foreign language)
without prior agreement and written consent from Sunburst Software Solutions, Inc. as governed by
United States and International copy right laws.

Products that are referred to in this document may  be either trademarks and/or registered
trademarks of the respective owners.  The publisher and the author make no claim to these
trademarks.

While every  precaution has been taken in the preparation of this document, the publisher and the
author assume no responsibility  for errors or omissions, or for damages resulting from the use of
information contained in this document or from the use of programs and source code that may
accompany  it.  In no event shall the publisher and the author be liable for any  loss of profit or any
other commercial damage caused or alleged to have been caused directly  or indirectly  by  this
document.

Phone:  (888) 348-2877 
Fax:  (866) 684-5157

Email:  sales@sunburstsoftwaresolutions.com  
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1 Sunburst Software Solutions, Inc.

1.1 Welcome

2378 Dane Hill Road, West Charleston, VT  05872

Phone:  (888) 348-2877    Fax:  (866) 684-5157

Email:  sales@SunburstSoftwareSolutions.com

Website:  http://www.SunburstSoftwareSolutions.com

Welcome to Construction Application for Payment Solution
- Version 5.0

Construction Application for Payment Solution (CAPS) is the quick and easy way to generate AIA G-702/ G-

703, G-702 CMA (Construction Manager Adviser Edition)/703, and other billing types on plain paper, OR, to

complete original AIA copyrighted G-702/G-703 and G-702/G-703 CMa forms that you purchase and feed into

your printer; as well as generate various common contract documents and billing sheets.

QuickBooks Estimate, Progress Invoice, and Job Information is imported from your company file, and with a

few quick additions; various AIA-type billing forms are generated, ready for your signature and mailing.

Construction Application for Payment Solution Version 5.0 (our current version) was written utilizing the

Intuit QuickBooks Software Development Kit (SDK) in 2001 and is designed to specifically interface

QuickBooks® Pro/Premier 2002 through 2011 and Enterprise Solutions 1.0 through 11.0,  as well as, any

future editions of the above via a compatibility update for our software when the new QuickBooks edition

is released. 

You will need Microsoft Word and Excel (97, 2000, XP, 2003, 2007 or 2010) with the appropriate updates - to

generate your completed billings and contract documents on plain paper.  We have tested this product in all

versions mentioned.

Copyright 2000-2010.  All Rights Reserved.

No part of this manual, or the contents of the in-program Help file, may be reproduced in any form or by any

means (including electronic storage and retrieval or translation into any foreign language), without prior

agreement and written consent from Sunburst Software Solutions, Inc., as governed by United States and

International copyright laws.  Products that are referred to in this document may be either trademarks and/

or registered trademarks of the respective owners.  The publisher and the author make no claim to these

trademarks.

While every precaution has been taken in the preparation of this document, the publisher and the author

assume no responsibility for errors or omissions, or for damages resulting from the use or misuse of

information contained in this document, or from the use or misuse of the programs and source code that

may accompany it.  In no event shall the publisher and the author be liable for any loss of profit, or any other

commercial damage caused, or alleged to have been caused directly or indirectly, by this document.

mailto:sales@SunburstSoftwareSolutions.com
http://www.SunburstSoftwareSolutions.com
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1.2 About Sunburst Software Solutions, Inc.

Primary Contacts:

Nancy Smyth – sales@sunburstsoftwaresolutions.

com (888) 348-2877

Ben Smyth – smyth@sunburstsoftwaresolutions.com

(888) 348-2877

Background

Nancy (Hoffman) Smyth, President of Sunburst Software Solutions, Inc., has utilized Intuit products in a

variety of industries since 1986, specializing in the construction industry, and has been a Certified

QuickBooks ProAdvisor since 1999.

Providing bookkeeping services for several small Union and Non-Union construction firms, Nancy knew

QuickBooks was a great tool to be used, not only for herself, but also by the small business owner. While

completing a job-costed payroll for 10 employees, or a progress invoice within QuickBooks was a fast and

efficient process, completing the required Certified Payroll Reports and AIA billings would take hours to

complete. Distaste for these tedious tasks led to a lengthy search, beginning in 1996, for someone to extract

this information from QuickBooks and assemble the forms, ready to be signed and submitted. 

In August 2000, a method was found for retrieving QuickBooks® information through the use of the OfficeQ

Pro product developed by DataBlox, Inc. Ben Smyth, a Software Engineer with an accounting background, who

had written software programs since 1980 for use in Municipal, Retail, Restaurant, Web Services, GPS/

Imaging, and the Travel Industries (many involving complex payroll products for use in the Commercial and

Municipal arenas), was willing to embark on this project and Sunburst Software Solutions, Inc. was born in

Lakeside, MT. 

Already familiar with Federal Prevailing Wage Laws, and Connecticut and Massachusetts Specific Prevailing

Wage mandates, research to make Certified Payroll Solution was released, and has since grown to include

various EEOC/Work Utilization Reports, provides the ability to "electronically file" certified payroll reports,

and includes a highly flexible Benefit Report that can be used to report Union Fringe Benefit or "bona fide"

plan contributions. 

In August 2001, Sunburst Software Solutions, Inc. became a Premier Member of the Intuit Developer

Network, during its initial launch, knowing that the Software Development Kit (SDK) offered by Intuit would

provide a more direct and, therefore, sanctioned means of accessing QuickBooks data. They retain their

Premier Status to date. 

After determining a market to automate AIA billings from Estimates and Progress Invoices created in

QuickBooks®, Construction Application for Payment Solution was initially released in January 2002, with the

official launch of the Intuit Developer Network and the QuickBooks Solutions Marketplace. 

Certified Payroll Solution was rewritten in January 2003, when the Intuit Software Development Kit was

updated to include access to Payroll information for Sunburst's 2003 product line. Sunburst still maintains

their original Version 4.9 of the program for use with QuickBooks® Pro 2002 and prior versions. 

In December 2004, Sunburst became a Microsoft Registered Partner and is in the process of becoming a

Microsoft Certified Partner. 

Development of Wage Manager Solution, Sunburst's newest program, began in mid-December 2004 and was

released in February 2005. Wage Manager will allow business owners, payroll administrators and ProAdvisors/
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CPA's to work with payroll wage items for multiple employees simultaneously. 

Sunburst Software Solutions, Inc. maintained their Premier Member status in the Intuit Developer Network

until September 2006. At this time, Sunburst became one of the first 10 Developers to achieve "Gold

Developer" status through rigorous testing of their software programs by an independent 3rd party software

testing company hired by Intuit, passed a "customer satisfaction survey", provided customer case studies,

and are currently involved in a ProAdvisor Review of their products. In fact, according to Shannon Adkins,

Senior Manager, Developer Engagement & Customer Marketing of the Intuit Developer Network, she stated

that the "results of Sunburst's customer satisfaction survey were higher than that of Harley-Davidson or Ford

Motor Company." 

Sunburst Software Solutions, Inc. is committed to bringing high-end functionality at a reasonable price to the

small, but growing, contractor. As of December 31, 2008, over 80% of their customers have remained users

by purchasing a moderately priced Annual Maintenance Contract, which provides compatibility and/or

conversion updates for the latest releases of the QuickBooks® product line, as well as, user requested

enhancements, and new forms as they become available. 

All of Sunburst's products have been designed to specifically meet the needs of QuickBooks® users in the

construction industry. Sunburst Software Solutions' philosophy is that QuickBooks, when properly setup and

used, will provide the backbone of the information for the final reports and billings. Sunburst will utilize that

information on a read-only basis, and missing information will be held in "linked records" within a Sunburst

program. The information from both programs will then be merged together to produce the final reports and

billings --- leaving the user with the final tasks of signing and mailing the documents. 

1.3 Construction Application for Payment Solution Development
Process

The thought process behind the design:

AIA Billings can be required to be submitted by General Contractors, Developers, Homebuilders, or

subcontractors, who performs work on many types of Commercial or Residential construction

projects

Industry standard Contract Documents may, also, be required to be submitted

It takes hours each month to complete these forms

QuickBooks contains 90% of the information required to complete these forms

The original problem was how to access this information

The SDK provides the means to query that information

Construction Application for Payment Solution will have its own database containing a link back to

QuickBooks to hold information that QuickBooks provides no means of tracking

Contract Document Manager provides a function that can access most information required for

generating Contract Documents

Excel and Word have great formatting capabilities to produce the final reports and documents

Program Design and Utilization of the QuickBooks SDK (Software Development Kit) from Intuit:

Construction Application for Payment Solution utilizes the SDK to send a query or read-only access request

to the QuickBooks file for information already entered by the user from:

Estimates (amounts on Estimate become Scheduled Value on Continuation Sheet)

Progress Invoices (amounts on Progress Invoice become Work Completed this Period on Continuation

Sheet)

Bill to/Ship to information in the Job record

The requested information is then sent to Construction Application for Payment Solution and a linked
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record is created, tying it back to the records in QuickBooks

Missing information required by AIA billing, mandates that QuickBooks has no means of holding, is

entered into a Linked record in Construction Application for Payment Solution's own database

Construction Application for Payment Solution then merges the information and sends the billing

information to Excel, where it is formatted to the correct layout and printed

Use the existing QuickBooks Write Letters Function to create Industry Standard Contract Documents

that can be customized by the end user

All of this is accomplished without adding, modifying, deleting, or voiding, any existing information

in QuickBooks  

  

1.4 How Construction Application for Payment Solution Utilizes the
Intuit SDK

Introduction:

This overview will describe how Sunburst Software Solutions, Inc. has utilized the Intuit QuickBooks SDK in

the development of Construction Application for Payment Solution.  It is written for ProAdvisors,

Consultants, other Professionals, and end-users that are interested in the development process of

Construction Application for Payment Solution, which integrates with QuickBooks.

The purpose of this document is to provide you with a better understanding of the high-level concepts

relating to the components of the QuickBooks SDK, and how they are utilized, in Construction Application for

Payment Solution.

Why an SDK for QuickBooks?

The Intuit Software Development Kit (SDK) was created for technical professionals interested in developing

applications that share data with QuickBooks® to help business owners during times when QuickBooks® data

must be managed in ways that are unique to a specific industry and cannot be accomplished within

QuickBooks itself. 

Through development of 3rd party applications using the SDK, such as Construction Application for Payment

Solution, the small-business owner no longer needs to enter the same billing information twice, once in

QuickBooks and once in a stand-alone program, or a complicated Excel spreadsheet.  Because Construction
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Application for Payment Solution was created with the SDK, it can directly share this QuickBooks data, giving

the small-business owner the best of both worlds – the power, ease, and comprehensiveness of QuickBooks,

combined with the benefits of an application tailored to the billing requirements, put forth by the American

Institute of Architects.

The SDK provides a common method for integrating an application with QuickBooks: once a developer

creates an application for one QuickBooks product, modifying that application to support any (or all) of the

other QuickBooks products, is a straightforward task.  This shared SDK approach is based on qbXML, which is

a version of XML (eXtensible Markup Language) that has been designed specifically for QuickBooks.

The QuickBooks SDK was designed with the following principles in mind:

· Keep the small-business owner in control.  The business owner, or the administrator for the

business, must authorize the connection between the 3rd party application and QuickBooks.  They,

also, set up permissions for authorized users, and access rights for each 3rd party application.  The

SDK supports the user privilege structure established within QuickBooks, wherein, for example:

certain users can access only certain types of information.  

If Construction Application for Payment Solution has not been authorized to access the QuickBooks

file, the user will receive the following error message: 

Error Code: 0x8004041A Error Message: This application does not have permission to access

this QuickBooks company data file.  The QuickBooks administrator can grant access permissions

through EditàPreferencesàIntegrated ApplicationsàCompany Preferences.

· Provide robust mechanisms to protect QuickBooks data.  The SDK provides strong error recovery,

data logging, and synchronization facilities, to ensure that data is not lost or destroyed, and that 3rd

party application data remains synchronized with QuickBooks data.  Additionally, the Intuit SDK

enforces all the QuickBooks business rules, no matter what the 3rd party application does.  

Through the use of the qbXML Validator utility, we verify that a given qbXML document conforms

to the qbXML specifications, before it is sent to QuickBooks.  All Construction Application for

Payment Solutions requests for jobs, estimate and progress invoicing transactions, have been

validated.

The SDKTest utility is used to test the request/response cycle; which accepts a qbXML request,

sends it to QuickBooks, and returns the response to Construction Application for Payment Solution.  

The qbXML specifications are built into QuickBooks and the SDK provides methods for querying

which version of the qbXML specification is supported by the version of QuickBooks that is

currently running on the user's system – having written “smart” code that checks the version and

responds accordingly, Construction Application for Payment Solution can run with multiple versions

of QuickBooks.

· Use existing programming standards.  The QuickBooks SDK uses standard interfaces and XML

formats, and as a result, is compatible with most software programming languages, such as Visual

Basic, C, C++, and Java.  Sunburst Software Solutions, Inc. utilizes Microsoft Visual Basic for the

development of Construction Application for Payment Solution.

· Adhere to a single specification for the entire SDK.  The QuickBooks products, except for the On-

line version, all use the same qbXML specification, therefore, the content and behavior of the

request and response messages between QuickBooks Pro, Premier, Premier Accountant, Enterprise

Solutions, etc., and Construction Application for Payment Solution, is consistent across all products.

Construction Application for Payment Solution utilizes the SDK to:

· Query or read information contained in the QuickBooks file from:

Estimates

Bill To/Ship to information contained in the job record
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Progress Invoices

1.5 Purpose of This Document

We recognize that the purchase or recommendation of a QuickBooks® integrated application must be based

on detailed product knowledge, and the confidence that comes from detailed product information, and

practical experience, with the program.  The information provided here supplements what you will find in the

Construction Application for Payment Solution on-line Demonstration/Presentation at 

http://www.sunburstsoftwaresolutions.com/app-for-payment-quick-tour.htm, and other information found

on our web site.

The primary objectives of this document are to:

Provide you with a brief company history and background of Sunburst Software Solutions, Inc.

Provide you with a Construction Application for Payment Solution product data sheet

Provide you with information on how we utilize the Intuit Software Development Kit

Provide you with information on how Construction Application for Payment Solution accesses the

QuickBooks® company file

Introduce you to Construction Application for Payment Solution and the features available

Outline the improvements and new features available for QuickBooks® Pro, ALL Premier Editions

2004/2005 and Enterprise Solutions 4.0/5.0 users

Help you identify which construction companies for which Construction Application for Payment

Solution is the right solution

Provide a comprehensive overview of how Construction Application for Solution and QuickBooks®

Financial software can be used together, to automate the time consuming process of manually

completing these billings, accurately and efficiently, using plain paper format or original AIA

documents, that you purchase and feed, into your printer.

The information in this document is not all-inclusive.  This document primarily focuses on features that

make Construction Application for Payment Solution the ideal solution for contractors working on projects

that require billing to be submitted using industry standard AIA billing, and the benefits of using it, in

conjunction with QuickBooks® Financial software.

We are certain that once you explore Construction Application for Payment Solution and learn about product

features, ease-of-use, and the benefits of integration with QuickBooks® Financial Software, you will be able

to make your purchase with confidence.  We welcome your comments and questions, and appreciate the

opportunity to serve you and your client's needs.

For Additional Information:

About AIA Billing http://www.sunburstsoftwaresolutions.com/about-aia-billing.htm 

Online information available at http://www.sunburstsoftwaresolutions.com

On-Line Technical Support available at http://www.sunburstsoftwaresolutions.com/aia-billing-caps/ 

Your feedback is essential to helping us improve this white paper.  Please provide your feedback via email

to sales@sunburstsoftwaresolutions.com

1.6 Construction Application for Payment Solution Data Sheet

Market Applicability:  Construction Application for Payment Solution (CAPS) is designed for Developers,

General Contractors, and Sub-Contractors, using QuickBooks® for their accounting needs, who are required

to submit contract billings using standardized AIA format in any industry.

Benefits/Market Niche:  This program provides automation for a previously time consuming task, and is

currently, the only program of this type on the market, that provides a direct interface with Intuit's

http://www.sunburstsoftwaresolutions.com/aia-billing-caps/
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QuickBooks® product line.  This allows contractors added functionality, usually found in more costly

programs.

Cost:  The software is priced from $175.00 (electronic download version), $195.00 for Priority Mail, and

$210.00 for Express Mail delivery, of a CD and manual.

Function:  Construction Application for Payment Solution (CAPS) automates AIA billing, solves duplication of

entry, manipulation of data, and totally eliminates transposition errors, by providing an integrated solution,

utilizing existing features and functionality of QuickBooks Pro®, while allowing you to maintain accurate

Accounts Receivable and Retainage Receivable accounts.

Previously, contractors using QuickBooks® have had to manually complete their AIA type billings monthly,

purchase a stand-alone product, and reenter data, or, create a cumbersome spreadsheet type form, and

enter the required data, and update it, each month.  This causes contractors to spend extra effort

duplicating entry, and maintaining two or more sets of billing entries, plus, run an increased risk of

transposition errors.  

The productivity and cost saving of eliminating duplicate data entry add up quickly.  Even a small company,

saving 4 hours a month at $20.00 an hour, equates to an estimated annual savings of $480.00 a year, plus,

frees up the people performing these functions.  

Use:  The contractor will first, enter or import Estimates, from any estimating software that provides an

interface to QuickBooks®, then on their scheduled billing cycle, they will generate a Progress Invoice from

that Estimate.  After the Progress Invoices have been generated, users will then access Construction

Application for Payment Solution (CAPS), which will retrieve base information from the QuickBooks®

Estimate, Progress Invoice and Customer: Job Record; enter data in Construction Application for Payment

Solution that QuickBooks® has no method for storing, such as, the Architect Information, project numbers,

and retainage rates.  

Based on retainage information entered by the contractor, CAPS will automatically calculate all percent

complete, fixed or variable retainage amounts, and generate completed AIA type forms similar to the G-702

and G-703 on plain paper, or, print the information on purchased AIA G-702/703 forms.  

There is no double entry of data, all CAPS specific contract information is entered once for each project, a

previous application history log is kept for each project allowing for fast regeneration of a billing, if

required.  Each program comes with a total of 30 industry standard Contract Documents that utilize a

familiar Microsoft Word® merge letter function – plus, detailed instructions for creating forms that are not

included.  In some instances, the user is required to enter information that is not accessible by the interface.

 Construction Application for Payment (CAPS) can be used on a single computer or in a network environment.

Human Resource requirements:  Anyone in the office can operate this software, by simply following the

instructions in the manual or Help file.  A basic knowledge of QuickBooks® is helpful, but not necessary, as

set-up and use of this program is very user friendly.  Most customers are able to use the software after the

first time they walk through its use with the step-by-step instructions provided in the manual or Help file. 

The most pronounced requirement is the ability to read and follow instructions.  

Each software package contains a printed manual, detailing set-up and use, with additional information

contained in the programs on-screen Help.  With the initial purchase, all customers receive 20 days of

technical support to help them use the product.  Sunburst Software Solutions, Inc. provides maintenance

services that include; software updates, product enhancements, and free basic ongoing support, via an on-

line forum.
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Technical requirements:  Contractors are required to have QuickBooks® Pro, Premier, or Enterprise

Solutions Edition; Microsoft® Word and Excel; an Intel® Pentium III class computer, minimum 256 MB RAM,

and 40 MB disk space, for our program.  All software must have current updates from the manufacturer. 

There are a few changes that are required to the Customer/Job List in QuickBooks®:  the QuickBooks®

Customer must be your General Contractor, or the company that you obtained the work through; individual

projects must be listed as Jobs, under the General Contractor; the Ship To section of the Job record should

contain, Project Number, Project Name, and Project location.  For each job that an AIA bill is required, it

must have a Customer Type of AIA Format, and the Job Status must be set to, In Progress.  All Estimates

must be entered in QuickBooks®, and the Progress Invoice function must be utilized.  

CAPS software will take only a few moments for installation.  Set-up will vary, from company to company,

and will depend on many factors, usually, 1 hour for contractors already running QuickBooks®, to 1 week for

complete set-up of QuickBooks®, from scratch.

New Features as of July 2004:  

Added the ability to print on AIA G-702/703 documents, purchased by the user, for those rare times

that a plain paper version is not acceptable

An increased ability to deal with taxable contracts; splitting sales tax between original contract,

current change orders, and previous change orders.

Increased functionality provided by the Intuit Software Development Kit will allow users of the

2004/2005 Editions of QuickBooks® - including the Contractors Edition and Enterprise Solution 4.0/5.0

only, to subscribe to what is known as QuickBooks data events, or simply, data events. 

Automatically have QuickBooks notify CAPS when a job is added, modified, deleted, merged, with

another job, or, if you have condensed your company file.  These changes are called QuickBooks data

events, or simply, data events.  This will help you with setup, as you can add the job to CAPS at the

same time that you add it to QuickBooks, while you have all the necessary information right in front of

you.

The Contract Documents now reside within the CAPS Program's Contract Document Manager.  This

change provides access to both QuickBooks, as well as, CAPS data, and increases the overall

functionality of this module.

Print on original AIA G-702 CMa - Construction Manager Advisor Edition.

Use the Contract Document Manager to complete original AIA documents G-706, G-706A, G-707, and

G-707A.

Easily and efficiently handle negative adjustments to contracts that result in the need to create Credit

Memo's in QuickBooks.

A "form alignment" option has been included, so that information can be adjusted up, down, right or

left, when printing on AIA original documents.

Additional method of Retainage has been included, where the retainage can be changed with each

draw, and is shown as an accumulating balance on the G-702.

Easily obtain or check for program updates, by going to the CAPS Help Menu, choosing About, and

clicking the Log Into Support Area button.

G-703 shows 2 decimal places for percent

G-703 for Retainage Requisitions now shows Retainage # before the application number.

G-703, the Total Percent Complete will now print.

New Features as of November 2005

A second newer AIA original version of the CMA form has been added

The alignment process of Original AIA forms has been enhanced as follows:

Adjusting forms has been converted to inches
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Each individual field on any AIA Original form may now be adjusted

During the alignment test printing, you are prompted to print the header and detail pages

An alternate plain paper form has been added that includes a PO number and Job Code

Allows for rounding to the nearest dollar of lines 4-8 of the G-702

Page totals can be added to continuation sheets

Running totals can be added to continuation sheets

Subtotals may be assigned after certain items on the continuation sheet, using the Detail screen

Page breaks may be assigned after a particular item on the continuation sheet, from the Detail Screen.

Set Company Defaults for Billing, Printing, Notary, and Misc. Document fields.  While your original

selections become the Default for each job, these options can be changed at the Job Level, for

individual jobs.

A line 7 adjustment may be made in each period billing

A warning is issued when a new job is created, and the Original Contract amount is pre-filled by the

program, as the Estimate Total.

Multi-company operation has been added.  This allows for multiple companies to be easily accessed

from the program.

Applications for Payment can be saved as Excel files.

Previewing and printing each application will be faster.

Negative adjustments have been added.

New Digital Code Signing has been implemented, as the previous one has expired.

A Billing Sheet has been added that is useful for determining the next draw; it contains the Schedule of

Values, Completed, Stored, and Remaining, for each detail line on the Continuation Sheet.

Help is available on each screen by clicking on the ? in the lower right corner.

Repair options added to the Help Menu for Registry Entries and QuickBooks reboot

New Features as of April 2006

An option has been added to allow for the Contact Name and Phone Number to be printed AFTER the

Company Name & Address, instead of, the default behavior of, before the company name and address.

An error message has been added where all copies to print are set to 0 (zero)

The Contract Documents have been digitally signed.

The Schedule of Values in the Contract Document Manager has been enhanced to place the entries in a

table.

Improvements to Sales Tax tracking and distribution.

New Features & Functions as of 12/31/2006

Vista Compatibility

Compatibility for QuickBooks 2007.

Four new plain paper forms have been added:

Replaces "To Owner" with To GC or General Contractor and "From Contractor" with From

Subcontractor

Replaces "To Owner" with To GC or General Contractor, "From Contractor" with From

Subcontractor and "Architect" with Engineer.

Non-Notarized Invoice format replaces the G-702 format. 

Non-Notarized Statement format replaces the G-702 and shows prior payments from QuickBooks in

Line 7.

A new Backup & Restore function has been created and replaces the existing features.  The new

Backup function creates a single file that can be copied to a CD or other removable media.  The

Restore function will allow you to restore a single file or all files from a previous backup.  

Set an Automatic Backup routine for each time you correctly Exit the CAPS program (File -> Exit).

Specify the number of backups to keep for both the current day and for prior backups.



Construction Application for Payment Solution11

© 2002-2011 Sunburst Software Solutions, Inc.

A calendar has been added to all date files.

Changes to the Contract Document Manager - total payment s received, last payment received, and

last payment date are now retrieved from QuickBooks and can be placed in documents.

Better handling of multiple estimates for the same Job in QuickBooks.

Enhanced Error Reporting now includes instructions for resolving the error at hand.

New Options:

Print Customer Contact info when printing on AIA Originals

Omit the printing of Lines 5A & 5B when the retainage is a variable rate.

New Features as of October 2007

Compatibility for QuickBooks 2008.

Enhanced program update procedure that is easier to download and install updates.

Updated In-Program Help & Manual

New plain paper format which has double height detail lines on the Continuation Sheet, for legibility.

New "Track Materials" plain paper format.  This form uses the Stored Materials, as an accruing balance

as shows a total for this on the Continuation sheet and subtracts the Stored Materials from current and

previous billings on the G-702 cover sheet.

New Features & Functions as of December 31, 2008

Compatibility for QuickBooks 2009.

Updates links to our new website.

Adds links to pay Annual Maintenance, accessed from the Help menu -> On the Web.

Allows you to access Contract Documents from the CAPS Edit menu -> Jobs screen.  When accessing

the Contract Documents in this manner, you will be prompted to select the document to use.  You will

not be able to select Vendors or Employees accessing the Contract Document Manager this way.

Allows you to access the Contract Document Manager from the CAPS Print screen.

All In-Program Help is now Vista compatible.

Add new plain paper forms:

Change Order List form- displays a listing of current period Change Orders on the G-702.  If you

use this form, the DESCRIPTION of your QuickBooks Item that you use for the Change Order MUST

include a date and a change order # with the # sign before the actual number -  i.e. #2, #3, etc.

Alt B form - includes a signature line for the Inspector of Record, Architect/Engineer, and Owner's

Representative.

Bognet Form - used in Maryland.

Kentucky Schools Form - which shows Owner Purchase credit.

Enlarges maximum file sizes.

New Features & Functions as of December 2009

Setup Users, passwords and user permissions

Adds a "Special Corrections" tool to aid users when they need to resolve common QuickBooks data

entry errors, such as deleting lines form and Estimate after issuing one or more progress invoices.

Windows 7 compatibility

QuickBooks 2010 compatibility

Contract Document Manager updates - Conditional & Unconditional Lien Release Waivers Upon Final

Payment

Allows for multiple lines per description on all plain paper forms

Additional Plain Paper billing forms: Owner-Subcontractor-Engineer, Owner-Contractor-Engineer

New Features & Functions as of September 2010

QuickBooks 2011 compatibility
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Add Quantities to AIA Billings for Estimated, Previous, Current, Stored, Previously Stored, and Unit

Prices.

New plain paper forms adds Quantities columns

Calculate Retainage by Dollars, instead of percent

Add a new Non-Notarized Invoice format

Add HUD-51001, 51002, and 51003 forms

Includes Contractor's Qualification Statement

Contract Document Manager updates - Create G-706, G-706A, G-707, and G-707A forms on blank

paper

1.7 Which Construction Companies are Right for Construction
Application for Payment Solution?

Construction Application for Payment Solution will not be suitable for every construction  business, however,

it will be a suitable recommendation for Commercial or Residential contractors, who perform work on jobs

that require billing to be submitted following Standard AIA Billing requirements.

1.8 What are AIA Billing Requirements - Who is the AIA?

AIA billing is a standardized method of construction contract billing developed by the American Institute of

Architects, by which the contractor can apply for payment due, and the architect can certify that the payment

is due.

AIA Form G-702© Contractors Application for Payment is a summary of the information being submitted

on the Continuation Sheet, and requires the contractor to show the status of the construction contract to

date; including, the Original Contract Sum, Net Change by Change Orders, Contract Sum to Date, Total

Completed and Stored to Date, the amount of Retainage (if any) on Completed Work, Stored Material, and

Total Retainage to date, the Total Earned Less Retainage, the Total of Previous Certificates for Payment,

Current Payment Due, Balance to Finish, including Retainage, and a summary of Current and Previous Change

Orders - indicating if the Change Orders were, an Addition to or a Deduction from, the Original Contract

Amount.  This document must be signed by the contractor and notarized, prior to submission.  View our plain

paper version of the AIA G-702; Application for Payment

AIA Form G-703© Continuation Sheet breaks down the contract sum into portions or segments of the work,

in accordance with a Schedule of Values, required by the General Conditions of the contract.  This form

serves as, both the contractors application for current payment due and the architect's certification that

payment is due, to the contractor.  Its use can expedite payment and reduce the possibility of errors.

If the application is properly completed and acceptable to the architect, the architect's signature certified to

the owner that a payment in the amount indicated is due, to the contractor.  This form allows the architect

to certify an amount different than the amount applied for, with explanations provided by the architect.

In looking at our plain paper version of the AIA G-703; Continuation Sheet, you can see that Columns A, B,

and C should be completed, by identifying the various portions of the Project, and the Scheduled Values

should be consistent with the schedule of values submitted to the Architect, at the beginning of the project. 

http://www.sunburstsoftwaresolutions.com/download-document/standard-g-702.htm
http://www.sunburstsoftwaresolutions.com/download-document/g-703-continuation-sheet.htm
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This breakdown should be used consistently throughout the project, using multiple pages, when necessary. 

(Construction Application for Payment Solution (CAPS) pulls this information from your QuickBooks

Estimate).

Column D is the Total of Work Completed from the Previous Applications amounts in Column D & E.  (CAPS

keeps track of this for you.)

Column E is the value of Work completed at the time of the current application.  (CAPS pulls this information

from your QuickBooks Progress Invoice.)

Column F is the value of Materials Presently Stored on the Job Site for which you are seeking payment.

(CAPS keeps track of this, as QuickBooks provides no mechanism for doing so.)

Column G is the Total of the amounts shown in Columns D, E, & F.  (CAPS does all this math so you don't

have to!)

Percentage Complete is calculated by dividing Column G by Column C.  (CAPS does all this math so you don't

have to!)

Column H is the difference between Column C minus Column G.  (Again, CAPS does this math so you don't

have to.)

Column I is normally used ONLY for contracts where variable retainage rates are permitted on a line-item

basis.  It DOES NOT need to be completed for contracts that have a consistent rate of retainage held over

the entire contract.  (CAPS has an option that you can turn on to do this, even if the job has a fixed rate of

retainage.  Additionally, you can choose to have it show the percentage rate or the dollar amount, that is

being held.)

Change Orders are listed separately, either on their own Continuation Sheet, or at the end of the original

Schedule of Values.

*AIA Forms G-702 and G-703 are copyrighted by the American Institute of Architects and fall under copyright

laws.

NOTE: Copyright laws prohibit software vendors from exact duplication of the forms themselves - our

software provides all the data in a similar format, for printing directly onto plain paper, OR, original AIA

forms that you purchase and feed, into your printer.

1.9 System/Software Requirements

System Requirements:

Intel® Pentium Class machine a minimum, Pentium III recommended. 

Minimum RAM 32 MB, 64 MB or more recommended. 

25 megabytes of disk space for program.

2X CD-ROM drive for program delivery via CD-ROM

Internet connection to receive product updates & enhancements 

Software Requirements:

Windows® 7 (32 OR 64-bit) with the latest Service Pack applied OR

Windows®Vista with the latest Service Pack applied OR 

Windows® Server 2008 with the latest Service Pack applied OR

Windows® Server 2003 with the latest Service Pack applied OR
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Windows® XP Professional with the latest Service Pack applied OR 

Windows® XP Home Edition with the latest Service Pack applied OR

Windows® 2000 with the latest Service Pack applied OR

Windows® NT 4.0* Service Pack 6 OR

Windows® ME* with the latest Service Pack applied OR 

Windows® 98* (SE) with the latest Service Pack applied

Microsoft® Word and Excel 97, 2000, 2002 (XP), 2003, 2007 or 2010 with the latest Service Pack applied - for

printing plain paper versions.

*Compatibility with QuickBooks Financial Software

QuickBooks® Pro 2002, 2003, 2004, 2005, 2006, 2007, 2008, 2009, 2010, 2011 OR

QuickBooks® Premier 2002, 2003, 2004, 2005, 2006, 2007, 2008,2009, 2010, 2011 OR 

QuickBooks® Premier Accountant Edition 2002, 2003, 2004, 2005, 2006, 2007, 2008,2009, 2010, 2011,

OR 

QuickBooks® Premier Contractor Edition 2003, 2004, 2005, 2006, 2007, 2008,2009, 2010, 2011 OR 

QuickBooks® Enterprise Solutions 1.0, 2.0, 3.0, 4.0, 5.0, 6.0, 7.0, 8.0, 9.0, 10.0, 11.0

QuickBooks® Enterprise Solutions Accountant Edition

QuickBooks® Enterprise Solutions Contractor Edition

QuickBooks® Enterprise Solutions Professional Services Edition

*NOTE:  Refer to QuickBooks requirements.  Windows NT, ME, and 98 are not supported by QuickBooks

Pro/Premier 2005 or Enterprise 5.0 versions.

1.10 Construction Application for Payment Solution Features

This listing of features is not intended to be all-inclusive.  The more basic and common features mentioned

here, are those considered to be of significant value to targeted construction clients, and those central to

the integration of Construction Application for Payment Solution, with QuickBooks Financial Software data.

Features:

Track Architect information for each job

Track Federal, State, and Architect Projects numbers, for individual jobs

Accurately handle Fixed, or any one of several, Variable Rates, of Retainage methods

Easily indicate stored materials

Filter for "Non-AIA" or private jobs

Select if AIA billing is to be generated on plain paper in a similar format, or on several different AIA

original documents, purchased by the end user

Reliably track original bid amounts and Change Orders

Easily deal with Taxable Contracts

Generate Retainage Requisitions throughout the contract, when submitting the final draw, or within
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a specified time, after the contract is completed

Easily handle negative contract adjustments that result in the creation of a Credit Memo in

QuickBooks.

Easy setup for fast startup

Excel & Word export of data

Easy Job management

Maintains QuickBooks administrator and password controls

Network ready – install on as many computers, as necessary

Track multiple jobs

Additional items are covered in detail, in the complete manual or in-program help, such as:

Excellent flexibility concerning the implementation of CAPS midway through an existing project

Two proven methods for tracking Retainage Receivable in QuickBooks 

Creating a Memorized Report in QuickBooks to monitor Retainage Receivable

Two proven methods for tracking Retainage Payable in QuickBooks

Reliably track Change Orders

Creation of new and specific Purchase Orders to monitor Subcontract bid vs. actual costs

Reliably using CAPS in conjunction with QuickBooks, to generate AIA billing for Time and Material

Jobs

Much more
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2 Quick Start Guide
Every day, we speak with QuickBooks users, Certified QuickBooks ProAdvisors, CPA's, Consultants, and IT

people.  Each of these individuals have varying levels of experience using QuickBooks in the commercial

construction industry and AIA Billing requirements.

This manual must accommodate everyone; from the new QuickBooks user, to the Certified QuickBooks

ProAdvisor, Subcontractors, General Contractors, Union Shop, Non-Union Shops, people who have been doing

AIA Billing by hand for years, and those who have never done an AIA Draw - hence, the length of this manual.

 It is setup in a logical fashion; starting with QuickBooks required setup - because QuickBooks provides the

backbone of the information for your final billings.

Many long-time QuickBooks users and ProAdvisors feel that they "know QuickBooks" and, therefore, feel that

they can skip the Setting Up Your QuickBooks File for use with CAPS  section.  This choice is a common

mistake  that  results in blank spots on the final billings, errors, frustration, and overall dissatisfaction with

what is really a very robust software program.  

We would like to stress, that while you may know QuickBooks, you need to familiarize yourself with what

CAPS expects to find in your QuickBooks company file, in order for your billings to be complete and accurate.

 

Feeling overwhelmed?  Don't be - it's not that bad.  Watch the Audio Video and/or Flash Training

Demonstrations found in the Construction Application for Payment Solution Training, Support & Resource

Center - http://www.sunburstsoftwaresolutions.com/aia-billing-caps/ 

The Audio/Video Demonstrations are broken into 4 parts and will put you on the right track for successful

billing generation and is far less time consuming, than reading this manual.  The items listed below will point

you in the right direction for additional information on critical topics, found in the Table of Contents.:
1. Download & Installation Video - provides a complete overview  of how to download the Construction

Application for Payment Solution program electronically from our Web Service Center, save it to the

hard drive of your computer, and install the program.  Includes common Vista problems and

resolutions.   25 minutes.
2. Initial Setup Video - walks you through entering your license information, granting CAPS permission

to access your QuickBooks file, and the initial setup of CAPS and various AIA Billing preferences NOT

handled by QuickBooks.  27 minutes
3. QuickBooks Setup - provides a review of your QuickBooks company file setup and the information that

CAPS "expects" to find there in order to accurately generate your billings and contract documents.  25

minutes
4. Running CAPS - an overview of running your first set of AIA billings and the creation of one-time

linked records to hold additional information that QuickBooks has no means of tracking.  30 minutes. 

The Audio/Video training will provide you with a very thorough step-by-step overview of the program, and

you can actually "see it in action".  The Training demonstrations are far less time consuming than reading

the entire manual, however, the items listed below will point you in the right direction for additional

information on critical topics - refer to the Table of Contents for appropriate page numbers.

IMPORTANT NOTE:  All links below are working links, if you are accessing the Quick Start Guide from both

the .pdf manual and In-Program Help.

General Windows Checks & Updates:

Update your Windows operating system; obtaining Critical Updates

20
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Verify that you have the latest service packs for Word & Excel - required to print

Read and verify the information found in "Important Information for Windows Vista & Windows 7

Users "

In QuickBooks:

Verify that you have the latest maintenance release for QuickBooks Pro/Premier/Enterprise 

Verify that your Preferences  are set correctly

Read and become familiar with Things you absolutely cannot do

Verify Set-up of QuickBooks Jobs

Read how to "make" QuickBooks track Retainage Receivable  and/or Retainage Payable

Read the Overview  of Using QuickBooks for Estimating

Read about Creating a Progress Invoice from your Estimate

Construction Application for Payment Solution:

Installing Construction Application for Payment Solution

Follow the instructions for Installation & Initial Connection to QuickBooks

Grant Permissions for CAPS to access your QuickBooks 2008-2011/Enterprise 8.0-11.0  company

data file

Complete the initial System Setup, beginning with Address & Default Information , Options , AIA

Form Printer Alignment , QuickBooks Menu & Notification , and Data Locations

You are now ready to begin Generating AIA Billings

Special instructions are included for:
1. Implementing CAPS in the middle of a current project
2. Migrating to CAPS from another billing program
3. Billing with different rates of retainage on different line items
4. Deal with fixed rate retainage changes, at different points in the contract
5. Deal with variable rate retainage changes, at different points in the contract
6. Effectively handling change orders
7. Time & Materials billing
8. Accounting for Stored Materials
9. Handling Taxable Jobs

Important Note:  Some people find that the manual is very overwhelming, because it contains so many pages

- please be aware that it is so, because we deal with a wide range of contractors, people who have been

using a QuickBooks file that someone else setup (and they have never had to add anything new), and users

who are brand new to QuickBooks.  All of these combinations make for a lot of "instructions".
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3 QuickBooks Setup - Administrator Manual

3.1 How To Use This Manual

This manual must accommodate everyone; from the new QuickBooks user, the Certified QuickBooks

ProAdvisor, the IT person, Subcontractors, General Contractors, Builders, and Developers - hence, the length

of this manual.  It is setup in a logical fashion; starting with QuickBooks required setup.

Every day, we speak with QuickBooks users, Certified QuickBooks ProAdvisors, CPA's, Consultants, and IT

people.  Each of these individuals have varying levels of experience using QuickBooks in the commercial

construction industry and with AIA Billing requirements.

Many long-time QuickBooks users and ProAdvisors feel that they "know QuickBooks" and, therefore, feel that

they can skip the Setting Up Your QuickBooks Company File  section.  This choice is a common mistake

that results in blank spots on the final billings, errors,   frustration, and overall dissatisfaction with a very

robust piece of software.

We would like to stress, that while you may know QuickBooks, you need to familiarize yourself with what

CAPS expects to find in your QuickBooks company file in order for your billings to complete and accurate. 

Therefore, throughout this entire manual, you will see sections containing the following graphics:

These sections relate directly to AIA Billing functions and should be reviewed carefully.

Administrator Tasks - these tasks should be performed in QuickBooks by the QuickBooks

Administrator, in single-user mode when applicable.

Audio/Video Training - we will provide you with the title of the Audio/Video training

demonstration where this topic is covered.  Audio/Video's require Windows Media Player and sound

and are designed so that you can watch/see the step in action, pause the video, go perform the

action, and then come back and resume the video.

Important Notes - a special "call out" telling you why something is important.

QuickBooks Training - we will provide you with links to Basic and Advanced QuickBooks Training;

located either on our website, in the On-Line Support Area http://www.sunburstsoftwaresolutions.

com/technical-support.htm; or from within Construction Application for Payment Solution, by

choosing Help -> Contents.

For additional QuickBooks tips, techniques, and training, visit the QuickBooks Resources section of our On-

Line Support Area at http://www.sunburstsoftwaresolutions.com/technical-support.htm

3.2 Setting Up Your QuickBooks File for use with CAPS

We believe that your QuickBooks file should provide the "backbone" of the information that is

required on your AIA Billings, and we use as much information as possible from QuickBooks, in

order to do just that.

Audio/Video Training Available:  A 30 minute video called Construction Application for Payment

Solution - QuickBooks Setup Video covering this section is available on your Installation CD or in

our On-Line Support Area using this url - http://www.sunburstsoftwaresolutions.com/construction-

application-for-payment-free-training/view-category.htm 

20
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With this being said, you need to be aware that we may use portions of the QuickBooks data file to hold this

information that you currently are not utilizing, therefore, it is in your best interest to carefully review the

following sections to ensure that your billing comes out right the first time.

In some cases, this may mean only a cursory glance comparing the setup in QuickBooks, to screenshots and

instructions contained within this manual - in other cases, it may mean some setup for you, upfront.  In

either case, you should find these instructions to be beneficial to you and/or your client and their company.

3.2.1 QuickBooks Required Setup

As Construction Application for Payment Solution reads approximately 80% of the information directly

from the QuickBooks data file, there may be some setup required by you in the data file in order for

CAPS to accurately retrieve required information.  Those changes are outlined below, and are covered

in the Training Demonstrations; found on our website at http://www.sunburstsoftwaresolutions.com/

construction-application-for-payment-free-training/view-category.htm or on your installation CD.

Look for the Construction Application for Payment Solution - QuickBooks Setup Video

Customers and Jobs

If you have not already set up the QuickBooks Customer:Job List (in the Customer Center) to reflect

Customers as well as, the various jobs that you are performing work on for this customer, you should do

so now, following the simple guidelines below:

The QuickBooks Customer  should be the General Contractor or the Awarding Authority through

whom you will receive payrrment from for the work performed.  All pertinent "Bill to Address"

information should be completed.  The information entered into the "Bill To Address" will

automatically transfer over into the "To Owner" block on the G-702.  Once the Customer record has

been established - Job records should be created below the Customer or Awarding Authority.

The Job  record will contain the same "Bill To" (or Owner Information) as the Customer Rcord,

however, it is required that you complete the "Ship To Address" information with the Project

Number, Project Name, and Project Location; this information will then transfer to the "Project"

block on the G702.

Creating a Customer Type of AIA Format in the Additional Info tab will create a filter for only

those jobs requiring AIA Billing.

A Status of In Progress in the Job Info tab, indicates that this is a job that you are currently

working on.  While entering information in the Description field will transfer to the Contract For

section on the G-702.

Use of QuickBooks Items List

The QuickBooks Items List will essentially become your "Cost Codes" list or the Items that make up the

Schedule of Values for the contract.  Many contractors set up their QuickBooks Item List to reflect CSI

Cost Codes for the type of work they perform, which only enhances their job costing abilities.  To

download a complete copy of the CSI Masterformat Cost Codes List, visit our On-line Support Area at 

http://www.sunburstsoftwaresolutions.com/view-document-details/csi-masterformat-cost-codes.htm 

Use of Estimates

The QuickBooks Estimate becomes the line item Descriptions and Scheduled Value amounts on your

Continuation Sheet.   You have the ability to create your QuickBooks Item list as it relates to the type of

work you perform and will in turn use those Items to build your QuickBooks Estimate and your Schedule of

Values.

Use of the QuickBooks Progress Invoicing Function

From the QuickBooks Estimate create a Progress Invoice for the amounts you wish to bill for on the

current billing, not only does this update your Accounts Receivable without a lot of extra data entry, but
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the dollar amounts from the progress invoice become your current work complete on the Continuation

sheet.

3.2.2 Quickbooks Preferences that CAPS Utilizes

In this section we'll cover the QuickBooks preferences that CAPS utilizes.  Setting up these

preferences correctly will help to ensure your success in using Construction Application for

Payment Solution.

Only the QuickBooks Administrator may change Company Preferences and you must be in

single user mode to do so.

You use preferences to help you set the options you need to make QuickBooks Pro® fit your particular

business needs.  For example, you can turn payroll off or on, change the accounting basis for your reports,

set an interest rate for finance charges, or change the icon bar buttons to display the icons you use most

often.  CAPS utilizes special settings in the Jobs & Estimates Preference.

There are 16-20 different windows (depending upon your year version of QuickBooks) with both individual

and company preferences, with several options on each window.

In this section, we'll concentrate on customizing the QuickBooks Preferences that are utilized by CAPS,

other Preference settings specific to the construction industry are covered in the In-Program Help, in the 

Other QuickBooks Preferences topic.  You will be spending quite a bit of time there, however, you will not

have to do it very often, and the payoff is that when you are finished, it will be easier to use QuickBooks.

 

To begin, go to the Edit menu and choose Preferences, click on Jobs & Estimates.  You must be logged in

as the QuickBooks Administrator and in single-user mode.

My Preferences – personal preferences are not available.

Company Preferences Tab:

Job Status Descriptions - Change these descriptions, if you

prefer.  

This will be a very important part of your success with

using this program.

Do you create estimates – select YES

Do you do Progress Invoicing – select YES

Warn about duplicate estimate numbers –  select YES

Don't print items that have zero amounts – THIS BOX SHOULD NOT BE CHECKED
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3.2.3 Customers

QuickBooks Pro tracks jobs by Customer, however, it is important to understand that each customer can

have several jobs.  It is suggested that you set up each of the companies or agencies that you contract

work from, as Customers-then set up the different contracts that you perform work on, as Jobs , using

the Federal Project number as the job name (this is only a suggestion as project numbers are usually short,

and when you run a P & L by Job, you will be better able to view short names than long ones).

 

To set up a new Customer:

Using QuickBooks Pro/Premier 2009/2011 from the Customer Center, choose the New Customer & Job

option, and choose New Customer

In the Customer: Job List window, choose the Customer: Job button (lower left), and choose New

In the New Customer window, in the Customer Name box, enter the name of the company (General

Contractor) or agency, that you are contracting and billing work to (Contractor One)

In the Address Info tab, enter the company name, again (you can also do a copy and paste), in the

Bill To box, enter the billing address information for the company, you will have a total of 4 lines

with the 4th line reserved for City, State, and Zip Code.  Although, Intuit offers you the user 5 lines

in each of these sections, at this time, they are only allowing access to 4 of them. 

In the fields for Alt. Phone and Alt. Contact, you could enter the name and phone number of the

person in the companies Accounts Payable Department.  Leave the rest of the boxes empty.  

Click OK

QuickBooks Pro/Premier 2006-2011 & Enterprise 6.0-11.0

Important Note regarding QuickBooks Pro/Premier 2006-2011 and

Enterprise 6.0-11.0

These new versions will allow for an unlimited amount of Ship To

Addresses to be associated with a Customer Record, however, if you

want accurate Job Costing and AIA billings, you will need to create Jobs,

as always.  You cannot Job Cost with a Ship To address.

3.2.4 Jobs

To add a new job for a customer:

Job setup is a critical part of using CAPS successfully, as well as, obtaining accurate Job Costing Reports in

QuickBooks.  

The "Bill To" information transfers to the "To Owner" section of the G-702 - Application for Payment, and

the "Ship To" information transfers to the "Project" section, also, on the Application for Payment.  We, also,

utilize sections contained on the Additional Info and Job Info tabs of the Job Record, allowing you to enter

data once, and be done with it!

 

Using QuickBooks Pro/Premier 2008-2011 or Enterprise 8.0-11.0: from the Customer Center,

highlight the Customer for whom you wish to add a Job for, and either right click and choose Add

Job, or, from the New Customer & Job button, select Add Job 

In the New Job window, in the Job Name box, enter the federal project number that is assigned to

this project (15-271)

In the Address Info tab 

 o In the Contact Name box – enter the name of the contact person for this project (Joe

23
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Contractor)

 o Enter Phone and Fax numbers for this person in the appropriate boxes

 o Enter an E-Mail address, if you know it.

 o In the Ship To Address box, enter your Project Information 

On the first line, enter the Federal Project/State Project numbers associated with

this job (Fed Proj # 15-271/ST Proj # VT15271555555).   Limit of 41 characters

and/or spaces per line

On the remaining lines, enter the project name & location

Limit of 4 lines maximum with the 4th line containing City, State, and Zip Code

Information

 

NOTE:  It is important that you enter the information in the order shown above for inclusion Application for

Payment form.

 

IMPORTANT INFORMATION for QuickBooks Pro/Premier 2008-2011 and Enterprise 8.0-11.0 Users

ONLY: 

Intuit added an "enhancement" to this version - the ability to have an unlimited amount of Ship To Addresses

associated with a Customer or a Job.  In order for you to get accurate Job Costing Reports and AIA Billings,

you will still wish to create individual Jobs for your customers.  When you initially come to the Add Job

screen, you will  notice some changes.  Complete the Contact and Phone for inclusion on the "To Owner"

section of the G-702.  To create your "Project"  information, click on the "Add New" button below the "Ship

To" address block, and complete the Add Ship To Address Information, as shown.

QuickBooks Pro/Premier 2008-2011 &

Enterprise 8.0-11.0

Add Ship to Address Information Screen

About the "Add Ship to Address Information" Screen:

Customer Name -  your customer's name

Job Name - the name of the job for your customer

Address Name - this is what you will see in the drop down Ship To List and is not included in the actual

address

Address - this is where you will want to input the actual "Project" information

City, State, Zip -  you must include this information; otherwise, QuickBooks does not see it as a valid

address, and it will not be reflected accurately on the G-702

Default shipping address checkbox - this box must be checked, otherwise, the shipping address is not
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linked to the job and will be considered as being used one time only.

In the Additional Info tab

In the Customer Type  box (this is a user-defined list), create an item called AIA Format, and use this

for all jobs that you are required to submit AIA type billing.  CAPS uses this Customer Type as a filter

when accessing data from your company file.  

NOTE:  If you have both CAPS & CPS - creating a customer

type of AIA & CPS or CPS & AIA will act as a filter for both

programs.

Click on the Define Field button and set-up the following OPTIONAL custom customer fields. 

These fields are not used by CAPS, but will provide you with better internal QuickBooks reports,

should you choose to set them up, you have the ability to add a total of up to 15 fields, depending

on your version of QuickBooks

Orig Contract Date

Orig Contract Amt

Billing Period

%Retainage Complete

%Retainage Stored

Sales & Use Cert (this field can also be used for Vendors)

Architect's Proj #

 

· Orig Contract Date - enter the date of the original contract, as it is to be shown on the

Application for Payment Sheet

· Orig Contract Amt - enter the amount of your original contract for this job – do not include any

Extra Work Order or Change Order amounts

 · Billing Period - enter the frequency of your billing for this contract: Monthly, Weekly, Semi-

Monthly or Bi-Weekly – NOTE – if you use semi-monthly or bi-monthly, follow this by the 1st period

end date and the 2nd period end dates

 · %Retainage Complete - enter the percentage amount held in Retainage for Completed Work

 · %Retainage Stored - enter the percentage amount held in Retainage for Material Stored

 · Sales & Use Cert – if your state requires that you collect sales tax from your customers, you will

be required to have an Exemption Certificate on file for them.  You can use this field to track the

expiration date of the current certificate that you have on file.  Be sure to update it, when you

receive a new one.  See Tracking the Expiration of Sales & Use Certificates for a memorized

report to help keep you compliant.

 · Architect's Proj # - this will be utilized on the Contractor's Affidavit of Release of Liens form –

this item is mandatory, if you wish to use the Affidavit

 

In the Payment Info tab, enter whatever information you so choose.

The Job Info tab holds much pertinent data regarding your contract

26
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In the Job Status box, choose In Progress.  CAPS, also, uses this as a filter, when accessing your

company file. 

In the Start Date box, enter the date that you anticipate you will start working on this project

In the Projected End box, enter the date that you anticipate you will be finished with all work on this

project

The End Date box will be edited with the actual end date

In the Job Description box, enter the job description as you would have it appear on the Application

for Paymentt document (you are limited to 50 characters and/or spaces)

In the Job Type box, enter how you would classify this type of job – some examples could be Municipal,

School, Remodel, etc. or the type of work you perform, Electrical, Plumbing, etc.  The Lien Waiver forms

utilize this field. This will be utilized on the Contractor's Affidavit of Release of Liens form in the

Contract For: section

When you are ready to run CAPS, please generate a Contract Information Report, which will give you

useful information that you will be required to input into our program.  This is a custom report that you

can create in QuickBooks Pro; instructions for generating it can be found in CAPS Help, under Useful

Memorized Reports.

3.2.4.1 Create a "Filter" for Jobs Requiring AIA Billing

We realize that you might not need an AIA Bill for every job that you work on; therefore, we do

provide you with a method to easily create a "filter" for jobs that require an AIA Billing format. While

this has been included in the Job setup ; we'll highlight how to create this mandatory filter for your

jobs which only require AIA Billing.

To create the first half of your filter, click on the Additional Info tab of the Job record.

From the Customer Type drop down list, choose Add New, in the

Customer Type box - type in AIA, AIA format, or anything else as long as

the name begins with AIA, click OK, and use this customer type to easily

single out jobs that require an AIA billing to be submitted.

The other half of the filter is found in the Job Info tab:
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Here you will set the Job Status to be In Progress; indicating that you are

currently working on this job.
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3.2.5 Vendors & Subcontractors

The information contained in this section have absolutely no bearing on AIA billing, and is simply

provided because it has been asked for, by other contractors just like you, over the years.

In QuickBooks Pro®, there is no difference between a Subcontractor and a Vendor – whether they supply

material or services to you – they are set up the same way.  The only difference is how you set them up.

  

Setting up 1099 Subcontractors

You are mandated to report amounts over $600.00 of supplied labor for each subcontractor on IRS Form

1099.  You can set QuickBooks Pro® up to track all 1099 related payments to each of your subcontractors,

and then, generate the required Forms 1099 at the end of the year, by turning on the Tax: 1099

Preference .  

 

To create a 1099 Subcontractor

Using QuickBooks Pro/Premier 2002-2005: From the Lists menu, choose Vendor List, or in the

2003-2005 Contractor Edition from the Contractor Navigator, choose Add a Vendor, or in

QuickBooks Pro/Premier 2006/2007 from the Vendor Center, select New Vendor

In the Vendor List window, select the Vendor button (lower left), and choose New

In the New Vendor window, in the Vendor Name box, enter the name of the company (Smyth

Electrical Co., Inc.)

In the Address Info tab

 o In the Company Name Box, enter the company name again (Smyth Electrical Co., Inc.) -

you can do a copy, paste, here

 

NOTE:  THE COMPANY NAME WILL NOT APPEAR ON FORM 1099, IF YOU, ALSO, FILL IN FIRST NAME, MI,

LAST NAME BOXES – SO, BE CAREFUL HERE.

If the subcontractor is a sole proprietor, you will be required to print the persons legal name on the 1099,

and will fill in the First Name, MI, Last Name Boxes, in addition to, the company name.  If the

subcontractor is a partnership, fill in ONLY the Company Name box with the legal name of the partnership.

 If the subcontractor is a corporation, fill in ONLY the Company Name box with the legal name of the

corporation.  To identify Legal Names, require your subcontractors to complete IRS Form W-9, Request for

Taxpayer Identification Number and Certification.  This form may be downloaded from http://www.irs.

gov/forms_pubs/findfiles.html in the Keywords box, type in W-9.

 

Complete the rest of the required information
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In the Additional Info tab

 o Account box - enter an account number, if applicable, that the subcontractor has

assigned to you

 o Type box – enter the type of work this subcontractor performs (Electrical Contractor), or

simply, that they are a Subcontractor

 o Terms box – enter the payment terms that this subcontractor requires

 o Credit Limit – if the subcontractor/vendor has set a credit limit for you, enter that

information here.

 o Tax ID box – enter the identifying tax number associated with this subcontractor from the

IRS Form W-9 that they completed. 

 For Sole Proprietorship, it will be the person's Social Security Number, for a Partnership or

Corporation, it will be their Federal Identification Number

 o Vendor Eligible for 1099 box – check this box, only for Sole Proprietorship's and

Partnership.  Corporations are exempt.  (See instructions on Form W-9).

 o In the Custom Fields section, click on the Define Fields button, add fields for the

following, you have the ability to add a total of up to 15 fields, depending on your version

of QuickBooks:

Workers Comp Expires – if you are required to have on file a copy of your Sub-

Contractors current Worker's Comp certificate – you can enter the expiration date

here, so that you can generate reports to track, when new ones are needed.  See 

Subcontractor Workers' Comp Report 

W-9 on file – Federal tax laws require you to have on file IRS Form W-9 for vendors

& subcontractors – use this field to track and verify, that you have received this

form.

Sales & Use Cert or Tax Cert Expires – if you live in a state that collect sales tax,

you are usually required to submit a Tax Exemption Certificate to your

subcontractors and vendors.  Usually, these exemption certificates have to be re-

filed periodically.  In this box, you can put in the expiration date of your current

exemption certificate with this subcontractor/vendor.  Reports can be generated to

help you remain compliant.  See Tracking the Expiration of Sales & Use

Certificates, a custom QuickBooks Pro report (instructions on how to create this

report in QuickBooks Pro can be found in CAPS Help).
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QuickBooks Pro/Premier 2002-2006 &

Enterprise 1.0-6.0

Premier Contractor 2007-2011 & Enterprise 7.0 - 11.0

 

New in QuickBooks Premier Contractor 2007 - 2011 & Enterprise Contractor 7.0 - 11.0

These versions now provide "standard" boxes for tracking the expiration of Worker's Compensation

Insurance and General Liability Insurance dates.

The good news is that, you no longer have to use custom fields to track this, however, the bad news is

that, although Intuit says that you will be warned/alerted when these types of insurances expire, it is after

the fact, and not beforehand.  If you would like to be warned before the insurance expires, create

"Reminders" for these.

 

Setting up a Non-1099 Subcontractor/Vendor

Setup is the same, except that you will need to create a Vendor type for Materials or supplies, if you need

to issue them a Sales Tax Exemption Certificate and wish to track the expiration date of that certificate,

there will be no need to enter a tax ID number, and you will not need to check the box for, eligible for 1099.

3.2.6 Special Considerations for General Contractors

General Contractors may utilize this program, as well as, Subcontractors; when reading this

manual, simply replace all references to "General Contractor", with "Contract Owner or Awarding

Authority", and all references to "Subcontractor", with "General Contractor".

When setting up your QuickBooks Customer List, the Contract Owner or Awarding Authority" becomes your

Customer, and you would simply add the Job under the Customer, as outlined in the Customers  & Jobs

.

 

General Contractors do, however, have some special areas of concern.  You will need to track Retainage

Due  to you, but also, Retainage that you owe your Subcontractors .  

To track Retainage, follow the instructions under the Retainage section. 

For information on using Customized Purchase Orders for Materials, Subcontract Work, and Invitations to

Bid, please refer to Vendors & Subcontractors . 

We have included in CAPS the following functionalities:

The ability to generate simply, a schedule of values – this starts in QuickBooks Pro by pulling up your original

Estimate, clicking on the Progress Invoice button, and selecting to bill for a specific percentage of the entire

23

23

32 37

28



Construction Application for Payment Solution31

© 2002-2011 Sunburst Software Solutions, Inc.

estimate, enter 0 as the percentage, this will produce a Progress Invoice with no amounts billed.  Save and

close this Progress Invoice (noting the invoice number).  Start CAPS and retrieve this invoice number, and

you will in turn, generate simply, a Schedule of Values on the Continuation Sheet.

The ability to bill for more than the scheduled value – originally, while QuickBooks Pro would allow you to do

this, CAPS would not, we have added this ability to CAPS (there will be a warning message that line item

XXXX is being billed for more than the scheduled value, and do you wish to continue – you should answer,

yes).  This will allow you to use your schedule of values in QB as more of a budget than an actual estimate

of costs.
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3.2.7 Retainage

3.2.7.1 Retainage Receivable

There are two methods for making QuickBooks track Retainage Receivable.  We have taken the time

to explain both methods in detail.  Please read about both methods, talk to your accountant, and

then decide which method you wish to use for your company, as well as how to handle and create any

required Journal Entries.

3.2.7.1.1  Tracking as a Sub-Account of Accounts Receivable

You will need to track retainage, whether you are a General Contractor or a Subcontractor.  If you are a

General Contractor, you will need to track Retainage Receivable by you and Retainage Payable by you, and

then if you are a Subcontractor, you may only need to track Retainage Receivable.  

There are two methods of tracking these items – one method creates sub-accounts of Accounts Receivable

and Accounts Payable, and the other creates an Other Asset and Other Liability Accounts; each method is

explained in detail under the appropriate category.  Please read through the appropriate sections thoroughly

and decide which method will best suit your business; using the Sub-accounts method is a more lengthy

process.  Each method is explained in detail.

 

Method 1:  Setting up an Accounts Receivable Sub-account for Retainage Receivable

Accountants tend to really like this method, but, it is a two-part process for the person actually doing the

billing, which means that it's error prone, simply due to normal day-to-day distractions.

From the Lists menu, choose Chart of Accounts

 From the Chart of Accounts window, click the Accounts button (lower left), and choose New

 Choose Accounts Receivable as the Account type

 Enter an Account Number

 In the Name Box enter Retainage Receivable

 Click on the Subaccount of box and choose Accounts Receivable

 In the Description box, enter Retainage Receivable on Contracts

 Click OK

 

Creating Items for Retainage

To create an Item to deduct retainage

 o From the Lists menu, choose Item List

 o From within the Items List window, click on the Item button (lower left), choose New

 o In the Type box, select Discount

 o In the Item Name/Number box, type in 90 Retainage

 o In the Description box, type in Less Retainage

 o In the Rate box, type in the percent as a negative (-10%) if you are using a flat rate, leave this

blank if you have a variable rate, create additional Discount items for other commonly used rates

naming them something like 10% Ret, 5% Ret, etc.

 o In the Account box, type in or select, your main Construction Income account

 o Click OK to create the new item.

To create an Item to record retainage that is due to you in the Retainage Receivable on Contracts account

 o From the Lists menu, choose Item List

 o From within the Items List window, click on the Item button (lower left), choose New

 o In the Type box, select Other Charge
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 o In the Item Name/Number box, type in 91 Retainage Due

 o In the Description box, type in Retainage Due from Application #

 o Leave the Rate box blank

 o In the Account box, type in or select, your main Construction Income account

 o Click OK

Including Retainage on a Progress Invoice

 

After you have created your Progress Invoice, scroll down to the first available blank line and create a 

Subtotal line by pulling in a Subtotal Item from your Item List, on the next blank line, pull in your

Retainage Item – if you have created the item with a negative percent (as shown above), QuickBooks® will

automatically calculate what amount is to be held as retainage.

If you do not have a Subtotal Item in your Item List:

Go to Lists -> Item List -> Item Button -> New -> Item Type = Subtotal -> Item Name/Number = Subtotal ->

Description  = Subtotal of Above

 

If you use a variable rate of retainage, it is suggested that you let CAPS calculate the total amount of

retainage to be held on the Application, and manually go back into QB, pull up the Progress Invoice, do the

subtotal line as above, pull in your Retainage Item, and enter the Retainage amount as a negative number

(-359.50).  There will be a minimal amount of manual calculation involved here on a monthly basis, as you

will have to take the total retainage from this application ($1000.00) and subtract out the previous

retainage ($750.00) to get the current amount of retainage ($250.00), for this invoice.

 

Recording Retainage Receivable

 

After you have recorded your Progress Invoice; select Create Invoice, pull up your job, in the Account box

at the top of your invoice, change Accounts Receivable to Retainage Receivable, change the Invoice

Number to the Progress Invoice Number-R (for example your Progress Invoice number was 1251 – this

invoice number would become 1251-R.  Go to the body of your invoice and pull in the 91 Retainage Due

item that you created above, and record the invoice.  Change the Terms accordingly – for example, let's say

that you know from the contract that Retainage will be paid 6 months from the original billing date, you

could create a new QuickBooks Pro Terms for Net 6 Months. 

If you choose to use this method, you must verify which Accounts Receivable account you are using

the next time you invoice a customer and restart your numbering process manually.

You or your accountant will need to make a Journal Entry to Defer the income that is associated with

Retainage, either at year end or on a monthly basis. a Sunburst support person will not be qualified

to tell you how you should complete this journal entry as we have no idea how your books are set up
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3.2.7.1.2  Tracking as an Other Current Asset

Method 2:  Setting up an Other Asset Account for Retainage Receivable

This is a simple one-step process for the person actually doing the billing, and at the end of the year, the

accountant will need to do a Journal entry to move the dollars for tax return purposes.

From the Lists menu, choose Chart of Accounts 

From the Chart of Accounts window, click the Accounts button (lower left, and choose New

Choose Other Current Asset as the Account Type (QB will not let you associate Items with an

Accounts Receivable account and if you try to associate an item to an account type of Accounts

Receivable, you will receive the following error message - "You cannot associate an item with Sales

Tax Payable, Undeposited Funds, Accounts Receivable, Accounts Payable or Non-posting accounts. 

Usually, if you sell an item, use an income account; if you buy it, use an expense account.") 

Enter an Account Number

In the Name box, enter Retainage Receivable on Contracts

In the Description box, enter Retainage Receivable

Click OK

 

Setting Up an Item for Retainage

From the Lists menu, choose Item List

From within the Items List window, click the Item button (lower left), choose New 

In Type box, select Other Charge

In the Item Name/Number box, type in 90 Retainage

In the Description box, type in Less Retainage

In the Rate box, type in the percent as a negative (-10%) if you are using a flat rate, leave this

blank, if you have a variable rate

In the Account box, type in or select the account used for Retainage Receivable

Click OK to create the new item.

  

NOTE:  If you have different flat rates of retainage that you use, a separate item can be created for each

of them using the rate in the Item Name/Number

Including Retainage on a Progress Invoice

 

After you have created your Progress Invoice, scroll down to the first available blank line and create a 

Subtotal line by pulling in a Subtotal Item from your Item List, on the next blank line, pull in your

Retainage Item – if you have created the item with a negative percent (as shown above), QuickBooks® will

automatically calculate what amount is to be held as retainage. 

If you do not have a Subtotal Item in your Item List:

Go to Lists -> Item List -> Item Button -> New -> Item Type = Subtotal -> Item Name/Number = Subtotal ->

Description  = Subtotal of Above

IMPORTANT:  The Item Name/Number MUST BE Subtotal as CAPS
has been taught to ignore this Item and the item directly below it where
you will be deducting your retainage.

If you use a variable rate of retainage, it is suggested that you let CAPS calculate the total amount of

retainage to be held on the Application, and manually go back into QB, pull up the Progress Invoice, do the
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subtotal line as above, pull in your Retainage Item, and enter the Retainage amount as a negative number

(-359.50).  There will be a minimal amount of manual calculation involved here on a monthly basis, as you

will have to take the total retainage from this application ($1000.00) and subtract out the previous

retainage ($750.00) to get the current amount of retainage ($250.00), for this invoice.

  

Invoicing for Retainage/Recording Retainage Paid

 

First, you will need to set up a billing item for Retainage Due

From the Lists menu, choose Item List

From within the Items List window, click the Item button (lower left), choose New 

In Type box, select Other Charge

In the Item Name/Number box, type in 91 Retainage Due

In the Description box, type in Retainage due from previous Application #

Leave the Rate box blank

In the Account box, type in the account used for Retainage Receivable

Click OK to create the new item.

 

From the Customer Navigator, Contractor Navigator, or Home Page, click on the Invoice icon, from the

drop down menu, select the Customer: Job that you will be billing, in the PO No. field, reference the

Application Number the retainage pertains to, in the Item Column, type in the Item that you just created

above, in the Amount column, enter the amount of retainage that you are invoicing for. 

While this is an easier method, it does NOT deduct the retainage held from your gross income (like

Method 1) on a Profit and Loss Report.  You will need to inform your accountant of this at year end,

so he or she, may make the necessary Journal Entries.  You MUST discuss this Journal Entry with

your accountant and NOT a Sunburst Support Representative as we have no knowledge of how your

books are set up.

3.2.7.1.3  Reports for Tracking Retainage Receivable

There are several of ways to view retainage:

The first is to view the Retainage Receivable account by:

From the Lists menu, choose Chart of Accounts

In the Chart of Accounts window, scroll down to the listing for Retainage Receivable, click on this

account to highlight it, then click the Activities button (bottom center) and choose Use Register.

This will show you all the increases and decreases to your Retainage Receivable account, although,

it is cumbersome to figure out who is outstanding.

 

The second method is a little more cumbersome, but very effective.

 From the Lists menu, choose Chart of Accounts
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In the Chart of Accounts

window, scroll down to the listing

for Retainage Receivable, click

on this account to highlight it,

then click the Reports button

(Lower right), and choose Quick

Report.  This gives you all a

report containing all the activity

in your Retainage Receivable

Report sorted by date.

Once this report is up in QB, click on the Excel button (top center) – this will open Excel – in the Export

Report to Excel window, choose Send Report to a New Excel spreadsheet and click OK

Once the Excel spreadsheet opens, click anywhere in the report, and press CTRL and A keys together to

highlight the entire spreadsheet.  Choose Data, and Sort.

From within the Sort window, choose My list has header row (lower left) and in the first Sort by box,

choose Name from the drop down list, in the second Sort By box, choose Num from the drop down list.

Click OK

Excel now sorts your Retainage Receivable Report, so that you can easily see what has been paid and

what remains unpaid.

 

Another method is to create a Memorized Report, called Retainage Receivable Report.  To create this

report,

Menu Path + Reports |Customers & Receivables | Customer Balance Detail

Select Modify | Filters | Account | Selected Accounts

Select Retainage Receivable

Header/Footer | Report Name = Retainage Receivable Report

Select Ok

Memorize

And, if you are utilizing the use of an Accounts Receivable Sub-Account, you can simply run an A/R detail

report Filtering for just that Account.
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3.2.7.2 Retainage Payable

There are two possible ways to track retainage that you owe to your subcontractors; one method

utilizes a Sub-Account of Accounts Payable, called Retainage Payable, and the other method utilizes

an Other Liability Account, called Retainage Due to Subcontractors.  Please review the setup and use

of both methods, and choose whichever one seems more appropriate for your use.

You will need to inform your accountant of this at year end, so he or she, may make the necessary

Journal Entries.  You MUST discuss this Journal Entry with your accountant and NOT a Sunburst

Support Representative as we have no knowledge of how your books are set up.

3.2.7.2.1  Tracking as a Sub-Account of Accounts Payable

Method 1:  Retainage as an Accounts Payable Sub-Account

Accountants tend to really like this method, but, it is a two-part process for the person actually doing the

billing, which means that it's error prone, simply due to normal day-to-day distractions.

From the Lists menu, choose Chart of Accounts

From the Chart of Accounts window, click the Accounts button (lower left), and choose New

Choose Accounts Payable as the Account type

Enter an Account Number

In the Name Box, enter Retainage Payable

Click on the Subaccount of box, and choose Accounts Payable

In the Description box, enter Retainage Payable on Contracts

Click OK

Deducting Retainage Payable on a Vendor/Subcontractor Bill

If you have created a Purchase Order for this subcontractor and are now receiving his first progress billing,

choose Vendors, and Receive Items with Bill, and if you have not created a Purchase Order, simply choose

Enter Bill.  

Select the Subcontractor from the drop down list; change the date, enter a Reference Number, the total

amount of the bill, select terms, due date, and enter a memo if applicable - select either the Expenses or

Item tab, and pull in the appropriate Item Code or Expense account associated with the vendor bill, and

select the Customer: job.  In the next blank line, again, pull in either the Item Code or Expense Account,

enter the retainage as a negative amount, in the memo field type in less retainage held, choose the

Customer: job from the dropdown list.

Sample 1 below shows a sample bill created from

a purchase order using the item tab

Sample 2 below shows a sample bill created

using Enter Bills and the Expenses Tab
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Recording Retainage Payable

Select Enter Bills; change A/P Account from Accounts Payable to Retainage Payable.  Select your

subcontractor; enter date of original subcontractor invoice, in the Ref. No., input the invoice number

followed by, –R to indicate Retainage, enter amount due, change your terms to reflect when you will pay the

retainage, select either the Item Code or the Expense account, and select the job.

Sample 1 shows a bill for retainage

entered using the Item tab

Sample 2 shows a bill for retainage entered using the

Expenses tab

3.2.7.2.2  Tracking as an Other Current Liability Account

Method 2:  Retainage Payable as an Other Liability Account

This is a simple one-step process for the person actually doing the billing, and at the end of the year, the

accountant will need to do a Journal entry to move the dollars for tax return purposes.

From the Lists menu, choose Chart of Accounts

From the Chart of Accounts window, click the Accounts button (lower left), and choose New

Choose Other Liability as the Account type

Enter an Account Number

In the Name Box, enter Subcontractor Retainage Payable

In the Description box, enter Retainage Payable on Contracts

Click OK

  

Setting up Items to Deduct Retainage Payable

From the Lists menu, choose Item List

From within the items List window, click the Item button (lower left), choose New

In Type box, select Other Charge

In the Item Name/Number box, type in 92 Less Sub Ret

In the Description box, type in Less Subcontractor Retainage

In the rate box, leave the amount set to 0 (you cannot use percentages in the detail of the bill) in the

Account box, select the account used for Retainage Payable on Contracts

Click OK to create the new item

 

NOTE:  If you have different flat rates of retainage that you use, a separate item can be created for each

of them using the rate in the Item Name|Number

Deducting Retainage Payable on a Vendor/Subcontractor Bill

If you have created a Purchase Order for this subcontractor and are now receiving his first progress billing,

choose Vendors and Receive Items with Bill, and if you have not created a Purchase Order, simply choose

Enter Bill.  
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Select the Subcontractor from the drop down list; change the date, enter a Reference Number, the total

amount of the bill, select terms, due date, and enter a memo if applicable - select either the Expenses or

Item tab, and pull in the appropriate Item Code or Expense account associated with the vendor bill, and

select the Customer: job.  

Sample 1 shows a deduction for

retainage using the Item Tabs

Sample 2 shows a deduction for retainage using the Expenses

Tabs

While this is a much more simple process than Method 1, it will not reduce total expenses or Cost

of Goods Sold, on a Profit and Loss Report.  You will need to inform your accountant of this at year

end, so he or she, may make the necessary Journal entries.  You MUST discuss this Journal Entry

with your accountant and NOT a Sunburst Support Representative as we have no knowledge of how

your books are set up.

3.2.7.2.3  Report for Tracking Retainage Payable

If you choose to use the Accounts Payable subaccount method, simply run an Accounts Payable Report, and

Filter it for the Retainage Payable Account, setting the dates to all.

If you choose to use the Retainage Payable as an Other Current Liability Account you can create a Retainage

Payable Report by:

Reports menu  -> Vendors & Payable -> Vendor Balance Detail

Modify Report -> Display -> Name

Modify Report -> Filters -> Account -> Multiple Accounts -> Subcontractor Retainage -> OK

Modify Report -> Header/Footer -> Report Title = Subcontractor Retaiange Payable -> OK

Remove the Account Column

Memorize Report = Save In Vendors
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3.2.8 Estimating

3.2.8.1 Introduction

We realize that Estimating is an individual preference, but the most important thing that will be stressed in

this section is this – You must input your estimate in QuickBooks exactly as you need it to appear in

output form on the Continuation Sheet.

 

If your estimate is created using a sophisticated estimating program or a spreadsheet program that doesn't

have a QuickBooks® interface, you will need to manually recreate the Estimate in QuickBooks Pro® - see 

Handling Estimates Created in a Program with No QB interface .

If you use a program that provides a QuickBooks interface (such as Craftsman's National Estimator), simply

import the estimate and make a few changes – more on this under Using National Estimator.

3.2.8.2 Handling Estimates Created in a Program with No QB interface

QuickBooks Pro® has no labor and materials cost database, but you will need to set up the individual items

in order to recreate the Estimate.  Refer to the Sample Items List for Contractors (accessed from the

CAPS Help Menu -> Contents->Index tab) or  obtain a copy of the CSI Masterformat Cost Codes from our

On-Line Support Area at http://www.sunburstsoftwaresolutions.com/view-document-details/csi-

masterformat-cost-codes.htm 

If you need help setting up items; assign the appropriate Cost of Goods Sold, Job Related Costs, and

Income Accounts.  It is helpful to set up your Item List in QuickBooks Pro® using item names or numbers

that match that of the other program and duplicating the item description, you will be limited to a total of

48 characters, including spaces, when setting up descriptions in QuickBooks Pro® for use with our

program.

You may, also, create Group Items that contain 19 individual pieces, which is convenient, if you bill using

Divisions or CSI Cost Codes.

 

Be sure that you have set up your Job as described in the Jobs  section   

Follow instruction for creating the Estimate in An Overview

 

40
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3.2.8.3 Using National Estimator

Using Craftsman's National Construction Estimator ($47.50 for manual and software – approximately $12.50

yearly cost upgrade fee), and the Job Cost Wizard (free), is a wonderful option.  For more information on

National Construction Estimator, visit http://craftsman-book.com/downloads/trybuy.php/ there are

several different modules available: Electrical, Painting, Plumbing & HVAC, Renovation & Insurance Repair,

and Repair & Remodeling Estimating modules, using current building costs for residential, commercial, and

industrial construction.  Provides man-hours, recommended crew, and gives the labor cost for installation.

 

This same program is offered at no cost at many Home Depot stores, this version is called ProBook CD and

comes with a database of about 18,000 items stocked at the Home Depot.  Prices in ProBook CD are

updated daily to reflect shelf prices at your local Home Depot store.  Unfortunately, it is not available in all

states at this time.

The Estimates that you create using National Estimator® can be smoothly exported into QuickBooks Pro®

using the Job Cost Wizard®.  Remove the subtotal lines, create Progress Invoices, and you are ready to run

CAPS to generate your AIA billing.

3.2.8.4 Using QuickBooks for Estimating

3.2.8.4.1  An Introduction to Estimating with QuickBooks

There is a lot to be said about Estimating with QuickBooks  - it works, it comes as a standard part

of the program so there is no additional expense, and like all other portions of QuickBooks - It is

forgiving.

 

Good reasons to Use QuickBooks Pro Estimating Functions

Estimating is the starting point for all the account and job costing features that are built into

QuickBooks.  Once you have created your estimate, a single click of the mouse turns it into an

invoice (no additional work here).  The amount of your newly created invoice automatically becomes

an entry into your Accounts Receivable, and an Asset on your Balance Sheet.  You are able to

compare the actual cost of doing the work, to what you thought the costs to be.  The difference

between costs and receipts shows as your profit (loss) on the job.

The Progress Billing feature in QuickBooks Pro® is a huge advantage if you need to send out

detailed invoices for work done during a specified period of time, and you need to keep track of

what has been billed, what remains to be billed, what has been paid, and what is still receivable. 

This is the part of QuickBooks Pro® that Construction Application for Payment Solution (CAPS)

relies heavily upon, enabling you to do all of the above, PLUS, generate your AIA type billing with

only a few additional keystrokes and a limited amount of additional data entry.

 

Your progress invoice and your AIA type billing, like your original bid or estimate, should identify each cost

in the job.  The best invoice for construction work is to exactly duplicate your estimate – using the same

descriptions for each line item and showing the same costs.  Why create an estimate, and then recreate it

in invoice form in QuickBooks Pro, and then manually prepare your AIA type billing, when you can do it all

from an Estimate created in QuickBooks Pro®?  

QuickBooks Pro® converts your estimate to a progress invoice in the click of a button – minimal data entry

for individual line item amounts or percentages is required for the progress invoice.  Once the progress

invoice is created, you will be required to add a subtotal line, and a line to record retainage held.  Click to

save and record the progress invoice.  You are done-your Accounts Receivable and Retainage Receivable

accounts are updated.  You will then start CAPS, enter a date or invoice number range, enter a minimal

amount of information regarding the contract that QuickBooks Pro® has no capabilities of tracking: 

http://craftsman-book.com/downloads/trybuy.php/
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Architect Information, Original Date of Contract, Original Contract Amount, various project numbers, etc. 

Select the number of copies you will need to generate, and you are now ready to take the report to be

notarized and then mail it. 

3.2.8.4.2  An Overview

If you currently use QB for Invoicing purposes, you will undoubtedly already have an Item List; if not, you

will have to create EVERY labor and material cost in the Item List manually, this can take time.  It is not an

issue to type in a few dozen descriptions and costs – but depending on the detail that you are required to

include on your estimate-this list could become, hundreds to thousands, of lines.  Even after you get this

list compiled – you may not be happy.  Finding an item in a list that size can be frustrating, and QuickBooks

Pro® only support alphabetic sorting within the different types of Items – Inventory Parts, Non-Inventory

Parts, Service, etc.  This is why it is suggested to use a combination of numbers and letters.  The Item

Name cannot be more that a total of 31 characters, including spaces.  If you would like, review the

Sample Items List for Contractors (found in CAPS from the Help menu -> Contents ->Index tab) or for the

CSI MasterFormat Cost Codes list, visit our website at http://www.sunburstsoftwaresolutions.com/view-

document-details/csi-masterformat-cost-codes.htm 

 

To Create An Estimate in QuickBooks Pro

From the Lists menu, choose Customer List, or in the 2003/2004 Contractor Edition from the

Contractor Navigator, choose Estimates & Change Orders.

In the Customer: Job List window, click to highlight the Customer: Job that you wish to create an

Estimate for.  If you do not have Jobs set up for your customers, please read about Jobs, it's a

worthwhile read, as there are a few mandatory things that CAPS requires.

Click on the Activities button and choose Create Estimate.

QuickBooks Pro® will automatically enter today's date and the next Estimate Number that is available

(if you are recreating your estimate from a program without QB Interface, manually enter the Date

and Estimate Number used by the other program)

To enter each line item for the Estimate, Click in the Item column and: 

From the drop down list, scroll down to the item that you wish to use

Or, simply start typing – this is where numbering an Item List really saves time.  Press the Enter or

Tab Key, the description will fill in automatically, if you entered it when you created the item (TIP: 

Item descriptions are limited to 48 characters, including spaces).

In the Qty. column, enter a quantity 

In the Cost column, enter a price each of the Item.  The Amount will automatically calculate.

If you use the Mark-Up column, you can enter either a lump sum markup, or enter a number with a %

sign (33%, for QuickBooks Pro to calculate the markup, add it to the Amount, and show it, in the

Total column).

Do this for each line item of your Estimate

Do not use subtotal lines in your Estimate - CAPS will allow you to create sub-totals, page

breaks, page totals, running totals, etc. 

Click on Save & Close, to create and record the Estimate.

 

http://www.sunburstsoftwaresolutions.com/view-document-details/csi-masterformat-cost-codes.htm
http://www.sunburstsoftwaresolutions.com/view-document-details/csi-masterformat-cost-codes.htm
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3.2.8.4.3  Creating a Progress Invoice from your Estimate

QuickBooks® Estimates don't have any effect on account balances.  You can do all the estimates

you want without changing anything on the profit and loss statement or the balance sheet.  That

no longer holds true, when you turn an Estimate into a Progress Invoice.  Estimates are simply talk

- invoices are money!

Using your Open Estimate Report, double-click the Job that you are now ready to begin billing (you

will be taken directly to the Estimate).

Click the Create Invoice button at the upper center of the window

You will receive a Create Progress Invoice based on

Estimate box with 3 options.   It is most likely that you

will use option 3 – Create invoice for selected items or

for different percentages of each item, and click OK

 

From within the Specify Invoice Amounts for

Items on Estimate window, place your cursor in

either the Amount or Current % column, and enter

either the dollar amount to bill for this period or

the percent complete to bill for.  Using either

column will calculate amounts for the remaining

columns.  Click OK, when you are finished selecting

line items to bill.
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IMPORTANT NOTE:  If you will be billing for an Amount Stored on the Continuation Sheet, that amount

must be included here – you can separate it out, once, you are in CAPS.

You are now taken to the Create Invoice window and you will see that the Form Template box

shows Progress Invoice.  

Review that the Invoice Number, Date, PO, etc. are what you want.

Check the line item Prices for accuracy

When you reach the last line item in your Progress Invoice – place your cursor in the first blank line

of the Item column, type in Subtotal, to create a subtotal for your Progress Invoice.

In the next blank line in the Item Column, type the Item Code for your Retainage withheld.  See

Sample Items List for Contractor,s if you need help in setting up an item to track your Retainage.

 

You should print a copy of the invoice, for your records, and to compare with the Detail screen  in CAPS.

 If you are doing more Progress Invoicing, key it to be printed, and print the entire batch.

3.2.8.4.4  Handling Extra Work Orders or Change Orders

Significant Changes have been made in the Contractor Edition relating to how change orders

are dealt with, but, you will still want to create the items, and follow the instructions given

here.  Any changes will be noted, so please, read this section carefully in order for your

change orders to correctly appear on the Continuation Sheet.  As the QuickBooks

Administrator you will want to be sure to train your employees appropriately.

When you receive an Extra Work Order (EWO) or Change Order (CO), you will need to add the line items to

the bottom of your original Estimate, and NOT just go to the Estimate and change the dollar amounts.  See

Documenting Job costs/Extra Work Orders/Change Orders in the Support Area at http://www.

sunburstsoftwaresolutions.com/view-document-details/documenting-job-costs/extra-work-orders/change-

orders.htm 

First – create two new items on your Item List, as shown below:

Extra Work Order Change Order

Sample Estimates with Change Order - recommended method

85
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Open your Original QuickBooks Pro Estimate

Scroll to the first blank line at the end of the estimate

In the Item column, pull in the EWO or CO item that you just

created (92 EWO), press enter to get into the Description

Field, place your cursor after the # sign, and enter the EWO

or CO number, and the date that it was issued.

From your item list, pull in the items that pertain to the EWO

or CO, and enter quantities and amounts, remember to enter

amounts as a negative number, if they decrease the value of

the original contract.

Negative Change Orders:

Based on the screen shot above, the contractor received a

Change Order #200 dated 8/10/01 from the General Contractor

removing the entire amount of Item 22 Specialty – Mirrors for

restrooms.  The Change Order was entered at the bottom of the

Original Estimate using a negative amount, and the original line

Item 22 Specialty – Mirrors for Restrooms has an additional note

stating  - Removed per Change Order #200.  When generating

your Progress Invoice, in the Specify Invoice Amounts for Items

on Estimate screen, you would enter in the Current % column

100% for each of these items.  For more information on

Negative Change Orders, see the Adjustments  section of the

manual. 

Contractor Edition Special Notes

After you have pulled in the lines items involved with the EWO, and Click on Save & New to record your

changes, a pop-up window will appear similar to that shown below

Select Yes to record your changes.  Another pop-up window

will appear, and you may edit the first line of information

contained in the white box to read something similar to

what is shown below.

You may choose to add the statement contained in the

white box, or Do Not Add or Cancel.  If you choose to

add the statement, your Estimate will look similar to

what is shown below.

The "statement" is nothing more than a text box that

is placed on the Estimate, and in reality, it is pretty

worthless in our opinion.

Sample Estimate with Change Order from the Contractor Edition

100
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The information contained within the Change

Order Pop-Up Window will appear on your

estimate 2 blank lines below your last line

item entry.  When you create your Progress

Invoice, you MUST enter your Subtotal, and

Less Retainage Items, in these blank lines

without adding any additional blank lines,

otherwise, CAPS will try and print the new

Change Order function on your continuation

sheet, and it will appear something like this in

your CAPS Detail Screen:
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3.2.8.4.5  Accounting for Stored Material

To make QuickBooks handle stored material, for each line item, add the amount to be billed plus

the amount of stored material, and use this figure in the Amount column of the Specify Invoice

Amounts for Items on Estimate screen.  You will be able to separate it out once you are in the

Detail  screen of CAPS.

Example:

You are billing for $1,000.00 of completed work, plus, you have $500.00 of material stored on the jobsite. 

You would put $1500.00 in the Amount column of the Specify Invoice Amounts for Items on Estimate

screen.  When you pull this Progress Invoice into the CAPS Program you will click the Detail button and enter

$500.00 in the Stored column.

3.2.8.4.6  Dealing with Time & Material Jobs that require AIA billing

Time & Material Jobs are a little more time consuming.  

You would still need to create your Estimate, (or in this case, you would call it your Budget for the job) in

QuickBooks®.  

When you are ready for billing, first, you will go to the Create Invoice section, select the job, choose NOT

to use the Existing Estimate in order to get a blank invoice; then, click on the Time & Costs icon at the top

of the invoice screen, and select the items you wish to bill this month from the Item, Expenses, and Time

tabs.  Print, save, and then delete, this invoice to clear the items from the billable history.  

Go to the Estimate, choose to create a Progress Invoice, and using the invoice you just printed with your

true costs as a guideline, bill appropriately.

85
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4 Construction Application for Payment Solution -
Administrator Manual

4.1 Installation

Administrator Task:

The installation of Construction Application for Payment Solution should be done by the QuickBooks

Administrator in Single-User Mode so that they can grant CAPS permission to access the QuickBooks

data file.

Audio/Video Training Available:

Audio/Video Training is available for downloading, saving, and installing the software from our Web

Service Center.  

Look for the Construction Application for Payment Solution - Download & Installation Video.

Audio/Video training is accessed via a Link on our Web Service Center, or directly from the On-Line

Support Area of our website using the following url - http://www.sunburstsoftwaresolutions.com/

construction-application-for-payment-free-training/view-category.htm  

4.1.1 Important Information for Windows Vista & Windows 7 Users

Windows Vista & Windows 7 Users - take a few moments to review the following important information, as

these are our top  technical support calls from users:
1. You should be logged in as a Standard User – QuickBooks and any of your other software programs does

not need to be run or installed at the Windows Administrator level, HOWEVER, you will need to know

the Administrator password to install the programs.
2. Your User Account Control should be turned ON.
3. Your QuickBooks file should be located in the C: -> Users -> Public Folder ->Public Documents -> Intuit -

> QuickBooks -> Company Files Folder

NOTE:  If when you start Vista or Windows 7 there is only a single login account, that account is the

Administrator account and you will need to create a Standard User Account and sign in under the

Standard User Account when installing QuickBooks, or any other software.

Why is it important to have a Standard User Account?

When you use your computer under only the Administrator account, ANY malicious programs or harmful

viruses from unfamiliar websites can install themselves with little to no warning to you; because they take on

all of the privileges and abilities of you - the computer Administrator.

On the other hand, when you create a Standard User Account, and it is set up so that the User Account

Control is turned on, when ANY program is installed (and even some program updates) the Standard User is

presented with a window which requires the computer administrator password - essentially asking permission

to install the program - therefore, you will be made aware when a program is being installed.  

How do I know if my Windows Vista or Windows 7 settings are correct, and WHY is this

important?

Vista implemented tighter security controls to protect us from harmful programs and viruses from malicious

websites and Windows 7 made those security controls somewhat less annoying.  Basically  they have changed

how we work with our computers and where we store our information; whether we share it with others or

not.

http://www.sunburstsoftwaresolutions.com/construction-application-for-payment-free-training/view-category.htm
http://www.sunburstsoftwaresolutions.com/construction-application-for-payment-free-training/view-category.htm
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To check your account type, and whether or not your User Account Control is turned on, perform the following

task:

1. Click your Start button 

2. Choose Control Panel 

3. Choose User Accounts 
4. Select Your Account.  

Here you should see that you are setup as a Standard User (as shown below).  If you are set up as an

Administrator, you should create a Standard User Account for yourself, and ALWAYS log in using that

account.

Windows Vista - Standard User Account

Windows 7 - Standard User Account

Click the link that says “Turn User Account Control on or off”.  One of two things will happen.

IF a User Account Control Window appears asking for the Administrator password, your Use Account Control

is turned on - enter the Administrator password to Continue.  Click OK, and install your software AFTER

verifying that your QuickBooks file is in the Public Folder.
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IF the User Account Control Window does NOT appear, your User Account Control is turned off, and we need

to turn it on.

Below is a screenshot of the User Account Control Window in Windows Vista:

IF the “Use User Account Control (UAC) is checked, it is turned on and properly functioning.  All you have to

do is click OK, verify that your QuickBooks  company data file lives in C: -> Users -> Public Folder ->Public

Documents -> Intuit -> QuickBooks -> Company Files Folder, and then you can safely install your new

software.

If the “Use User Account Control (UAC) is not checked, it is not turned on.  Click into the box to place a

check mark in it – the placement of the check mark “turns” the UAC on – click OK, and you will have to reboot

or restart your computer in order for this to take effect, before you can install your new software. 

Below is a screenshot of the User Account Control window in Windows 7:

NOTE:  The User Account screen will vary in appearance depending upon which version of Windows 7 you are

running, however, it should be set to Always Notify you.
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4.1.2 Internet Download

Audio/Video Training Available:

Audio/Video Training is available for downloading, saving, and installing the software from our

Web Service Center.  Audio/Video training is accessed via a Link on our Web Service Center, or

directly from the On-Line Support Area of our website using the following url - http://www.

sunburstsoftwaresolutions.com/construction-application-for-payment-free-training/view-

category.htm  

From the Web Service Center, locate the button which says "Download CAPS Installation"

Click on the button above, and when prompted to Run or Save the file; choose to Save it to the hard drive of

your computer for future reference.

If you use Firefox If you use Internet Explorer

When the program has finished downloading, you will have an opportunity at that time to Open (FireFox) or

Run (Internet Explorer).  This will initiate the Installation Wizard .  

If you do not have time to install the program at this point, you can easily locate the file later, and then

initiate the installation.

Where and How do I save the file so I can find it?

Where you save the file will depend on if you are using Windows XP or Windows Vista, AND if you will

ultimately be running CAPS only on your computer, or, if you will network it.  Complete details are provided

in our Audio/Video training, mentioned above, however, we'll provide examples for each.

Windows XP:

Run on single Computer - Create a new Folder in your My Documents folder called Downloaded

Programs - save the file in My Documents -> Downloaded Programs folder

55
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Network - Create a new Folder in the Shared Documents folder called Downloaded Programs - save the

file in Shared Documents -> Downloaded Programs folder

Windows Vista or Windows 7:

Run on a single computer - create a new folder in your Documents folder called Downloaded Programs

- save the file in Users -d> your user name -> Documents -> Downloaded Programs folder

Network - save the file in Public -> Public Downloads

How do you install the program later?

Complete details are included in the Audio/Video training, mentioned above.  

Open the folder where you originally saved the program (see above).  Locate the file called CapSetup or

CapSetup.exe and double-click on it.  This automatically launches the Installation Wizard , and the Vista

User Account Control window will appear, and you will need to enter the Administrator password.  IF THE

USER ACCOUNT CONTROL WINDOW DOES NOT APPEAR, your User Account Control is not turned on, and you

will experience errors when attempting to run the CAPS program.  Immediately cancel the installation and

verify your Vista settings, as outlined in "Important Information for Windows Vista & Windows 7 Users

".

4.1.3 CD Installation Manager

In most cases, inserting the installation CD, or double-clicking on the executable (.exe) file you downloaded

from the web, starts the Installation Manager.  If the Setup Manager shown below does not appear shortly

after inserting the CD, do the following:

 A. Use "My Computer" to locate the CD drive and double click on it.

 B. Locate the file named "AutoRunSetup" and double click on it.

Please take a few moments to familiarize yourself with the various options contained within the Installation

Manager.  The Installation Manager is ONLY available on CD Purchases.

Windows 7 & Vista Users:

There will be a User Account Control window that will appear (which cannot be captured in a

screenshot) stating that an unidentified program wants to access your computer, you must select

Allow.  If you do not see the User Account Control window - immediately STOP, or CANCEL the

installation, and follow the instructions in Important Information for Windows Vista & Windows

7 Users .  You may then start the installation again.

Installation Manager - Installation Options Tab:

Clicking on the "Install CAPS"  button will  begin the installation

procedure for CAPS.

Clicking on the "View Installation Instructions"  button will open a .pdf

which provides complete instructions for installing your new software.

Clicking on the "View Installation Video"  currently provides a complete

overview of how to download the Construction Application for Payment

Solution program electronically from the Web Service Center, save it to

the hard drive of your computer, and install the program.

Clicking the "Show License Information" button displays your license

information. 

Installation Manager - Video Training Options Tab:
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Clicking the "Initial Setup of CAPS" button will launch an Audio Video

which will walk you through entering your license information, granting

CAPS permission to access your QuickBooks file, and the initial setup of

CAPS and various AIA Billing preferences not handled by QuickBooks.  22

minutes.

Clicking the "Setup of QuickBooks"  button will launch an Audio Video

which will provide a review of your QuickBooks company file setup, and

the information that CAPS "expects" to find there, in order to accurately

generate your AIA BIllings.  30 minutes.

Clicking the "Running CAPS"  button will launch an Audio Video which will

provide an overview of running your first set of AIA draws, the creation

of one-time linked records to hold additional information that QuickBooks

has no means of tracking, handling Change Orders, and how to

successfully pick up billing in the middle of a job.  30 minutes.

Installation Manager - Self-Paced Training Options Tab:

Clicking on the "Start Training"  button allows you to run through a "Flash"

presentation.  This is provided for your benefit, and you should find it to

be very helpful in setting up your QuickBooks data file, and running your

new program.  The demonstration contains approximately 45 slides and

should take no longer than 15 minutes to view it. The basics are covered

here, and this is well worth the time in getting billings right the first time.

 The manual has more detailed information, if you have questions – refer

to the Quick Start Guide found in your manual for quick referencing

appropriate page numbers. 

By clicking on the Install CAPS button from the Installation Options tab, you will initiate the installation

and will automatically be taken through the setup process.

For Troubleshooting Help on Installation see:

Construction Application for Payment Solution Common Error Messages  in the program Help file, or for

the most up-to-date comprehensive list of Error Messages, visit our on-line support at http://www.

sunburstsoftwaresolutions.com/aia-billing-caps/  

NOTE:  If problems occur during the installation, specifically a 1329 or 1395 error (possibly others as well),

disable your anti-virus software - after scanning the installation file or media.  Rerun the installation.  As a

general rule, it is NOT a good idea to disable your anti-virus program during the installation of any software

program.

Having clicked the Install CAPS button from the Installation Options tab, you will initiate the installation,

and will be automatically taken through the setup process.  The 7 Steps found in the Installation Wizard

are really quite self-explanatory, and in most cases, you need to do nothing more than simply click the "Next"

button to continue.

Step 8:  Return to Installation Manager

124

55

http://www.sunburstsoftwaresolutions.com/aia-billing-caps/
http://www.sunburstsoftwaresolutions.com/aia-billing-caps/


Construction Application for Payment Solution55

© 2002-2011 Sunburst Software Solutions, Inc.

If you have not already watched any of the Training Demonstrations, select

the Video Training Option tab to view Audio Video training, OR, click on the

Self-Paced Training Options tab to view Self-Paced Flash training.  If you

have purchased the program via electronic download, you may view the

training demonstrations on-line from the Web Service Center (where you

downloaded the program), or by clicking this link:  http://www.

sunburstsoftwaresolutions.com/aia-billing-caps/ 

The training demonstrations are provided for your benefit, and you should find them to be very

helpful in setting up your QuickBooks data file, and running your new program.  The basics are

covered within these training demonstrations, and it is well worth the time in getting your billings

right the first time.  The manual has more detailed information if you have questions - refer to the

Quick Start Guide found in your manual for quick referencing appropriate page numbers.

If you will be using CAPS in a Network Environment , please read the instructions on the following page –

otherwise, continue on to Installation & Initial Connection to QuickBooks®

4.1.4 Installation Wizard

Important Information for Windows Vista & Windows 7 Users:
1. The Vista User Account must have its User Account Control (UAC) set to "On"  (as

recommended by Microsoft).  This setting is found in the Vista Control Panel-->User

Accounts section.  Failure to set the UAC to "ON" will result in Error Code 80040408 -

Could not start QuickBooks.
2. Both QuickBooks and CAPS should be run with standard user permissions (NOT elevated to

run as Administrator).
3. Your QuickBooks company file must live in the Vista Public folder in a network

environment, or, the Private (Your UserName) folder, in a single user environment.
4. For detailed information, see the topic called "Important Information for Windows Vista &

Windows 7 Users ".

Step 1 - Preparing the InstallShield Wizard Step 2 - Welcome Screen
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Step 3 - License Agreement On Some Computers - Enter Company Info

A copy of the entire license agreement  can be found in this manual, as well as, the in-program Help

for your convenience.
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Step 4 - Installation Folder (Vista/Windows 7 32-bit) Step 4 - Installation Folder - (Vista/Windows 7 64-bit)

The software, like any other software program, will automatically default its installation to the computer that

you are using.  DO NOT attempt to change this default location.  Complete Network Installation Instructions

 are included within this manual.  CAPS must be installed on each computer, with all computers sharing a

common "data folder".

Step 5 - Ready to Install Step 6 - Installing

If you are running Windows Vista or Windows 7 a User Account Control window should appear and you will be
required to enter the password of the computer Administrator before the program will complete it's installation
routine.

Step 7 - Installation Complete
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4.1.5 Network Installation

While Sunburst Software Solutions, Inc. does not proclaim to be an "IT Company, we do provide you and your

IT Consultants with Network installation instructions, as a courtesy.  Also, please be advised that we do not

provide any other FREE Network Installation services, support, or troubleshooting assistance.

Running our program on a network is fairly easy.  First, an overall view is explained, and then detailed

instructions are given.  

OVERVIEW
1. The program is installed on each computer that will run the program.  The same version of the program

MUST be running on each computer.  Use the Help menu -> About to check the version on each computer. 

Additionally you may download the most current version of the program from our Web Service Center

(provided that you have a current Annual Maintenance  Contract), by choosing the Help menu -> About -

> Login to the Web Service Center.

***The software may NOT be copied from one computer to another.  Any computer tech who does

this/attempts to do this should be instantly fired***

Since our software requires QuickBooks, Microsoft Word and Excel, each of these products must

also be installed on each PC that runs our software.

If you are running Terminal Services, the software only needs to be installed on the server as

essentially that is where the software is running, and your networking is complete.
2. The Data for the program is kept in a shared folder on the network that each user has FULL PERMISSION to

access.

A Run-time Error 75 or 76 will occur immediately upon starting the program (after double-clicking the

shortcut on your desktop and BEFORE the menu appears) if the permission levels of a specific user are

not sufficient.
3. Our program contains many support files and, therefore, a folder names "Data" contains all of these files. 

The "Data Path", which is specified in the Data Locations  tab (accessed from the System Setup menu ->

Data Locations) points to where this Data folder is and must not contain the final \Data.

For example if the program's data is stored in \\Server\Accounting Shared Data\CAPS\Data, then the

Data Path will be \\Server\Accounting Shared Data\CAPS

IMPLEMENTATION

Backups:  Even if the server is backed up, use the program's own Backup  program to automatically make

data backups.  The reasons for this are many:

Using the program's own data backup  is simple and automatic, once it is setup.

Restoring data  is simple and does not require much searching for what files you may need to

restore.

The program restore  will allow you to specify one particular file if that is the only file you are

having trouble with.

Allows you to keep multiple backups.

  

If the program has not yet been run for the first time:  When the program is licensed on each PC, there is

a "Data Path" folder where you can specify your network folder and you are networked from the start.

By "default" this folder is set locally for a single user system and is different for Windows XP, Vista,

and Windows 7.

You may change this folder upon installation and your networking is complete.

NOTE:  If this folder ever changes, you need to update it's location using the "Browse for Data Path

Folder" button found from the System Setup -> Data Locations  tab.

If you have already been running the program on one computer and now wish to setup another PC:  
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1. Backup your data on the currently functioning computer.
2. From the System Setup menu -> Data Locations tab, and note the current location of your data

(probably on your C drive).
3. Click into the white box her and press the F5 key to be taken into a Windows Explorer window

displaying this folder.
4. Right click on the folder called "Data" and then left click the COPY option.
5. Navigate to the server and create a shared folder for this application if you have not done so already.
6. Double-click into the shared folder, right click, and then left click the PASTE option.  This will copy

your existing data to it's new server location.
7. TEST to be sure that you have necessary permissions to access this folder by creating a simple Word

document named "Test" and saving it to this folder.  ALSO TEST to ensure that you can delete the

"Test" document.  If you cannot save a file to OR delete a file from this folder you do not have

sufficient permissions and will need to resolve this BEFORE you attempt to run CPS.
8. Now that your data has been moved, simply tell the program about it's new location by returning to the

Data Locations tab and using the Browse for Data Path Folder button.

All computers must be running the same version of CAPS - check the Help menu ->About for version

information.

Obtain software installations for new computers from our Web Service Center, which can be

accessed from the computer that the program is currently installed on by going to the Help menu ->

choosing About -> clicking the Login to Web Service Center button.
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4.1.6 Installation & Initial Connection to QuickBooks

For the initial installation, you must have QuickBooks open and be in your company file, in single-user mode,

logged in as the QuickBooks Administrator.

Start CAPS by using Start->Program-> Sunburst Software Solutions ->CAP V 5.0 or look for the icon shown 

on your desktop, and double click on it.  Be sure that your CD is still in the drive, so that your

license information is pre- filled.  

If you purchased CAP via electronic download, simply click "OK" at the message box regarding

the CD, and then copy and paste your license information from the email into the appropriate

boxes.

Enter License Info & click Ok (XP) Follow Instructions, select Ok to continue

After opening the QuickBooks Company file that you will be

using with CAPS, and clicking the OK button, CAPS will now

access your QuickBooks Pro/Premier/Enterprise Company

file requesting that you grant it permission  to access

your file.

64-bit Windows 7

4.1.7 Granting CAPS Permission to Access Your QuickBooks File

Whenever you initially install a 3rd Party Integrated application such as ours, you must grant

permission within QuickBooks to the integrated application before the Integrated Application is able

to communicate with  your company file.  This safety protocol was established by Intuit, so that

QuickBooks users would feel safe using integrated applications.

To grant permissions to an Integrated Application, you must be logged into QuickBooks as the QuickBooks

Administrator (Admin), and be in single-user mode.
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As the QuickBooks Administrator, Certified QuickBooks ProAdvisor, Accountant, IT Consultant, etc. setting

up this program; please take the necessary time, up front, to make sure that the following permission

setting exists - you can even create a new Role in QuickBooks called CAPS, if you would like, and assign it to

multiple people, if you like.  The time you spend now will save someone a frustrated call to Technical

Support, and eliminate the need to call you back into their office to correct any problems.

Be sure to follow the correct instructions, because granting permissions does differ between versions.

Instructions for "Granting Permission for QuickBooks Pro/Premier 2002-2004 or Enterprise 2.0-4.0" can

be found in our On-Line Technical Support Area at http://www.sunburstsoftwaresolutions.com/view-

document-details/granting-cps-permission-to-access-your-quickbooks-2004/enterprise-4.0-file.htm  

Instructions for "Granting Permission for QuickBooks Pro/Premier 2005 and Enterprise 5.0" can be

found in our On-Line Technical Support Area at http://www.sunburstsoftwaresolutions.com/view-

document-details/granting-permission-for-quickbooks-pro/premier-2005-and-enterprise-5.0.htm 

Instructions for "Granting Permission for QuickBooks Pro/Premier 2006-2011 and Enterprise 6.0-

11.0 " can be found in this manual.

Enterprise Solutions Minimum Permission Settings for running Construction Application for Payment

Solution:

The advanced permission setting in Enterprise 6.0 - 11-.0. certainly make a business owner feel more

confident that only the people they really want to have access to certain data, are the only ones that will,

indeed, be able to access it.  However, we have seen many business owners get "carried away"---effectively

stopping people from actually doing their job.  Employees who will be responsible for generating AIA Billings

MUST have the QuickBooks permission levels as outlined in these documents.

User Permission Settings for Enterprise 1.0 - 5.0 can be found in our On-Line Technical Support Area

at http://www.sunburstsoftwaresolutions.com/view-document-details/construction-application-for-

payment-enterprise-5.0-permissions.htm

Enterprise 6.0/11.0 Minimum Permissions

4.1.7.1 QuickBooks 2006-2011 or Enterprise 6.0-11.0 Users

After opening the QuickBooks Company file that you will be using with CAPS and clicking the OK button, CAPS will

now access your QuickBooks Pro/Premier/Enterprise Company file requesting that you grant it permission to

access your file.  The following QuickBooks Integrated Application Screen will appear as shown below.

Intuit has made it easier to grant permissions in these versions, and allows Developers, such as ourselves, to

indicate "how" we will be accessing your QuickBooks company file.  As shown below, CAPS will access your

company data file on a "read-only" basis, meaning, that we will only read the information that you have

already entered in QuickBooks without ever writing anything back.

Select Yes, Always; allow access even if QuickBooks is not running.  In the

Login as: drop down menu, choose the QuickBooks Administrator, or

someone who has sufficient permissions, to access billing information. 

Click the Continue button.

NOTE:  CAPS will only access your QB file when you request it to, so, it is

quite safe to select the Yes, Always  option.

Enterprise Users: be sure that the person chosen in the "Login as" has

sufficient permissions.  See Enterprise 6.0/11.0 Minimum Permissions

.  Permission settings differ between versions.  
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The Access Confirmation screen shown above, simply provides an overview of the

permissions that you have just granted to CAPS, and confirms that it will only Read

QuickBooks Data.

Click on the Done button, and minimize QuickBooks, to be automatically taken to

CAPS for System Setup.

If you do not grant the permissions following these instructions, you must always have your QuickBooks

Company file open when using CAPS, and no one else will be able to generate billings using CAPS.

In QuickBooks 2006/2011 and Enterprise 6.0/11.0 the "Login as;" user must have access to

"Sensitive Financial Information" in order to query per Invoices, therefore, the user selected must

have the correct permissions, as outlined in the Enterprise 6.0-11.0 Minimum Permissions

section.

When you have completed the above screens, you will automatically be taken to CAPS Address Information

 screen.

4.1.7.1.1  Enterprise 6.0-11.0 Minimum Permissions

The advanced permission setting in Enterprise 6.0- 11.0 certainly make a business owner feel more

confident that only the people they really want to have access to certain data, are the only ones that

will, indeed, be able to access it.  However, we have seen many business owners get "carried

away"---effectively stopping people from actually doing their job.

When granting Construction Application for Payment Solution access rights to your QuickBooks file, the user

that is assigned in the “Login As” drop down selection, must have the following access rights to the

QuickBooks company file – otherwise, Construction Application for Payment Solution will not be able to access

the required information to complete your AIA Billings, as well as, various Contract Documents.

As the QuickBooks Administrator, Certified QuickBooks ProAdvisor, Accountant, IT Consultant, etc. setting

up this program; please take the necessary time, up front, to make sure that the following permission

setting exist – you can even create a new Role in QuickBooks, called CPS, if you would like, and assign it to

multiple people, if you like.  The time you spend now will save someone a call to Technical Support, and

perhaps, eliminate the need to call you back into their office from an important meeting.

To ensure that the user has sufficient permissions from the QuickBooks Company Menu, select Users, and

then Set Up Users and Roles. In the User List tab, click on the name of the user to view the Roles assigned

to this user.  Select the Role List Tab, and then press the Edit Button.  

NOTE:  You may, also, create a New Role called CAPS, if you prefer.

Following are the minimum permissions required to retrieve paycheck and time sheet information from

QuickBooks. 

These permissions will allow a user to use CAPS to retrieve Estimate & Progress Billing Information from

the QuickBooks file, and other data required, to create various contract documents.  It does not

necessarily allow them to actually create the Estimate or Progress Invoice itself in QuickBooks.

Select Centers and expand the Activities by clicking on the + sign
1. Click on the Customer Center and expand the list by clicking on the + sign.  Select Partial Access,
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View List, Modify Entries, Print List, and View Balance.
2. Click on the Employee Center and expand the list by clicking on the + sign.  Select Partial Access,

View List, and Print List
3. Click on the Vendor Center and expand the list by clicking on the + sign.  Select Partial Access,

View List, Print List, and View Balance.

Select the Company Area, and expand the list by clicking on the + sign.  Select Company Information, and

grant Full Activity Access to View and Modify.

Select the Customers & Receivables Area and expand the list by clicking on the + sign.
1. Select Accounts Receivable Accounts and grant Full Access to View and Print
2. Select Estimates and grant Partial Access to View, Create, Modify, and Print
3. Select Invoices and grant Partial Access to View, Create, Modify, and Print
4. Select Receive Payments and grant Partial Accesss to View

Select the Employees & Payroll Area and expand the list by clicking on the + sign.  Select Paychecks and

grant Partial Access to View.

Select the Lists Area and expand the list by clicking on the + sign.  Click on Customer & Vendor Profile Lists

and expand the list by clicking on the + sign.
1. Select Customer Message List and grant Partial Access to View List and Print List
2. Select Customer Type List and grant Partial Access to View List, Modify Entries, and Print List
3. Select Job Type List and grant Partial Access to View List, Modify Entries, and Print List
4. Select Payment Method List and grant Partial Access to View List and Print List
5. Select Terms List and grant Partial Access to View Lists, Modify Entries, and Print Lists
6. Select Vendor Type List and grant Partial Access to View List and Print List

Click on the Item List and grant Partial Access to View List and Print List

Click on the Reports section and expand the list by clicking on the + sign.  
1. Select Customers & Receivables and grant Full Access to View and Print
2. Click on Jobs and expand the list by clicking on the + sign

a. Click on Jobs Detail and grant Full Access to View and Print
b. Click on Jobs Summary and grant Full Access to View and Print

4.1.8 What's Next?

After you have completed the program installation and granted Construction Application for Payment Solution

(CAPS) permission to access your QuickBooks Data file, you will automatically be taken to the System Setup-

Address & Defaults window.

Access to your CAPS Manual (in .pdf format) will be available as:

· a shortcut on your desktop

· From your Windows Start button -> Programs -> Sunburst Software Solutions -> CAPS Manual

· From within CAPS by going to the Help Menu, and choosing Manual (.pdf)

Screen (window) sensitive Help is, also, available by clicking on the question

mark (located in the lower right  corner of each screen). Clicking on the button

will open a browser window containing Help that is specific to the screen you

are working in.
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5 Construction Application for Payment Setup - Administrator
& User Manual

Administrator Task:

The initial setup of Construction Application for Payment Solution should be done by the the person

who will be the Construction Application for Payment Administrator.

Audio/Video Training Available:

Audio/Video Training is available for downloading, saving, and installing the software from our Web

Service Center.  

Look for the Construction Application for Payment Solution - Initial Setup Video.

Audio/Video training is accessed via a Link on our Web Service Center, or directly from the On-Line

Support Area of our website using the following url - http://www.sunburstsoftwaresolutions.com/

construction-application-for-payment-free-training/view-category.htm  

5.1 Program Navigation

Navigating Construction Application for Payment Solution is accomplished via simple drop down menus, as

shown below:

The File Menu contains links to:

Application for Payment

Adjustments

Negative Application for Payment

Prior Period Adjustment

Retainage Billing

Billing Sheets

Contract Documents

Qualification Statement

Exit

The *Edit Menu* contains links to:

Jobs

Architects

The System Setup Menu contains links to:

Address & Default Information

Options

AIA Form Printer Alignment

QuickBooks Menu & Notification

Data Locations

Users

The Backup & Restore Menu contains links to:

Enhanced Backup CAPS Data

Enhanced Restore CAPS Data

The Help Menu contains links to:

Contents

Manual (.PDF format)

Setup Wizard

Enterprise Permission Settings

Version 5.0

Version 6.0, 7.0, 8.0, 9.0, 10.0, & 11.0

Where Does the Info Come From? (.PDF format)

On the Web

Video Taining

Support Area

Common Problems

Errors

Forum

Get Adobe PDF Reader

Save $ on QuickBooks

Pay Annual Maintenance

Repair

Registry Entries

Reset QuickBooks after update

Check for Updates

About

*The Edit Menu will contain the "linked records" that you create during your initial billings.*
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In Program Help:  Help is easily accessible from each screen by clicking on the question mark

located in the lower right corner.  Clicking on the question mark will open Help that is specific

to the screen you are working on.
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5.2 System Setup Menu

5.2.1 Address & Default Information

This section is split into 5 different tabs, all of which enable you to set up "default" information for how you

will be billing for the bulk of your jobs.  Because these are the "default" or most often used options, you will

be allowed to change individual items for each job, when you Add the Job  to CAPS.

These tabs hold the default information for 

Address

Job Billing Defaults

Job Printing Defaults

Notary Information

Misc. Document Fields

5.2.1.1 Address

The information that you enter on the Address Tab is the address of your company, which you wish to have

appear in the "From Contractor" section of the G-702 - Application for Payment form.

Special Note about the Billing Contact box - this

box is for the Default company contact for jobs,

such as, the person responsible for Accounts

Receivable  – if there is a different contact for

individual jobs, such as, one of the Job Foremen,

you may change this information at the job set-

up  screen
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5.2.1.2 Job Billing Defaults

The choices offered on this screen reflect your usual billing options.  These options can be changed for

individual jobs, when you Add the Job  to CAPS.

Default Retainage % on Completed Work - if it's normal for retainage to be held at 10% on your jobs, you

should enter 10 in this box. 

Default Stored Retainage % - if it's normal for retainage on stored materials to be held at 10% on your jobs,

you should enter 10 in this box.

Default Billing Period - choose your normal billing period for your jobs, for example, if you usually bill on a

monthly basis, you should select the Monthly option here.

First Period Ending Date - This should be the first billing date for your Applications for Payments that you

generate with CAPS - this can be the date that you purchased CAPS, if you plan on using CAPS from this point

forward, or, if you will be creating job history in CAPS, choose the earliest billing date.

Invoices are usually dated before the "Period To" date on the Application for Payment - for example, if

you are usually billing for work done through the last day of the month, but actually create your bills on the

25th of the month, you should select this option.

Retainage % varies by billing period and is an accumulating balance - if the retainage held varies with

each draw, and you are required to show the accumulated balance on the G-702, check this box.  This feature

will ONLY WORK with Jobs that you have indicated as having a VARIABLE Rate of retainage.

Round amounts on cover page lines 4-8 as whole dollars -  if you would like the amounts shown on lines 4-

8 on the Application for Payment rounded to the nearest whole dollar, select this option.

5.2.1.3 Job Printing Defaults

This screen holds several options for printing on both our plain paper

forms or actual AIA forms, that you have purchased.  Choices made here

may be changed for individual jobs, when you Add the Job  to CAPS.

83
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Print a Page Total at the end of each Continuation Sheet - if you have multiple Continuation Sheets (G-

703) and would like to print a page total at the end of each page, select this option.

Print a Running Total at the end of each Continuation Sheet - if you have multiple Continuation Sheets (G-

703) and would like to include a running total at the end of each page, select this option.  You can combine

Page and Running Totals.

Select a default plain paper copy for each job - from the drop down menu, choose which plain paper billing

form that you will use for your jobs.  View the cover sheet of each available form by first selecting it from

the list and then clicking on the View blank cover sheet selected above button.  Choices include:

      None - indicates that you will not be using any of the plain paper forms available

Standard Form on Blank Paper - selecting this option indicates that you wish to use our standard plain

paper version of the G-702/703

Standard CMa Form on Blank Paper - selecting this option indicates that you wish to use our standard

plain paper version of the CMa (Construction Manager Edition) form

Alternate Form on Blank Paper - the alternate form is our standard G-702 form with the ability to add a

Purchase Order and Job number, in addition to, Federal, State, and Architect project numbers.

Subcontractor Standard Form on Blank Paper - this is a standard plain paper version of the G-702/703

that replaces the term Owner, with GG or General Contractor, and Contractor with Subcontractor.

Subcontractor/Engineer Standard Form on Blank Paper - this is a standard plain paper version of the

G-702/703 that replaces the terms Owner, with GC or General Contractor, Contractor with

Subcontractor, and Architect with Engineer.

Non-Notarized Invoice on Blank Paper - this is a plain paper Invoice format displaying the information

contained on the left-hand side of the G-702.

Non-Notarized Statement on Blank Paper - this is a plain paper Statement format displaying the

information contained on the left-hand side of the G-702.

Track Materials - this is a plain paper version of the Standard G-702 with an additional section on the

"overview" that allows for tracking just stored materials.

Double-Height Details on Continuation - this is a plain paper version of the standard G-702 with bigger

rows for your line item descriptions on the Continuation Sheet.

Change Order List - this is a plain paper version of the standard G-702 which includes a more detailed

listing of Change Orders.  To successfully use this form, your Change Order Items MUST contain a date

and the # sign before the Change Order #, for example 7/31/08 #2.

Alternate "B" - this is a plain paper version of the standard G-702 which includes signature lines for

Inspector of Record, Architect/Engineer, and Owners Representative.

Kentucky Schools - this is a plain paper version of the Standard CMa form, which includes a section for

tracking Owner Purchase and/or Purchase Order Billings.  This form is currently used only for Kentucky

School systems.

Bognet form - this is a customized G-702 Plain Paper Alternative form, designed to meet the billing

requirements of Bognet Construction Associates, Inc. of Maryland.  The G-702 form has been modified to

include a Release of Lien Waiver.

HUD 5100 Series - 

Wilson & Associates - 

Hydrospec - 

Non-Notarized Invoice 2 - 

Standard Owner-Contractor-Engineer - this is a standard plain paper version of the G-702/703

designed to be submitted by Contractors and replaces the term Architect with Engineer.

Standard Owner-Subcontractor-Engineer - this is a standard plain paper version of the G-702/703

designed to be submitted by Subcontractors and replaces the term Architect with Engineer.
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Standard with Quantity and Unit Price - standard G-702 cover sheet with a continuation sheet that

displays Quantities and Unit Prices 

Invoice with Quantity - an invoice type cover sheet with a continuation sheet which displays quantities.

Colorado Structures - this is a custom form required by Colorado Structures, Inc.

Non-Notarized Invoice 3 - 

Owner Contractor Engineer - this is a standard plain paper version of the G-702/703 designed to be

submitted by Contractors and replaces the term Architect with Engineer.

Standard without architect signing - this is a standard plain paper version of the G-702/703 without

the Architect sign-off section.

View blank cover sheet selected above - clicking this button will open a blank cover sheet of whatever form

you have selected for the plain paper copy giving you an opportunity to look at and decide which form to

print.

Maximum characters per description line on plain paper forms - this option allows you to set the

maximum numbers of characters that will display in the description column on the G-703 forms - the default

setting is to display 50 characters.

Maximum lines to print per description on plain paper forms (0 = no maximum) - this option allows you

to set the maximum number of lines to display for each line item description.  The default setting is 0 -

which means that there is no maximum and if you have very long description in your QuickBooks items, all

the data will print on the Continuation Sheet.

Set a default AIA form for each job - from the drop down menu, choose which AIA original form that you will

 use for your jobs; choices include:

None - indicates that you will not be using any of the available AIA forms

Older Original AIA Form - the logo is black and located on the bottom left

Newer Original AIA Form - the logo is red and located on the upper left

AIA CMa Form Type A - on this form, the Via Construction Manager heading wraps; 

Via Construction

Manager: 

AIA CMa Form Type B - on this form, the Via Construction Manager heading is displayed on one line. 

Allow access to Contract Document Manager (CDM) from print screen with Jobs that have 1 or more

copies - selecting (clicking in the box to place a checkmark) will allow you to print Contract Documents of

your choice directly from the Print Screen  for jobs that have 1 or more copies selected to print.

Do not issue warning when more than 1 window will be created when accessing CDM (Contract

Document Manager) from the print screen - selecting (clicking in the box to place a checkmark) indicates

that you wish to turn off warning messages when more than one window (contract document) is created for a

specific job.  Each Contract Document will open in it's own window for you to review, add any additional

information, and print the documents.
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5.2.1.4 Notary

If you have an in-house Notary, or always use the same

Notary for your Application for Payment and Notarized

Contract Documents, you may complete the top portion of

this screen to have the information you input here, appear

on your completed Application for Payment, and to have it

appear in numerous Notarized Contract Documents that you

create with the Contract Document Manager, available in

CAPS.

Representative Information shown in the lower portion of this screen should be completed for the person who

normally signs off on your Application for Payment and Contract Documents.

5.2.1.5 Misc. Document Fields

Through the use of this tab, you can custom define 10

additional document fields, which you can include on

the various Contract documents, provided that you can

generate through the Contract Document Manager

Feature of CAPS.
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5.2.2 Options

From the System Setup Menu, select Options.

These options let you customize the look and feel of your billings.

See the explanations below for what each option will do.

1.  Print current dollar amount instead of retainage % on continuation form?

This pertains to, any and all, Variable Rates of Retainage, by checking this box, the dollar amount of the

variable rate of retainage will appear in Column I on the continuation sheet, by leaving it unchecked, only the

percentage rate (5%, 7%, etc) will appear in Column I.

2.   Add "Item #" to "Item Description" on continuation form?

If you have set up your QuickBooks Item List to have the Item Names be the numbers from Division or CSI

Cost Codes, you may check this box in order to have those specific numbers show up in the Item Column in

your Continuation Sheet.    Using the sample below - the item would show on your continuation sheet as 02

Site Work.

Please be aware that choosing this option does

make bringing your progress invoices into CAPS

slower, because it does have to "combine" these

items.

3.  Add the first word of the "Item #" (up to the first space) to the "Item Description" on the

continuation form?

This one is a tad difficult to explain; but, if you have created your Item Name/Number to include both a

number and a name, and have then entered that same "name" into the description box, and wish to include

only the number with the description on the continuation sheet, you should check this option.  Having your

items set up as shown below, and choosing this option, will show a final result on your continuation sheet of

02 Site Work [using the Description on Sales Transactions entry].  
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Without checking this option, it would appear

on your continuation sheet as 02 Site Work: Site

Work.

4.  Allow Retainage to be combined on last bill?

This option allows you, at the time of your final billing, to bill for not only for the final draw, but also,

request the total amount of retainage that is outstanding on this contract.  This option has been included for

those of you who can bill for your retainage when you issue your final draw, and are not required/or do not

wish, to issue a separate Retainage Requisition.  You may, also, access this option at the Print Screen, by

checking the box for, Include final retainage on bills, with copies greater than 0.

5.  Print Sales Tax on Continuation separated as Original, Prior Change Orders, and Current Change

Orders?

This is a new function for those of you who deal with Taxable Contracts.  Sales Tax is an extremely difficult

item to deal with, for more information on handling these type of jobs, see Taxable Contracts and Change

Orders & Sales Tax.  By selecting this option, you are indicating that on the continuation sheet you wish to

show a breakdown of Sales Tax as follows:

Total Sales Tax Amount Sales Tax Amount from the Original Contract

Sales Tax Amount on Prior Change Orders Sales Tax Amount on Current Change Orders

6.  Print Notary Date on Application for Payment?

Check this box, if you wish to have the current date appear on your Application for Payment in the Notary

section.  For more information on setting up standard Notary information, choose System Setup -> Address &

Default Information, Notary Info Tab

7.  Allow Subtotals and Page Breaks on Continuation sheets?

If subtotals or specific page breaks are needed on the Continuation Sheet, check this box, and then the

Detail Screen for each Application for Payment, will show these options for each detail line.

8.  Print contact & phone AFTER name and address on AIA Bills?

By default, the contact person and phone number are printed BEFORE the company name and address.  By

placing a check mark in this box, the contact person and phone number will be printed AFTER the company

name and address.

9.  Print QB Customer Contact on Copyrighted AIA Forms?

Selecting this option will include the customer contact name from the QuickBooks Job Record to be printed on

any AIA original documents, that you submit.

10.  Do not print lines 5A and 5B on cover sheet when retainage varies.

By default, CAPS provides easily cross-checkable information in section 5 of the Application for Payment with

amounts in both Lines 5a and 5b, and then the total of the two lines, which equals the total in Column I on

the Continuation sheet.  If you do not wish the individual amounts in Lines 5a and 5b to show - displaying

ONLY the total, check this option.

11.  Print retainage in Work Completed (column E) on retainage billing continuation sheets.  When

printing retainage billings you can choose to display the amount retained in Column E.

12.  Track Quantities.  Check this option to enable quantity tracking.

13.  Track Extra Quantities.  Check this option to enable the tracking of extra quantities.  
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5.2.3 AIA Form Printer Alignment

Currently, there are 4 different AIA original formats the program can print, the original and newer format of

the G702/G703, as well as, two versions of the G702Cma. 

The AIA Print Alignment allows you to move all print left or right, and up or down.  As each printer will have

slightly different margins, this screen is useful to align the forms for your printer.  Print a test sheet on a

blank piece of paper and hold it up in the light over an actual AIA Form.  If, for example, the print needs

to be moved to the left one eighth of an inch and down a quarter of an inch, enter -.125 in the horizontal

adjustment and .25 in the vertical adjustment, and then print another test.

Select which form you use, and use the horizontal and

vertical adjustments on the screen to move the print up/

down and left/right, as described.  Print a test on blank

paper and hold it up against an original form into a light to

ensure your alignment is correct.  Adjust the horizontal and

vertical values until your form is properly aligned.

The Fine Tune Adjustment allows you to alter each

individual field print position.  In general, this should not be

necessary.  Items that have their number highlighted are

normally not used on the report, but, may be added by

entering an adjustment relative to 0 for both vertical and

horizontal.   In the above example, to move the “To Owner

Address” to the right a twentieth of an inch, enter .05 in the

horizontal adjustment.  To add the “Job Description in the

middle of the page, enter 5.5 in the horizontal adjustment,

and 4.25 in the vertical adjustment, for this field.
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5.2.4 QuickBooks Menu & Notification

The QuickBooks Menu & Event Notification option will only work if you are using Windows XP.  This is

a know issue with the Intuit Software Development Kit, and we are waiting for them to fix the

problem, however, it appears to remain an issue.  

If you are using QuickBooks Pro/Premier 2004/2011 or Enterprise 4.0-11.0 on Windows XP, you can

automatically have QuickBooks notify CAPS when a job is added, modified, or deleted; merged with another

job, or, if you have condensed your company file.  These changes are called QuickBooks data events, or

simply, data events.  This will help you with setup, as you can add the job to CAPS at the same time that you

add it to QuickBooks, while you have all the necessary information right in front of you. 

Additionally starting with QuickBooks 2004, the SDK allows us to add our menus directly to existing

QuickBooks menus, so that, you may start CAPS directly from within QuickBooks, which will alleviate the

need to minimize QuickBooks, and then, start CAPS.  While these are useful tools, they are not without

drawbacks. 

There are two major drawbacks to these features that we do not have any control over, and that is

why we have made subscribing to these events, optional.

1.  If you are in a network/multi-user environment and CAPS is only installed only on your computer but other

people add jobs or employees, CAPS will not be notified when others add jobs.  You will still need to add the

jobs through the normal reconciliation process.  To avoid this, you could install CAPS on the other user's

computers, and have them subscribe to Add/Change/Delete Notifications – so that, they can complete the

setup for you in both programs.

2.  If you have more than one company that you do bookkeeping/accounting functions for using QuickBooks

Pro/Premier 2004-2011 or Enterprise Solutions 4.0-11.0 – when you add a subscription to one or more

events, that subscription goes into effect for all company files that you work with.  You will want to subscribe

to events for only the company file that you were granted a CAPS license for in order to guarantee accurate

billings, and you can filter out events from other files by denying CAPS access to that file, when you open the

other company files on your computer.    Rest assured, that once you deny CAPS access to the other company

files, it will not access them.

How to add CAPS menu items to QuickBooks and subscribe to events

The first time that you run Construction Application for Payment Solution, and it has determined that you are

using QuickBooks Pro/Premier 2004-2011 or Enterprise 4.0-11.0, you may Add Construction Application for

Payment Solution Menu items to the QuickBooks Customer Menu!

From the CAPS System Setup Menu, choose the QuickBooks Menu & Notification Option:

Initially, you will be presented with this Notice box.  If you

wish to continue, click Ok

This screen is sectioned into two tabs. 
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To Subscribe ONLY to Menu Items:

Use this tab to select, only the Menu items that you

wish to have added to the QuickBooks Customer Menu.

After making your selections, click Apply, wait for the

QuickBooks Menu Items message box that informs you

"These changes will take effect next time QuickBooks

is started", click OK, then Cancel. Close and re-open

QuickBooks, and select the Customer drop down menu

 

You may now, click on any of these items to start the process

directly from within QuickBooks.

Subscribing to the Add/Change/Delete Notification 

Selecting to be notified when Jobs Are Added is a

useful feature, as QuickBooks will notify CAPS when

you add a new job, and the CAPS Job Record will

appear automatically, allowing you to add the details

that CAPS stores.

Selecting to be notified when Jobs Are Modified can

be quite annoying; as, each time you open a

QuickBooks Job Record - QuickBooks will notify CAPS

that the record has been modified; even, if you have

changed nothing.

  

Select the notification types that you wish to be informed of, and click the APPLY button. Wait for the

QuickBooks Menu Items Box informing you that These changes will take effect next time QuickBooks is

started. Click OK, Cancel, close, and re-open QuickBooks.

Important Note:  When multiple computers access the same QuickBooks file, and CAPS is, also, installed on

multiple computers, other users may choose to ignore event notifications by using the ONLY APPLY TO THIS

COMPUTER button, if you are the only person who adds Jobs.  If other users add Jobs, you should choose the

APPLY button, and inform them, that they too, will be notified of the events that you have chosen to
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subscribe to, and that they can complete the required CAPS setup of those items, at the same time.

5.2.5 Data Locations

This will show you where various items are located on your computer or your network - you should take

a screenshot of this information and keep it with your manual or other safe place so that you will know

where it is in the event that a call to Technical Support requires that you have this information on

hand - requiring a Sunburst Support Rep to "find your data for you" in the event of an emergency is a

billable item.

1. Data Path:  This is the location of the CAPS “Data” folder.  By default, this folder is set to where the

program was installed, “C:\Program Files\Cap” on a Windows XP machine OR "C:\Users\Public\Public

Documents\Sunburst\Cap" on a Windows Vista machine.  This folder may be located on the network so

that other users can share the CAPS data.  The program requires that in the folder specified here, that

there is a “Data” folder that contains your CAPS Data, including the files that were installed.  When

setting up a network , copy the entire “Data” folder from the install default, to the new location.
2. QuickBooks File:  This is the location of your QuickBooks data file.  This file must end with .QBW.  A

great trick to use here, is to make this field blank, then with QuickBooks, open to the proper file,

choose File à Application for Payment, and then get invoices, either by date or invoice number. The

program will automatically connect to the QuickBooks file that is open and fill in this field for you.
3. Test QB Connection - with the QuickBooks file location field above empty AND with QuickBooks open

and running with your company file, click the Test QB Connection button to determine it's location.  

IMPORTANT - if your version of QuickBooks is 2004 or older you MUST check the box indicating so,

prior to using the Test QB Connection button.
4. Save Contract Document Folder:  This is the folder where Contract Documents will default to being

saved, after they are created.  (This option is NOT available to Trial Edition Users.  
5. Save Applications for Payment Folder:  If this folder is not blank, when Applications for Payment are

Previewed or Printed on Blank Paper, an Excel copy will be saved in this folder with the job name and

Invoice Date.  This option is not available to Trial Edition Users.
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5.2.6 Users

Construction Application for Payment Solution (CAPS) comes with no initial User or Security functions;

however, you can easily setup users and user permissions.

Important Note:  As the CAPS Administrator it is YOUR responsibility to keep a “master list” of

User Names and Passwords in the event that your co-workers forget.

There will be a $50.00 Technical Support Charge for calls regarding

forgotten and/or lost passwords.

From the System Setup menu – > choose Users

The Admin (Administrator) account has already been created,

HOWEVER, you will need to Edit the Admin account to add a password if

you wish to activate security. 

The default Admin accounts information is as follows"

User Name = Admin

Password = NO PASSWORD

If you do not create a password, you are indicating that you do not desire to implement any security for CAPS

on any of the computers on which it is installed.  User Names and Passwords will  apply to any/all computers

that the CAPS program is installed on.

The main Administrator account has access to all of the functions

listed.

Once a password has been created and verified, click the Ok button

-> Done -> and Yes, to Save Changes.

Exit and restart CAPS.

Once an Administrator Account has a password you will be required to

login to CAPS using the Admin account with the password you created.

The default Admin accounts information is as follows"

User Name = Admin

Password = NO PASSWORD

Usernames and passwords are CaSe sensitive!  Creating a user name of Nancy and then typing in nancy

will result in an error.
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Adding a New User:
From the System Setup menu -> choose Users -> click the Add button

Create a User Name and Password.

1.  Click the box next to the word Administrator if you would like

this user to have the same access rights as the CAPS

Administrator.

OR

2.  Check the box(es) for the options that you would like this

user to be able to access.

NOTE:  Leaving the options unchecked indicates that you do not

want the user to have access to/make changes to the items

listed, however, the user can still run billings.

Make sure that YOU, the Administrator, keep a list of user names and passwords.
Items that are not checked, such as access to Address & Default Info, will no longer display on the menu, see

below:

Access to Address & Default Info appears on the System

Setup menu.  When a user is denied access to Address &

Default Info, the System Setup menu no longer appears on

the menu when that user logs into CAPS.

Additionally, if a User is not given access to the Check for Updates option, that User will not be able to “side

step” and obtain updates through the Help menu -> About -> Login to Web Service Center button.

How to tell who is logged in:
A “Standard User” (one with limited or no additional permissions) will display with their User Name in the

lower left corner of the main CAPS window, see below:

ALL users who have been granted “Administrator Permissions” will simply be shown as being logged in as

Admin regardless of the User Name assigned to them.  This is done to prevent others from knowing the User

Name of Administrators and possibly guessing what the password is.  See below:
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6 Generating AIA Billings - User Manual

6.1 Starting the Construction Application for Payment Solution Process

Administrator Task:  The initial setup and linking of QuickBooks and Construction Application for

Payment Solution should be done by the QuickBooks Administrator in Single-User Mode so that

they can grant CAPS permission to access the QuickBooks data file, if this vital step has not yet

been completed.

Audio/Video Training Available:  Audio/Video Training is available for running your first set of AIA

Billings with the software from our Web Service Center.  

Look for the Running Construction Application for Payment Solution Video.  Audio/Video

training is accessed via a Link on our Web Service Center, or directly from the On-Line Support

Area of our website using the following url -

 http://www.sunburstsoftwaresolutions.com/construction-application-for-payment-free-training/

view-category.htm  

You are now ready to generate your first AIA billings using CAPS.  You should have created all of

your Progress Invoices in QuickBooks and noted what the invoice number range was. 

From the CAPS Main Screen, choose File, and Application for Payment

From the Construction Application for Payment Reconciliation screen, you may 

Using this screen, you may:

1. Select Invoices by Date Range, if you created your progress invoices

over a couple of days in QuickBooks.  This option can be filtered by the

actual date of the invoice, or the date that you modified them.
2. Select Invoices by Number Range
3. Just get progress invoices that were modified today.

You may use the calendar button to help you with dates.  Click, Ok

 A status bar will appear at the bottom of the screen shown above, with a message stating, "Gathering

QuickBooks® estimates."

Permissions Information

If you have not previously granted CAPS permission to access your company file, please follow the

instructions for: 

Granting Permissions for QuickBooks Pro/Premier 2005 and Enterprise 5.0; found in the On-Line

Support area of our website at ttp://www.sunburstsoftwaresolutions.com/view-document-details/

granting-permission-for-quickbooks-pro/premier-2005-and-enterprise-5.0.htm

Enterprise Solutions Minimum User Permissions can be found in the On-Line Support area of our

website at http://www.sunburstsoftwaresolutions.com/view-document-details/construction-

application-for-payment-enterprise-5.0-permissions.htm

Granting Permissions for QuickBooks Pro/Premier 2002-2004 and Enterprise 1.0-4.0; found in the

On-Line Support area of our website at http://www.sunburstsoftwaresolutions.com/view-document-

details/granting-permissions-for-quickbooks-pro/premier-2002-2004-and-enterprise-1.0-4.0.htm

http://www.sunburstsoftwaresolutions.com/construction-application-for-payment-free-training/view-category.htm
http://www.sunburstsoftwaresolutions.com/construction-application-for-payment-free-training/view-category.htm
http://www.sunburstsoftwaresolutions.com/view-document-details/construction-application-for-payment-enterprise-5.0-permissions.htm
http://www.sunburstsoftwaresolutions.com/view-document-details/construction-application-for-payment-enterprise-5.0-permissions.htm
http://www.sunburstsoftwaresolutions.com/view-document-details/granting-permissions-for-quickbooks-pro/premier-2002-2004-and-enterprise-1.0-4.0.htm
http://www.sunburstsoftwaresolutions.com/view-document-details/granting-permissions-for-quickbooks-pro/premier-2002-2004-and-enterprise-1.0-4.0.htm
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Granting Permission for QuickBooks Pro/Premier 2006-2011 and Enterprise 6.0-11.0  can be found

right here in your manual.

Enterprise 6.0-11.0 Minimum User Permissions  can also be found right here in your manual.

If you granted CAPS permission to access your QuickBooks file during the initial installation, you will

automatically be taken to the Construction Application for Payment Reconciliation Step 1  Screen.

Troubleshooting:

If you receive an error message stating that "No Invoices were found", either, you have 

not setup your QuickBooks Job Record  correctly, you happen to have the Progress Invoice in question

open in QuickBooks, have you created an Estimate  in QuickBooks, did you create a Progress Invoice

in QuickBooks for this draw (CAPS cannot work with just a "normal or regular" QuickBooks Invoice).  If you

are using Enterprise 6.0/10.0, user permissions may not be adequate.

Refer to the Quick Start Guide  for more detailed information regarding proper setup for the successful

generation of AIA billings.

Specific Instructions for using CAPS can be found in the following manual sections:

How to Implement CAPS in the Middle of a Current Project

How to Migrate to CAPS from Another Billing Program

How to Bill with Different Rates of Retainage on Different Line Items

How to Deal with Fixed Rate Retainage Changes at Different Points in the Contract

How to Deal with Variable Rate Retainage Changes at Different Points in the Contract

How to Deal with Change Orders

Using CAPS with Time & Materials Jobs

61

62

83

23

42 43

17

92

93

94

94

94

95

47



Construction Application for Payment Solution83

© 2002-2011 Sunburst Software Solutions, Inc.

6.1.1 Reconciliation Step 1 Screen

After you have told CAPS what invoices to retrieve from QuickBooks, using a Date or Invoice Number range,

you will  be taken to Construction Application for Payment Reconciliation Step 1 screen.  This screen will

appear with columns containing the following information: 

Estimate # from QuickBooks 

Job Name from QuickBooks

Invoice Date of your QuickBooks Progress Invoice

Total Amount of your QuickBooks estimate

Invoice # is your QuickBooks Progress Invoice Number

To Date may be manipulated here, if you frequently issue draws prior to the period ending date 

Job - where you may Add the Job  to CAPS own database

Detail - where you may View the Detail  of the information that will be shown on the Continuation

Sheet, enter stored material, enter different rates of retainage for each line item, etc.

Print - where you can Print  your Applications for Payment

In the Job Info column, click the Add button  – this is where you will

add the QuickBooks job to CAPS database, and create a linked record

containing information relevant to the contract that QuickBooks Pro®

has no capabilities to track.

6.1.2 Adding Jobs

After selecting the Add Button from the Reconciliation Step 1 screen , you will be taken to the Job

Maintenance screen, which is divided into three different tabs, where you will be requested to fill in the

following information:

Basics Tab:

Pay close attention to the Original Contract Amount.  CAPS will pull

in the amount that is equal to the TOTAL of your QuickBooks

Estimate.  Most of the time this amount is accurate....UNLESS....

You are picking up in the middle of an existing job, which has current

or previous change orders, OR,

This is your first billing, and you already have change orders.

The Basics Tab contains the following information about your job:

Project Name - This is the QuickBooks Job Name that you are creating a "linked record" for.

Original Contract Amount - The amount shown here is the TOTAL amount of your QuickBooks

Estimate.  NOTE:  Most of the time this amount will be accurate, however, you will need to

manually change this amount if you are picking up in the middle of a job that has current or prior

Change Orders, or, if this is your first draw, and you have already had a Change Order without ever

having issued a draw request.  If either of these situations occur, all you have to do is type the

correct amount in the box, and use the Detail  screen to set the correct status of your line

items.

Original Contract Date - This is the date that you originally signed the contract

Contact - this is the default person to contact in your company, and comes from System Setup ->
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Address & Default Information -> Address Tab , you may change this Contact person right here,

at the Job screen.

Federal Project Number - manually input "Federal Project #" for it to appear on the G-702

State Project Number - manually input "State Project #", for it to appear on the G-702

Architect Project Number - manually input "Architect Project #", for it to appear on the G-702

Via Architect - This is the Architect/Engineer in charge of the project, click on the Edit Architect

button, and follow the instructions found in the Adding Architects  section

       Additional information for use on Alternate forms only.

Via Contract Manager (CMa Form) - enter Contract Manager information

P.O. # (Alt Form) - if you will be using the Alternate form, enter the P.O. #

Job Code (Alt Form) - if you will be using the Alternate form, enter the Job Code here

Contract Documents button - issue Contract Documents  directly from the Job Maintenance

Window.

Billing Tab:

The Billing Tab will show you the defaulted preferences which you

set up in the Job Billing Defaults, found by going tot he CAPS

main window, and choosing System Setup -> Address & Default

Information -> Job Billing Defaults  tab.

You may change any of the items shown here, however, the

changes that you make here will ONLY be for this specific job.

Printing Tab:

The Printing Tab will show you the defaulted preferences that you set up in

the Job Printing Defaults , found by going to the CAPS Main window,

and choosing System Setup ->Address & Default Information ->Job Printing

Defaults.

You may change any of the items shown here, however, the changes that

you make here will be ONLY for this specific job.

When you have completed these three tabs, click the Save button, to return to the Reconciliation Step 1

Screen

6.1.3 Adding Architects

Architects and Engineers may be added to CAPS in two ways.  Initially, you may setup all of the Architects

and Engineers by choosing Edit from the Main CAPS window, and selecting Architects, or, you may add

architects "on the fly" as you are Adding Jobs , by clicking on the Edit Architect button on the Basics Tab

of the Job Screen.

Either Method will take you to the screen shown below:

To Add an Architect:
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1.  Select the Add Button

2.  Enter the Architect's Name, Address 1, Address 2, City, State,

Zip. Contact Person, and the Phone.  These items will appear on the

Application for Payment Via Architect/Via Engineer section.  

3.  Fax and Email address are optional

4.  When this screen is complete, choose OK, Done, and Yes, to

Save Changes.

Architects will now be available in the drop-down list on the Job

screen.

6.1.4 Viewing the Detail

After selecting the Detail button from the Reconciliation Step 1 screen , a screen containing the detail

of what will appear on the Continuation Sheet will appear, similar to that shown below.

Job Name - your Job name from QuickBooks

Application # - the first time CAPS sees a draw, it will default to Application #1 (meaning, it's the first time

its seen anything to do with this job), you can overwrite the existing Application Number with the correct

one, by simply typing in the correct number.

Line 7 Adjust - This adjustment may be useful when picking up in the middle of a job.  This adjustment

ONLY affects Line 7 (Less Previous Certificates for Payment) on the Application for Payment, for the date

entered.  For more information, see Prior Payment Adjustment . 

Period Ending - this is the Period Ending information for this Application for Payment, you may adjust the

date here, if necessary.

Invoice Date - this is the date of your QuickBooks Progress Invoice.

Line - this is the line number position on the Continuation Sheet

Description - this is the QuickBooks Item Description

Scheduled - this is the Scheduled Value Amount from your QuickBooks Estimate

Previous Bill - this would be the total of all amounts previously billed 
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Current Bill - this is the Current Amount due for this line item from your QuickBooks Progress Invoice

Status - this column is very helpful when you start to use CAPS in the middle of an ongoing job,

simply click into the status column for a specific line item, and from the drop down menu, choose

the appropriate status, as follows:

Original - when an item has a status of Original, it means that it is part of the Original Contract

Prior - when an item has a status of Prior, it means that it is a Change Order that happened in a Prior

Billing

Current - when an item has a status of Current, it means that it is a Change Order that is Current as of

this billing

Future - when an item has a status of Future, it means that it is a Change Order that will occur

sometime in the future

Stored - because QuickBooks cannot deal with stored materials, when you have stored materials on the

jobsite, you simply indicate here what amount of the current billing is stored materials

Retainage % - if you have indicated in the Job setup , that this is a job with Variable Rates of Retainage,

this column will be white (active), and you can enter the rate of retainage for each individual line item

Subtotal - if you have turned on the Subtotal option in System Setup -> Options .  If you check the

subtotal box, the subtotal will appear AFTER this detail line is printed on the continuation sheet.

Page Break - if you have turned on the Page Break option in System Setup -> Options .  If you check the

Page Break box, the Page Break will appear AFTER this detail line is printed on the continuation sheet.

Change Multiple Lines button :  allows you to change the Status for multiple lines, which is very helpful if

you are picking up in the middle of a job which has several change order lines.  For additional information on

using the Change Multiple Lines button, refer to the next page.

Special Corrections button : allows the correction of some but not all errors caused by user data entry or

data manipulation in QuickBooks which compromise the integrity of their billing history.  For additional

information on using the Special Correction button to resolve common user errors, see http://www.

sunburstsoftwaresolutions.com/view-document-details/aia-billing-best-practices-and-resolving-common-

user-errors.htm

Review this screen carefully for accuracy, matching it with your QuickBooks Progress Invoice. 

When you are through reviewing the contents of the Detail Screen, click OK to return to the 

Reconciliation Step 1 Screen .

6.1.4.1 Change Multiple Lines

Clicking on the Change Multiple Lines button provides a very useful

option; especially, if you are starting to use CAPS while in the middle

of a contract.  As an example, using the screen shot of the detail

screen above, we wish to change the status of lines 3 and 4 from

Future to Current, we would:

1.  Click the Change Status code for multiple lines button

2.  We wish to make changes From Line 3 To Line 4, so, we would

enter the line numbers in the appropriate box

3.  From the Status drop down menu, we would select Current

4.  And then, click the Ok button

Status - this column is very helpful when you start to use CAPS in the middle of an ongoing job,
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simply click into the status column for a specific line item, and from the drop down menu, choose

the appropriate status, as follows:

Original - when an item has a status of Original, it means that it is part of the Original Contract

Prior - when an item has a status of Prior, it means that it is a Change Order that happened Prior to

this billing

Current - when an item has a status of Current, it means that it is a Change Order that is Current as

of this billing

Future - when an item has a status of Future, it means that it is a Change

Order that will occur sometime in the future

6.1.4.2 Special Corrections

When you click on the Special Corrections button, you are initially prompted to make a Backup  of your

CAPS data.  

This is a critical step BEFORE attempting to use this function to attempt to correct billing errors caused by

changing an item in your estimate, for example.

It is a common misconception by most users that their CAPS data is backed up when they backup their

QuickBooks data - this simply is not the case, as they are individual programs each containing their own

data.

If you have not been backing up your CAPS data, follow the instruction found under Enhanced Backup CAPS

Data  BEFORE you continue.

The Special Corrections button will allow you to:

Merge Lines - if they appear duplicated in the detail window.

Delete Lines - as long as they do not have a Previous or

Current Billed amount and no longer exist on your QuickBooks

Estimate.

Move Lines - if the line item order has changed on your

Estimate from their order on previous draws.

For detailed information on using the Special Corrections button in the 4 most common user data

entry errors, see Best Practices for AIA Billing AND Resolving User Data Entry Errors from

QuickBooks When Using Construction Application for Payment Solution for AIA Billing in our Support

Area - http://www.sunburstsoftwaresolutions.com/view-document-details/aia-billing-best-

practices-and-resolving-common-user-errors.htm.  These data entry errors include:

1. Deleting lines from the QuickBooks Estimate after issuing one or more progress invoices/draws

whether that line has been billed or not.
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2. Changing the structure of the QuickBooks Estimate after issuing one or more progress invoiced/draws

- this includes moving or rearranging the way the line items appear on the Estimate whether or not

those line Items have billing history.
3. Inserting multiple lines into the existing QuickBooks Estimate using the same QuickBooks Item

repeatedly.
4. Handles Change Orders in a manner that no one can really track the changes without consulting the

original paperwork - this includes simply changing the dollar value of a line item.

6.1.5 Printing

After selecting the Print Button from the Reconciliation Step 1 Screen, you will be taken to the Print Screen,

similar to that shown below:

Choose to Preview, Print on Blank Paper, or Print on AIA Forms

that you have purchased, and are now ready to feed into your

printer.

How to use this screen:

Set All Copies To button - for example, let's say that you have 10 different jobs listed in the print grid,

but you would like to only Preview the pay app for job xxxxx.  First, you would put a 0 in the white box,

and then press the Set All Copies To button.  Then in the grid, you would enter a 1 in the copies column for

job xxxxx, and press the Preview button.

Select Printer - this will allow you to choose which printer you wish to print to

Preview - this will open Excel and allow you to preview the Application for Payment, click the Close button,

and then Preview the Continuation Sheet, for this job.  A Runtime Error 91 when selecting Preview,

indicates that you do not have Microsoft Excel installed on your computer.

Print on Blank Paper - selecting this button will generate your pay apps on plain paper, using the form

that you selected when you added the job  to CAPS under the Printing Tab, or, the forms that you

selected when you setup your Job Printing Defaults  .  A Runtime Error 91 when selecting Print on

blank paper, indicates that you do not have Microsoft Excel installed on  your computer.

Print on AIA forms - selecting this button will generate your pay apps on AIA Original Documents that you

have purchased and are feeding into your printer, using the form that you selected when you added the

job  to CAPS under the Printing Tab, or, the forms that you selected when you setup your Job Printing

Defaults .  

Contract Documents - Contract documents  are now available to be printed directly from this screen for

Job with copies set to 1 or higher.

Complete - indicates that you have completed printing, and now, wish to post the pay apps to CAPS, for it

to keep in its history.

Troubleshooting:

1. Print not aligning properly on purchased AIA forms - have you performed the AIA Form Printer

Alignment , or, have you failed to select the correct AIA form to use for this job?
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2. Runtime Error 91 when selecting Preview or Print on Blank Paper - to print on the Plain Paper

version of the forms, you must have Microsoft Excel installed on this computer.
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6.2 How To Use CAPS

Getting off to a good start with CAPS will depend on how you have previously issued your AIA

billings.  This section will cover the most common situations.  Please take some time to read

through this section, as it will provide you with a complete set of "how-to" instructions.

We realize that many of you may be purchasing this program:

after running QuickBooks Pro® for some time, and that you may have already issued numerous

Progress Invoices against various jobs

you may have used QuickBooks for a long time while doing all your billing by hand, through the use of

Excel spreadsheets, or in a stand alone program, and only creating a single line invoice in QuickBooks

to track your Accounts Receivable, and have never once, used the Estimating and Progress Invoicing

features of QuickBooks

you may be brand new to QuickBooks and are feeling totally overwhelmed

Whatever your situation, rest assured that we have designed our program to accommodate these

situations.
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6.2.1 Things You Absolutely Cannot Do!

For more detailed information, read the "8 Deadly Sins of AIA Billing with CAPS" found in our

On-line Support area at http://www.sunburstsoftwaresolutions.com/view-document-details/8-

deadly-sins-of-aia-billing-with-construction-application-for-payment-solution.htm 

After you have brought a job into CAP and generated AIA type billings, you cannot:

 1. Delete lines from Estimate and/or Progress Invoice - instead, use the CAPS Detail  screen and

set the status to "Future", meaning, this hasn't happened yet.  Really, the best way to do this, is to

create a negative line item on the QB Estimate, and "bill it" on your progress invoice.  See 

Handling Extra Work Orders or Change Orders

 2. Change the structure of the Estimate and/or Progress Invoice, by moving line item positions.

 3. Insert a line that uses the same QuickBooks Item, as the line that will be directly following the

newly inserted line.  If you insert multiple lines, none of these lines may be the same item as the

existing item following these lines. See Inserting Lines .

 4. Please note, that you may have only 1 invoice for any given date for a specific job in QuickBooks.

Having more than 1 invoice for the same date will confuse CAPS, as well as, yourself.

 5.  If you choose to round lines 4-8 on the G-702 to the nearest dollar, you cannot make a line 7

adjustment in pennies.

 6.  Issue Credit Memo's in QuickBooks, and EXPECT CAPS to pick these up as negative change orders

that reduce individual line items on the Estimate.  Line Item reductions such as these, should be

properly shown on the Estimate, and therefore, the Continuation Sheet.  See Negative Application

for Payment

You MAY be able to correct these actions using the Special Corrections  button.  For more detailed

information see the following Support Article found on our website; http://www.sunburstsoftwaresolutions.

com/view-document-details/aia-billing-best-practices-and-resolving-common-user-errors.htm.

CAPS must work in a logical manner due to some limitations in the QuickBooks® Software Development Kit 

(SDK).  The entire process starts with your original bid or Estimate, for the job; you enter those line items

with their original values, once in the QuickBooks® Estimate Form, those items MUST remain unchanged

during the duration of the job; meaning, that 3 months into the contract, you can not go back and change an

amount or a description.  Such an action will only confuse CAPS, and cause you problems.

In the natural course of a construction project, there are times when Change Orders or Extra Work orders

can both increase or decrease the original contract; in a logical fashion, those changes MUST be added to the

bottom of the Estimate after the line items for the original portions of the Estimate; you can not go to the

Estimate and just increase the dollar value for line item X, as it throws off the entire history of your job.

You return to the Estimate each month when you are ready to do a draw request, create a Progress Invoice

indicating the amounts that you are currently billing for; once the Progress Invoice is created, you can not

add additional items that do not exist on the Estimate Form - other than a Subtotal and a Less Retainage

item; because that line item has nothing to link back to, nor does it automatically add that line item to the

Estimate for you.  An action such as this, will only confuse QuickBooks®, CAPS, and also, yourself.

CAPS is only able to utilize line item descriptions and dollar amounts, from the Estimate and Progress

Invoice, CAPS completes all other mathematical calculations that are required on the Continuation Sheet;

CAPS cannot work off the similar columns on the Progress Invoice because the SDK does not allow access to

those columns, and even QuickBooks® itself, does not keep track of the amounts in those other columns

anywhere, other than on the Progress Invoice - meaning, you cannot generate a report showing all of the

information on that Progress Invoice.  CAPS utilizes a "read-only" access of your data file, and does not

write any information back to your QuickBooks® file, ensuring the safety of your data.
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6.2.2 Implement CAP in the Middle of a Current Project

If you have been using the Estimating & Progress Invoice features, you should be pretty well "good to go".  

The only thing that could pose a problem with your success is how you have handled Extra Work Orders,

or Change Orders in QB in the past, for our program to operate, all Extra Work Order, and Change Order

Information, must be part of the original estimate in QB.  For more information, please read Handling

Extra Work Orders, or Change Orders , and Accounting for Stored Materials .  You may, also, want

to review the entire section on Using QuickBooks for Estimating , as you may need to make some

changes.

 

Generate and print your latest batch of Progress Invoices from QB, print out the Contract Information

Report (if you have one), and have a copy of the Original Contract paperwork in front of you

From the CAPS Startup Screen, choose File, and Application for Payment

On the Construction Application for Payment Reconciliation  screen, enter your Progress

Invoice generation date, or the number range of the progress invoices that you just generated, and

click the OK button

You will have a status bar at the bottom of your screen, while CAPS accesses your QB file.

In a few moments, the Reconciliation Step 1  screen will appear showing you a list of all your

jobs.  

From the Job column, click the Add button.  Using the information from your Contract Information

Report and the Original Contract, fill in the required fields on the Job Maintenance  screen.  If

you have already had Change Orders to this Estimate, you will need to manually change the original

contract amount.  When you have completed this, click the Save button to be taken back to the

Reconciliation Step 1 Screen, and click on the Detail  button.

You are now taken to the Detail  screen, which is a line-by-line duplication of your QB Estimate/

Progress Invoice.

Using your Progress Invoice for this job, enter the amounts from the Progress Invoice Prior

Amount column for each line item in the Previous Bill column of the screen in front of you.

Need to make an Adjustment to Line 7?  Enter that amount in the Line 7 Adjust  box.

In the Status column of the Detail Screen , scroll to the lower portion until you reach the section

regarding your Extra Work Orders or Change Orders, using the drop down menu functionality of

this column, choose the status of these items:

 o Original - these are the line items that were part of your original bid

 o   Current – for an Extra Work Order or Change Order that was dated during the current

billing cycle

 o Prior – for an Extra Work Order or Change Order that was dated during any previous

billing cycles

 o Future – you would only use this, if your were running earlier billing cycles

In the Stored column, enter an amount of materials stored on

the job site.  NOTE: on the completed  continuation sheet, the

amount in the Current Bill column will be reduced by any

amounts in this column.

 

 Review this screen for accuracy against your Progress Invoice, if all is accurate, click on the OK button

 You will now be taken back to the Reconciliation Step 1 screen, where you may choose to print, if you
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wish.

 If you select the Print button, you will be taken to the Print  screen where you will enter the current

application  number in the Application # column, be sure the correct printer is selected, and set the

number of copies to 1  for a test, and press the Print button.  

 Review the generated documents for accuracy, and if all is well, print as many additional copies as

needed,  before clicking on the Complete button.

Change Multiple Lines :

Clicking on the Change Status code for multiple lines is a very useful option; especially, if you are starting

to use CAPS while in the middle of a contract.  As an example, using the screen shot of the detail screen

above, we wish to change the status of lines 3 and 4 from Future to Current, we would:

1.  Click the Change Status code for multiple lines button

2.  We wish to make changes From Line 3 To Line 4, so, we would enter the line numbers in the appropriate

box

3.  From the Status drop down menu, we would select Current

4.  And then, click the Ok button

5.  For more information on this function, see Viewing the Detail

A Run-Time Error 91 at the print screen indicates that you do not have Microsoft Excel installed

when choosing to Print on Plain Paper or Previewing.

Your job setup is now complete.  For future applications, you will only need to enter amounts for materials

that are currently stored.

6.2.3 Migrate to CAP from Another Billing Program

If you previously have generated all of your billing in another program that has not had a

QuickBooks interface, and you have not used the Estimate/Progress Invoice functions of

QuickBooks, but rather, have only created simple one line invoices in QuickBooks to record current

Accounts Receivable, there are several things that you can do.

If the contract has a fixed rate of retainage until it is completed – 

1.  Create an Estimate, giving it a date of the original contract date, using items to give you the amount

of detail that you are required to show on the Continuation Sheet.

2.  Using your most recent draw request as a reference, create a single progress invoice for the amounts

located on the Continuation Sheet in Column G – Total Completed and Stored to date. 

3.  Date the QuickBooks Progress Invoice with the Application Date from the Continuation Sheet.  Note the

invoice number.  Select Save & Close.

 4.  Go to CAP, choose File, Application for Payment, enter the Progress Invoice Number, click Next, Click 

Add , and complete the job record.  Select the Detail  Button, and verify that the dollar amounts in

the Current Bill Column match Column G of your existing Continuation Sheet.  Use the Status Column to

verify each line item's status as follows:

Original – part of the Original Contract

Prior – a prior change order or extra work order

 Current – a current change order

Click OK, when you have completed this task.  Select Print , and then Print out a single copy of the

billing from CAP.  Compare it to the app from the other program, and file it away.

5.  Go back to QuickBooks, find and open, the Progress Invoice.  From the Edit Menu in QuickBooks,

select Mark Invoice as Pending, select Save & Close.  Do not skip this step.  If you do, your Accounts

Receivable Report will be overstated.  Pending Invoices, like Estimates, are Non-Posting.

 

If the contract retainage has dropped or changed – Repeat steps 1 through 5 for each time it has
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changed. 

6.2.4 Bill With Different Rates of Retainage on Different Line Items

When you set up your job in the Job Maintenance Screen , choose Variable Retainage. In the Detail

screen, in the Retainage Column, enter your retainage percent rates for each line item.  CAPS is designed

to automatically calculate the amount of retainage for each line item using this method, and will accurately

report it on the Contractor Application for Payment Sheet in Item 5.  CAPS will, also, remember these

varying line item retainage rates for future applications.

 

IMPORTANT NOTE:  If you are required to collect sales tax  and do not wish to have Retainage held on

the sales tax portion of this billing, in the Retainage Column, enter the percentage for your individual line

items, but when you reach the line item for Sales Tax, put in 0.  

You will need to go back into QuickBooks Pro®, pull up the Progress Invoice, scroll to the end of the

estimate, insert a Subtotal line, then insert your retainage item, and enter this figure as a negative

number.  See the Retainage  section of this manual for more details.

6.2.5 Deal With Fixed Rate Retainage Changes at Different Points in the Contract

Every once in awhile you will start billing on a contract, only to find that when the General

Contractor pays you, that they held retainage at a different rate than what you used when

billing, or, the contract will indicate that retainage is to be held at 15% until you are 50%

complete on the job, then retainage will reduce to 5%, or other similar examples.  

This is a very simple thing to handle in CAPS.

 Start CAPS

 Choose, Edit, and then Jobs

 From the Job list, click on the job with the change to highlight it, and click on the Edit button

 In the Job Maintenance screen, change the amounts in the Retainage on Completed Work, and

Retainage on Stored Work, to reflect the new rate.  Click on the Save button – the following screen

will  appear

 

 

Click on the Yes button, and you will automatically be taken to the Print Screen.

6.2.6 Deal With Variable Rate Retainage Changes at Different Points in the Contract

Individual line items may have different retainage rates for different billing periods.  The rule

of thumb is that the retainage rate should change only when a retainage bill is created.  When

you create a retainage bill, the rates are only changed from that point forward.  

Besides the prior example, your line items may represent phases of a project.  And in a large project, after

certain phases are complete, you may be able to bill the retainage for those phases before the project has

completed.  So, the retainage rate for those lines will be 10% up to that date, and 0% after that point in

time.
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In the prior versions of CAPS, if you changed retainage for one bill, the retainage rate changed for all bills.

So now, when you change a variable retainage rate, the following screen will appear to allow you to

determine which applications the new retainage rate change should be applied.

 

Modify Retainage from this point forward – will change the retainage rate of this application

and all future applications.  It will not affect your previous applications Retainage.

Modify retainage from this point backward - will change the retainage rate of this application

and change all previous applications retainage.  

Modify Retainage for all applications – will change the retainage rate for all applications.

Modify retainage for this application only – will change the retainage rate for this application,

only.  

Cancel "Save" command and return – returns you to the Detail Screen, where, if you press

Cancel again, will revert any changes you made, and restore your previous retainage rate.

 

Lastly, when a new Application for Payment is created, the retainage rates used will be from the last

Application for Payment, or Retainage Requisition.  If the retainage bill is created for the same date as

an Application for Payment, the Retainage bill is considered to come after the Application for

Payment.

6.2.7 Deal with Change Orders

CAPS handles and recognizes Change Orders easily & accurately with two exceptions

1.  You have a brand new contract and receive a Change Order/Extra Work Order before you ever do your

first draw

2.  You begin to use CAPS midway in a project that has existing Change Orders/Extra Work Orders.

In each of these examples, you need to "help" CAPS a bit by doing the following:

1. When you first bring in an application for a new job, in the Job Screen , OVERWRITE the

amount in the Original Contract Amount Box (it will be the TOTAL of your QuickBooks Estimate

including Change Orders.)

 2. Click the Detail Button , scroll to the bottom where the change order items are, and set their

status to:

 Original – part of the Original Contract

 Prior – a prior change order or extra work order

           Current – a current change order

83
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6.3 Backup & Restore CAPS Data

We cannot stress how important it is to back up  your data!  Whether, it's your QuickBooks or

CAPS data.

With that in mind, please be aware that your CAPS data is not backed up when you backup your QuickBooks

file, and we have provided you with a means to quickly and easily back up your CAPS data in the event of

hard drive failure, or other computer issues.

Our backup routine creates a single "zip" file, which reduces the storage space/size required, and is easier

to copy to a CD or other media.  This routine can be set so that you can automatically backup your CAPS

data, every time you exit the program.  Also, if need be, you can selectively restore specific files from the

backup.

Please be aware of the notes below:
1. It is HIGHLY recommended that you create a folder on your "C" (local drive) or network drive, to save

your backups, and not a removable drive.  After you have made the backup, you can then copy it to a

CD or other external media.
2. If you have CAPS for multiple companies, you will need to have a separate backup folder for each

company.
3. While a complete system backup is good, do you know how to restore just a single file or folder? 

Most people do not.

6.3.1 Enhanced Backup CAPS Data

Main CAPS Menu, choose Backup and Restore, Enhanced Backup CAPS Data

If you created a folder on your computer or a network drive to hold your backups,

use the Browse for Backup Folder button to locate it.

You have the option to backup your data automatically each time you exit CAPS.

You may choose how many backups to keep each day, as well as, how many

previous backups you wish to keep.

Each backup is roughly 1.5 megs (due to the Contract Documents).  A minimum

of 5 backups is recommended.  Keep more, if you can.

Using the Browse for Backup Folder Button

Clicking on the Browse for Backup Folder button, will display the following screen

If you have not already created a folder in which to hold your CAPS Data, you can do so

from within this window.  It is HIGHLY recommended that you create the folder in a

place that is easy for you to remember - such as, My Documents.

To accomplish this:

Click on the + sign next to Documents and Settings.

Click on the + sign next to your name.

Click on My Documents (it will highlight and expand)

Click on the Make New Folder button.

While the New Folder box is active (see left screenshot), click into the box where it says New Folder, and
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type in CAPS Backups.

Click on the Ok button to create and save your backup folder - as well as, save its location in the backup

window, as shown below.

Clicking on the Backup button produces the following results - first, the

Progress bars will fill, and then the Backup Completed Successfully window.

If you wish to verify that the backup was indeed created, click the Yes button.

Each backup file name contains the date and time it was created, so, you can

easily see when the date of your last backup was made.

6.3.2 Enhanced Restore CAPS Data

From the Main CAPS Menu, choose Backup and restore, Enhanced Restore CAPS Data.  CAPS will

automatically remember the last backup it made, where it is to retrieve it from, and where it is supposed to

restore it to.  All pretty easy stuff, isn't it?

If you are restoring your data after a computer crash or to a new computer, use

the Browse for File to Restore button to locate where your backup is currently

stored.

*Use the Browse for "Data Path" to be Restored button to indicate where the

data is to be restored to.

Click the Restore All Data to restore all of the data contained in your last

backup, OR, Selective Restore, if you only need to restore a portion of your last

backup.

*In most cases, the "Restore CAPS Data to Folder"  is correct, and it is determined from information

contained in System Setup -> System Preferences -> Data Locations, and should not be changed.  Should you

wish to change the location, then use the "Browse for "Data Path"  button.
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More About Selective Restore

There are times when the information contained within the CAPS Linked Job Records become corrupted.  The

most common causes of this are:
1. CAPS is installed in a network environment, you update to a new version of CAPS and create your

billings; your co-worker (who has not installed the newer version of the program) goes into CAPS to

reprint some old billings.  OOPS, the data is now corrupted.
2. Sometimes data within QuickBooks becomes corrupt, sometimes it is not apparent when we look at

the QuickBooks data, and other times, it is very apparent.
3. Right in the middle of running your billings, the power goes out, and you do not have a battery backup

to keep your computer running during such a situation.

The Selective Restore option allows you to restore data from predefined file

groups (use the drop down menu), to select to restore Architect/Engineer

Information, Jobs, Blank Master Construction Application for Payment

Spreadsheet(s), etc.

OR, if you need to restore something more specific, like your Warranty

Statement, you would select Letters\ Warranty Statement.Doc from the 

Select specific files from CAPS Data backup Content listed below section.

6.4 Amending the "Period To" Date of an Application

This has been the biggest source of technical support calls.  You may create your QuickBooks

Progress Invoice on any given date, they no longer need to be spaced by your billing period setup in

CAPS.  When you pull the progress invoice into CAP, there is now a box where you can manually

override the Period to Date. 

NOTE:  Please note, that you may have only 1 invoice for any given date in QuickBooks.  Having more than

1 invoice for the same date will confuse CAPS, as well as, yourself.  This is especially important when you

are recreating draw history in QuickBooks.
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6.5 Effective Use of QuickBooks Group Items

If you use QuickBooks Group Items to create your Estimates, CAP will follow the rules you

choose about displaying individual items within the group.

 

For additional information on QuickBooks Group Items, download this article from our On-Line Support

Area http://www.sunburstsoftwaresolutions.com/view-document-details/quickbooks-group-items.htm

6.6 Inserting Lines in an Estimate

You may insert, a line or lines, anywhere within an Estimate, with one exception – the line or

lines you create, cannot be the same QuickBooks Item, that is after the newly inserted line. 

CAPS will automatically update this line on all previous applications for you, the only thing that

you will need to do is look at the Detail Screen, when you bring in the progress invoice that will

initially hold this newly inserted line, and perhaps, adjust the status of the line item.

http://www.sunburstsoftwaresolutions.com/view-document-details/quickbooks-group-items.htm
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6.7 Adjustments & Negative Pay Applications

Doing What QuickBooks can't!

There are times that QuickBooks, simply, just does not handle things, logically or efficiently, where

construction is concerned – such as, when there is a need to issue a Negative Invoice.  QuickBooks refuses to

allow you to create a Negative Invoice, and insists that you create a Credit Memo instead – there are times

when Credit Memo's are adequate, and other times, when it simply is not effective.

We have created the functionality within CAPS, to not only generate a Negative Application for Payment

, but create a Prior Payment Adjustment .

6.7.1 Negative Application for Payment

When A Negative and a Positive Change Order Result in a Negative Invoice

You are awarded a $30,000.00 job (retainage held at 10%) consisting of the following:

Excavation   5,000.00

Concrete 10,000.00

Site Work 15,000.00

Total 30,000.00

Application 1 is billed at 50% complete, or 15,000.00 less 10% Retainage (1500.00) for 13,500.00

Application 2 is billed at the remaining 50%, or 15,000.00 less 10% Retainage (1500.00) for 13,500.00

Two weeks after you have submitted the final billing, the General Contractor contacts you, says there is

something "defective" with the concrete, wants a $4000.00 credit for defective material, and also,  has an

additional  $3000.00 worth of site work that he wants you to do.  You go back to your original QuickBooks

Estimate and make the entries at the bottom of the estimate, so it now looks like this:

Excavation   5,000.00

Concrete 10,000.00

Site Work 15,000.00

Change Order #1, dated 7/15/04

Concrete – credit for defective material            - 4,000.00

Additional Site Work   3,000.00

Total 29,000.00

Now, you have completed the additional site work and are ready to submit your billing for it, as well as, show

the credit for the defective material.  

You go back to your QuickBooks Estimate, click the Create Invoice

button, select option 3 (Create invoice for selected items or for

different percentages of each item).  In the Specify Invoice Amounts

for Items on Estimate, you would logically want to bill for 100% of each

of these items as shown.

Selecting Ok will create a Progress Invoice. 
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The Progress Invoice appears to look fine, until you choose to Save &

Close the Progress Invoice, and QuickBooks refuses to allow you to

create a Negative invoice, and insists that you create a Credit Memo.

What do you do now, you wonder???

How to proceed.

In QuickBooks:

If you have reached the point shown above, select Ok on the error message box, select the Clear button, and

then, close the now blank Invoice screen.

1. Go back to your Estimate

2. Select Create Invoice

3. Select Option 3 - Create invoice for selected items, or for different percentages of each item

Bill 100% ($3000.00) for the Additional site work 

Do not bill anything on the $4,000.00 credit for the concrete (as

shown below)

Select OK to create your Progress Invoice, issuing it for the $3000

for the additional site work.  Save & Close the Progress Invoice.

7. After you pull this progress invoice into CAPS, come back to QuickBooks, and Create a Credit

Memo for this job for $4,000.00, and apply the credit, to either this Progress Invoice or one of the

previous outstanding QuickBooks invoices, for this job.

8. You will, then, have completed the process on the QuickBooks side.
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In CAPS:

1. Choose File and Application for Payment, enter the Progress Invoice number that you just created,

select OK

2. At the Reconciliation Step 1 Screen, select the Detail Button

3. Select OK, Choose Print, Do not print, but rather, select Complete.  This is done to update the

Schedule of Values

4. Choose Edit, Jobs, select this job, click the History button, and Delete this Application.

5. From the File Menu, choose Adjustments and Negative Application for Payment

Select the Create/Edit button to be taken to a Detail Screen where you will create the invoice.

When you have completed updating the Current Bill and Status columns,

select the OK button, and then the Exit button.

To Print your negative invoice – Beginning at the Edit Menu, choose

Jobs, select the Job by highlighting it, choose the History button, Select

the Application by highlighting it, choose the Print button, Set All Copies

to 0, enter a 1 next to this application, and then Preview, Print on Plain

Paper, or Print on AIA documents.

When a Negative Adjustment Results in a Negative Invoice/Credit Memo

You are awarded a $30,000.00 job (retainage held at 10%) consisting of the following:

Excavation   5,000.00

Concrete 10,000.00

Site Work 15,000.00

Total 30,000.00

Application 1 is billed at 50% complete, or 15,000.00 less 10% Retainage (1500.00) for 13,500.00

Application 2 is billed at the remaining 50%, or 15,000.00 less 10% Retainage (1500.00) for 13,500.00

Two weeks after you have submitted the final billing, the General Contractor contacts you, says there is

something "defective" with the concrete, and wants a $4000.00 credit for defective material.

In QuickBooks, you would:
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1. Create a Credit Memo for the defective material.

2. Go back to your original Estimate and enter a line item adjustment at the bottom of the Estimate

(much like you would when you create a Change Order.)  Save, and Close the Estimate.

In CAPS, you would:

1. Choose File, and Application for Payment, pull in your last Progress Invoice, for this job, to update

the Schedule of Values with the credit, there is no need to print it.

2. Choose File, Adjustments, Negative Application for Payment.

To Print the Negative Billing – From the Edit Menu, choose Jobs, highlight the Job, select the History

Button, Select the Print Button, Set All Copies to 0, place a 1 next to this application, and Preview, Print on

Plain Paper, or Print on AIA forms.

6.7.2 Prior Payment Adjustment

This feature is for fixing rounding problems that can occur when you change from a Fixed rate of retainage

to a Variable rate, or vice versa.  The adjustment may, also, be useful when picking up in the middle of a

job.  This adjustment ONLY affects Line 7 (Less Previous Certificates for Payment) on the Application for

Payment for the date entered.

From the CAPS File Menu, choose Adjustments, and Prior Payment Adjustment.

1. Select the job that you wish to make an adjustment for.
2. Enter the Date that you wish to have the adjustment be

effective.
3. Date of Line #7 Adjustment refers to Line 7 on the actual

Application for Payment Sheet.
4. Select the Edit Adjustment button.

Enter the amount of your adjustment – positive amounts require

nothing special, however, negative amounts must be preceded by

the minus (-) sign.

Select the OK button, and then Exit.

To Print the Adjusted Billing:  From the Edit Menu, Choose Jobs, Select this Job by highlighting it,

select the History button, Select Print, Set All Copies to 0, place a 1 in the upper grid next to this

application, and Preview, Print on Plain Paper, or Print on AIA forms.



Generating AIA Billings - User Manual 104

© 2002-2011 Sunburst Software Solutions, Inc.

6.8 Retainage Billing

CAPS includes the functionality for three different types of Retainage Billing:
1. Partial Retainage  - allows you to bill for Retainage at different points throughout the contract.
2. All  Retainage  - at a point, after you have submitted your final draw
3. Allow Retainage to be Combined on the last draw  - when submitting your final draw, include any

outstanding retainage.

This is a totally separate function and should not be confused with your normal

Application for Payment request.

To access the Retainage Billing function:

From the File Menu, choose Retainage Billing

You will be taken to this screen, where you may choose the Job, as well as, the type of retainage bill you

wish to generate.
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6.8.1 Partial Retainage

To create a Partial Retainage bill, from the main CAPS Screen, choose File -> Retainage Billing.  From the

Retainage Billing screen, highlight the Job,  

Click on the Partial Retainage button to bill a specific

amount of the total Retainage Held, or specific amounts of

Retainage held on individual line items – use this option if:

1. You are allowed to bill for previously held Retainage periodically throughout the contract

2. You have a contract that states that Retainage is held at X% until the contract reaches XX% complete,

and when you reach XX% complete, you may bill, for a portion or a percentage, of previously held

retainage, and future retainage is to be held at a reduced rate of X% until the contract is complete

Date of Retainage Bill to be created – should be one day later than your latest Period To date

In the example below, I am using Example #2 from above and wish to generate a bill for Partial

Retainage.  Using this example, I reached the 50% job complete stage with period ending 12/31/02, so I

will date the Retainage Bill 12/31/02.  If the retainage bill is created for the same date as an

Application for Payment, the Retainage bill is considered to come after the Application for Payment.

 

After clicking on the Partial Retainage button, you will be taken to the CAPS Detail Retainage Screen shown

below.

This screen performs two functions – it allows you to bill for previous retainage, and change the Retainage

Rates for future billings. 

NOTE: If retainage is to change for ALL line items in the future, enter this new rate in the Change All

Retainage % To box, and click the Change All Retainage % To button.

Explanation of items on this screen: 

Description Column – these are your individual line item names that you are billing

Scheduled – your Scheduled Values from your QuickBooks Estimate

Billed – total amount billed, as of your last application
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Retainage WH – total amount of retainage that has been held, as of your last application – in my case,

the date of the last application (#5) was for Period to 12/31/02 with a Progress Invoice Date of

12/31/02 and the total retainage withheld, as of that application, is shown in this column. 

Prev Retainage – the amount of any previous retainage that you have billed for – this will reflect all

zero's the first time you generate a retainage requisition.

Retainage to Bill – you will enter the dollar amount of retainage you wish to bill for, here for each line

Item

Retainage % - use this column to change future billing retainage rates if each line item will vary.

Balance – this is the balance of Retainage that you will bill for in the future

 

You may choose to Preview the Requisition, and enter the number of copies you wish to print.

As with any of our other preview functions, do not print from the Preview Screen, return here, and

click on the Print button.

 

Your Retainage Requisition will now be generated, the Retainage Requisition will automatically be added to

the history screen for this job, and your next application will automatically calculate retainage to hold at the

new rate that you have indicated, while keeping a running balance that includes the balance of your unbilled

retainage.

When you are ready to generate your

next Retainage Requisition, the

retainage amounts that you previously

billed will show in the Prev Retainage

column.  In the screen shot below, you

can clearly see that the Retainage WH

(Withheld) shows the retainage held,

Prev Retainage column shows the

amount of Retainage billed on

previous requisitions, and the Balance

column shows the Balance of

Retainage for each individual line

item.

As you continue to issue Retainage Requisitions, when you wish to bill for the balance of any individual line

item, you must change the rate in the Retainage % column to 0 to indicate that this item has been totally

completed.

Important Note: any job that has a change in retainage at any point in the contract should be

set up as a variable rate job in CAPS.
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6.8.2 All Retainage

To create a Final Retainage bill, from the main CAPS Screen, choose File -> Retainage Billing.  From the

Retainage Billing screen, highlight the Job,

click on the All Retainage button to Bill

for all Retainage held to date – use this

option if you only submit 1 Retainage

Requisition after the entire job is

complete and has been billed.

This simple screen gives you an overview

of the Retainage Requisition that will be

generated, and allows you to choose to

Print a Retainage Continuation Sheet

(check the box), or not to print one

(leave the box unchecked).

Enter the number of copies that you wish

to Print or Preview, Preview the

Requisition, Print on plain paper, or Print

on AIA forms, or Cancel the Bill.

As with any of our other preview functions, do not print from the Preview Screen, return

here, and click on the Print button. 

6.8.3 Allow Retainage to be Combined on Last Bill

First, go to System Setup, and Select Options , place a check mark in the box next to Allow Retainage to

be combined on last bill, in order to activate the function.  Generate progress invoices in QuickBooks, as

usual; bring them into CAPS, as usual.  When you pull in the final QuickBooks Progress Invoice on the job into

CAPS, when you reach the Print Screen:

72
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If you are pulling in draws for multiple jobs, in the

set all copies to box, enter a "0", click the set all

copies to button, check the box for Include final

retainage on bills with copies greater than "0".

 Go up to the printing details, and for the job that

you wish to include retainage in the final billing for,

enter the number of copies you would like to print in

the Copies column.  Click the Print button, and

when that particular draw is through printing, 

uncheck the box next to Include final retainage on

bills with copies greater than 0, go back up into

the detail area, change this job to "0" copies, enter

the required number of copies, for the balance of

your jobs.
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6.9 Billing Sheets

To access the Billing Sheets Option - from the CAPS Main Screen, choose File ->Billing Sheets, or press the

Ctrl and the B Key, simultaneously.

Billing Sheets are helpful in calculating what your next bill will be.   

When this menu option is selected, your jobs are

listed as shown.  

Simply enter the number of copies you want for

each job, select your printer, and click “Print”.

Following is an example of the billing sheet.  Each detail line description, Schedule of Value (Scheduled),

Billed to date (Completed), Stored Material (if present), % Complete ( Remaining amount, as well, is listed),

along with a blank space, to pencil in your current bill.    

Note: if there is no stored material for this job, this column will not appear.
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6.10 Taxable Contracts

Taxable Contracts have always proven to be a sticky situation when retrieving the Sales Tax amount from

QuickBooks, and properly getting it into CAPS, and then, accurately showing the distribution on the

continuation sheet.

While we have improved the CAPS side, there is nothing we can do about QuickBooks; therefore, there are

some special instructions that you must follow on the QuickBooks side to make everything come out

correctly.

For those of you who have both Taxable and Non-Taxable Contracts, you must pay special

attention to the Estimate that you create for Taxable Jobs.  Each line item of the Estimate must

have a "Tax" Entry in the Tax column of the Estimate, and the Tax Item at the bottom of the

Estimate must contain the applicable Sales Tax Item and rate, see below:

Tax entry in the Tax Column indicates that each line item is subject

to Sales Tax.

Sales Tax Item in the Tax box will calculate the applicable Sales Tax

Rate on the Total Estimate.

 

When you have verified that all Items have a Tax Code, and that the Total Sales Tax amount is correct, you

can create your Progress Invoice as usual, selecting a percentage of the contract, or specific amounts/

percentages, for each line item.

When you have the progress Invoice on the screen in front of you, DO NOT PULL IN YOUR SUBTOTAL ITEM

AND THEN YOUR LESS RETAINAGE ITEM AT THIS POINT, if you pull these items in now, CAPS will read the

reduced Sales Tax amount from QuickBooks, which essentially means, that you will be withholding retainage

on the Sales Tax twice.  Simply, save & close the Progress Invoice, go to CAPS, and pull it in.

 

When CAPS has retrieved this invoice, click on the Detail Button , to verify the accuracy, print the

required number of copies, and press the Complete Button.

At this point, you must now go back to QuickBooks, pull up the Progress Invoice, pull in your

Subtotal and Less Retainage Item, being sure that your Less Retainage Item is, also, assigned

to the same Tax Code as the rest of your line item entries. 

6.10.1 Change Orders & Sales Tax

In order to "distribute" Sales Tax accurately on Change Orders, you must first, turn on the option to do so, in

System Setup ->Options  - and choose Print Sales Tax on Continuation separated as Original, Prior

Change Orders, and Current Change Orders?

Essentially, you will create your change order, as always, by going back to the Original Estimate, pull in your

Change Order Item, add the details, and optionally, put in the details of the change order.  Create your

Progress Invoice, as usual; DO NOT PULL IN THE SUBTOTAL AND LESS RETAINAGE ITEMS.  Save the

85
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Progress Invoice, go to CAPS, retrieve the Progress Invoice, click on the Detail Button.

This screen will show you how CAPS has automatically distributed sales tax

by breaking it down into Columns for Scheduled Tax (from your Estimate),

Prior Tax Bills (tax billed on previous applications), and Current Tax Bill (tax

billed on this application).  If CAPS has not distributed Sales Tax properly,

you may manually correct the amounts in this grid.

There are few times that you would need to manually correct the sales tax distribution, the most common

times are:

1. When you have a change order, before generating your initial draw

2. When you start using CAPS midway in a project that has had change orders

3. You use QuickBooks Group Items that contain a mixture of Taxable and Non-Taxable items, and

choose not to print the items contained within the group.

4. When you change the Status of line items in the CAPS Detail Screen.

The Edit Sales Tax Distribution Button :

By clicking on the Edit Sales Tax Distribution Button, you will receive the following screen:

Here, you may manually edit the Sales Tax distribution within the grid.

6.11 Lien Waivers & Contract Documents

6.11.1 Using the Contract Document Manager

The Contract Document Manager allows you to use Microsoft Word to customize often used Lien

Waiver and Contract document "letters" to suit your needs, and integrate data that has already been

entered into QuickBooks and CAPS, into these documents, saving you time and effort.  Over 30

documents containing access to 127 different fields from both QuickBooks and CAPS, which we have

already created, are included.  You can modify these existing documents, as well as, create new

documents.  Contract Documents that are included with the program have all been digitally signed.

Customer: Jobs Letters:

Conditional Waiver and Release Upon Progress Payment

Notarized Withdrawal of Mechanic's Lien

Notarized Release of Mechanic's Lien

Notarized Sub-Contractor and Material Supplier's Final Waiver of Lien

Notarized Contractor's Affidavit of Release of Liens

Release of Stop Notice or Notice to Withhold

Sub-Contractor and Material Supplier's Final Waiver of Lien

Unconditional Waiver and Release Upon Progress Payment

Warranty Statement

Notarized Lien Waiver and Release

Des Agrment – Prelim, Constr, Eng Fees – Design Agreement featuring Preliminary, Construction,
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and Engineering Fees

Design Agreement (Short Form)

Design Agreement Total Fees

Labor Release

Out of Stock Material Certification

Supplier Cond Waiver Release Final Payment – Supplier Conditional Waiver & Release Upon Final

Payment

Supplier Cond Waiver Release Prog Payment – Supplier Conditional Waiver & Release Upon

Progress Payment

Supplier Uncond Waiver Release Final Payment – Supplier Unconditional Waiver and Release Upon

Final Payment

Supplier Uncond Waiver-Release Upon Prog Payment – Supplier Unconditional Waiver and Release

Upon Progress Payment

Sworn Statement – Notarized Sworn Statement

Submittal Register 

Vendor Letters:

SFA Between GC & Sub – Standard Form of Agreement Between GC and Subcontractor

SFA Contractor & Subcontractor – Standard Form of Agreement Between Contractor and

Subcontractor

SFA Owner & Contractor – Standard Form of Agreement Between Owner and Contractor

Subcontract Change Order

Invitation to Bid

Confirmation of Instructions

Employee Letters:

Weekly Mileage Log

Cash Expense Reimbursement

Consider that these documents are master templates and while these may be modified, they will be used for

many different jobs, suppliers, or employees.  To incorporate data from CAPS and QuickBooks, special fields

called "DocVariables", are used to bring in different data elements, such as, the "Architect Project #", or Job

Location, into the document, for each different job.

These master document templates are located in your CAPS "Data Path", "Data\Letters" folder.  By default,

this folder will be "C:\Program Files\Cap\Data\Letters", but may be changed for networks via System Setup à

Data Locations.   

Prior to attempting to generate any of these letters:

You will, first, want to review each of these letter templates for content, and to add any additional data

fields that will always remain the same (such as your State name, the county, etc.).  

To do this from the CAPS Main Screen, choose:  File and Contract Documents, alternatively, you can issue

Contract Documents from the Cap Job Record (Edit menu -> Jobs -> click to select Job -> Edit -> Contract

Documents button.  NOTE:  Contract Documents generated from the Job Record will not be able to access

Vendor or Employee options.

Initially, this screen comes up to allow you access to these master document templates
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Using the Remove Form button, will simply transfer the

master document template file to a "Removed" sub-folder

of "Data\Letters", so that the list displayed, only shows

the forms you use.  

Choose Edit Form or Add New Form to alter or create a

template. 

Below is the "Notarized Release of Liens" document opened.  There is a tool bar that will help you create

these letters.  Use the Caps Field Selector to navigate and insert the fields of data that may be automatically

filled.  The data is categorized by where it is located.  Currently, over 130 different fields may be inserted

into the document.

Double clicking on a field will insert that field into the Word Document.  Click on the Word document to go

back to editing in Word. Use the "Toggle Field Codes" to show or hide, where data will be inserted.  

At times, Word may get confused, for example: if you are inserting codes, while the toggle is off,  you may

need to toggle 3 times to show all the fields that will actually be inserted.  The finished letters will change

the "{DOCVARIABLE CapJobArchName \* Merge Format}" (aka Field Codes) to data, for the Job you have

selected.  This document, also, has one piece of data that is not in either QuickBooks or CAPS, and that is

the County of the Job.  Inserting a "DocVariable", and changing the name to "EnterCountyOfJob", will prompt

for this field, for when a document is created.  Use this trick when desired, and you can be sure to get a

prompt by starting the Variable name as "Enter…".
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Playing around with a test document will help you to see how this can be done.  Be sure to save your changes,

and then use Alt-Tab to switch back to the Contract Document Manager.

Note: that data can be selected for a Job, Vendor, or Employee.  Since this is the case, for Employee

documents, you need to select an Employee.  Hence, documents to employees are named, starting with

"Employee".  Vendor letters start with "Supplier ", and in this case, both a Vendor and a Job, need to be

selected to complete all of the data fields in the template.  All other documents, only require a job to be

selected.  The program will automatically find the QuickBooks Job information, as well as, the CAPS job

information (if it has been setup).  

When you click on "Use this Form" or double click on a letter, a window

that lets you select the "Data Source", will appear.  Initially, your CAPS

jobs will appear, but, you can use the "Select Data Source" drop down to

choose from Employees, Vendors, or Jobs, from QuickBooks.  The

program will be faster if QuickBooks is already open, when data is

retrieved from QuickBooks.
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When you retrieve data from QuickBooks, you will

be asked for a starting point and maximum number,

of records to acquire.

You can add a new, or edit an existing job, in CAPS, by clicking the "Edit Caps Data".  

When you click on an entry in the list, the "Document will be for:" will be updated to show the job, employee,

or vendor, you have selected.  You may only select 1 of each.  However, you may select 1 vendor and 1 job,

or even 1 vendor, 1 employee, and 1 job.  The "Clear Selections" button will reset what you have selected.

Once your selection(s) are complete, click the "Create Document" button to create a Word document with the

Data Fields filled in.  

In this document, there is a piece of data that is not available in QuickBooks or CAPS, and that is the County

of the Job.  Since there is a "DocVariable" that is not pre-defined by the program, this data is requested.
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6.12 Contractor Qualification Statement

To generate a Contractors Qualification Stxatement

From the CAPS main File menu -> choose Qualification Statement.

Each icon on the left represents a different section of the Contractor's Qualification

Statement which must be completed BEFORE you can actually create the completed

document.

Information that you enter in each section is saved and can be edited and/or updated as

time goes on.

SUBMITTING SECTION - This section contains basic information

about who you are submitting the Qualification Statement to as well

as basic information about your company - each item is explained

below.

Submitted To - who you are submitting the Qualification

Statement to

Address - their address

Name of Project - the project name as it relates to this

submission

Type of Work - what type of work will you be performing on this

project - NOTE: you will need to submit one Qualification

Statement for EACH type of work you will be performing

Submitted By - Your licensed CAPS company name will

automatically appear on the final document with no additional

effort on your part

Address - your company's address, from your QuickBooks file ->

Company Information.  This address can be displayed as a single

line or you can click into the box at the end of your street address -

> and press the Enter Key to have your address display on two

lines.

Principle Office - the location of your principal office

Corporate Structure - how is your business structured

When you have completed the information in the Submitting

Preference, be sure to click the SAVE button before moving onto the
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Organization section.

ORGANIZATION SECTION - This section contains basic information

about how your company is organized - each item is explained below.

 To move between the month, day, and year fields, use your arrow

keys.

Date opened for business - enter the date that you opened your

business

Date opened for business under present name - enter the date

that you opened your business under its present name

What former names has your organization operated - enter any

other names that your business has operated under

Date of Incorporation, or creation - enter the date that your

business became incorporated or was created

State of Incorporation - enter the name of the state that your

business is incorporated in

President's name -self explanatory

Vice-president's name (s) - self explanatory

Secretary's name - self explanatory

Treasurer's name - self explanatory

Type of Partnership (if applicable) - if your business is a

Partnership, enter the partnership type in this field

Name of General Partners - self explanatory

Name of Owner - if your business is a Sole Proprietorship, enter

the owners name in this field

If your organization is other than those listed above, denote it

and name the principles - if your business has any other formal

entity structure than listed above - enter the business type and the

name of the owners here.

LICENSING SECTION - This section contains basic information about

your company's licensing - each item is explained below.

In the first box, you should list the jurisdictions and trade

categories in which your business is legally qualified to do

business, be sure to include registration or license number - if

applicable.

In the second box, you should list jurisdictions in which your

business's partnership or trade name is filed.
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EXPERIENCE SECTION

This section contains basic information about your company's

experience - each item is explained below.

In the first box, list the categories of work that your business

normally performs with its own workforce.

Answer the next 4 questions about any claims or suits that your

company has been involved in.

1. Edit Jobs in Progress button

The Jobs in Progress window will display information about the jobs that you have brought into CAPS for

AIA type billing AFTER you click the Refresh button.

Jobs that exist in QuickBooks that you do not do AIA type billings for will have to be manually

entered in this window - begin entering information about those other jobs AFTER the >/

JobsInProgress> tag.

You MUST manually update the value of Work In Progress and under contract.

You can set your own parameters for reporting Jobs as "Complete" by percentage and/or by when

the last bill was issued.

You can set your own parameters for reporting Jobs as "Complete" by percentage and/or by when

the last bill was issued.

You MUST manually enter the dollar value of Work in Progress & Under Contract - we do provide you

with an "Estimated" value of the jobs in CAPS.

Click the Refresh button to pull information about Jobs in Progress from the CAPS program.

Jobs in QuickBooks that are NOT in CAPS will NOT be included in this window - you will need to

manually enter those jobs.

2. Edit Projects Completed button

You can set your own parameters for reporting Jobs as "Complete" by percentage and/or by when the last

bill was issued.  Once these parameters have been set and the Refresh button has been clicked, Jobs that

fit the parameters you set that have been brought into CAPS for AIA type billing will appear in this list.

Other jobs that exist in QuickBooks, but have NOT been brought into CAPS for AIA billing, WILL

have to be MANUALLY entered.  You can begin entering information about these jobs AFTER the </

JobsCompleted> tag.

You MUST manually enter (and then update) the dollar value of the AVERAGE annual amount of

construction work performed during the past five years.

You MUST manually enter (and then update) the dollar value of the AVERAGE annual amount of

construction work performed during the past five years.

Click the Refresh button to pull information about Jobs in Progress from the CAPS program. 

Jobs in QuickBooks that are NOT in CAPS will NOT be included in this window - you will need to

manually enter those jobs.

3. Edit experience & commitments button

In this window, you can enter additional information about your experience and present commitments.

Use this window to enter information about your experience and present commitments.
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REFERENCES SECTION - In this section, enter information about your

company's Trade References, Bank References, Bonding/Surety

Company, and the Name & Address of your Bonding Agent.

FINANCING SECTION - The Financing section holds information about

the financial records that you are submitting for your company,

including who prepared them and the date that they were prepared.

SIGNATURE SECTION - This window contains information about the

person who is signing the Contractor Qualification Statement - by

default, this information comes from the CAPS program -> System

Setup menu - > Address & Default Information - Notary tab -> 

Representative and Representative Title Fields.  You can change

this default information here, if you'd like.

CREATE WORD DOCUMENT - Click the Create Word Document

button, sit back and wait for Word to respond - review, print, and

save your document.
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6.13 Program Updates

Reminder:  Updates must be installed on all computers on which the CAPS program resides.  We do

NOT automatically download new updates like Intuit. 

Program "bug" fixes are available on the Web Service Center as we correct them, and we do not notify you;

however, you may access the Web Service Center at any time to see what is available.

Program "enhancements", such as the release of a compatibility update for a new version of QuickBooks, or

the release of a updated billing format, are made available on the Web Service Center and we do notify you

via email that "enhancement" updates are available and what the enhancements are, therefore, it is your

responsibility to keep us informed of your current email address.

As a customer of Sunburst Software Solutions, Inc. it is your responsibility to maintain your program, unlike

Intuit and Microsoft we do not arbitrarily and automatically update your software, as we feel that software

programs should do things when YOU tell them to do it.  

To obtain updates:

From the CAPS Help menu choose Check for Updates.

Selecting the Check for Updates menu option will launch the

window to the left.

Using the drop down menu, select an update from the list.

The drop down menu will provide you with a list of available updates.
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Click on the Show Release Notes

button to display what

enhancements/updates are

included in this version.

Clicking the Download and Install button opens the following

window.

Click the Download and Install

button and watch the status of the

installation.

A download wizard will inform you of what task (function) the

program is performing and it's status.

When the update has finished downloading and installing, the CAPS program will automatically close and you

will need to restart it from the shortcut on your desktop.
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6.14 Annual Maintenance

Your first year of Maintenance is included with the purchase of Certified Payroll Solution.  The following year

you will receive an Annual Maintenance Invoice in the mail for $50.00.

For $50.00 per year you will receive:

Updates to billing forms as they change.

Program enhancements that we do.

New billing forms that are requested by customers just like you.

Compatibility updates to new versions of QuickBooks, these are usually available when Intuit

announces that the new version of QuickBooks is available.

1 free technical support incident.

To pay your Annual Maintenance you may pay on-line using Master Card, Visa, or American Express by going

to the CAPS Help menu -> On the Web -> Pay Annual Maintenance.

OR

You may mail a check to:

Sunburst Software Solutions, Inc.

2378 Dane Hill Road

West Charleston, VT  05872

You will have 45 days in which to pay your maintenance from the date of the invoice.  

Non-payment of maintenance indicates that you are no longer using the software and have no

further need to receive program updates; therefore, we will make your account and access to

our Web Service Center inactive.

Should your Maintenance Agreement lapse, you will be assessed a $25.00 late fee, plus charged for

any maintenance in arrears.
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7 Errors

7.1 Common Error Messages

Error messages should not stop you from using your program, nor, should they be ignored. 

Error messages are indications that something is not accurate.  Errors are documented, and

those that are not, do have a solution, and we will find that solution for you.  This applies to

the first year of ownership, and any year thereafter, provided you are on maintenance.

It would be impossible to keep either the manual or Help file updated with the most current error

messages, so, we have provided the list shown below, but have also, included convenient links to the On-

Line Support Area of our site, which may be accessed directly from within CAPS.  

From the CAPS Help Menu, choose On the Web, and Support Area. 

Or visit our On-line Support & Resource Area directly, by using the link below http://www.

sunburstsoftwaresolutions.com/aia-billing-caps/ 

The On-Line Support & Resource Area contains the following items - other items will be added as time

progresses, so please, bookmark the above referenced page.

Common Problems.  Answers to your most common setup problems. 

Version 5.0 Error Messages These are the most common error messages and their resolutions that

you could encounter, when running CAPS. 

(http://www.sunburstsoftwaresolutions.com/caps-errors/view-category.htm) 

Enterprise 5.0, or 6.0-11.0 Minimum Permissions   Enterprise users will want to ensure that the

person responsible for generating AIA Billings has these minimum permission levels within

QuickBooks®. 

http://www.sunburstsoftwaresolutions.com/caps-technical-training/view-category.htm  

Handling Negative Change Orders.  A detailed overview of how to successfully, handle and track, a

negative change order, in both QuickBooks and CAPS. 

http://www.sunburstsoftwaresolutions.com/view-document-details/construction-application-for-

payment-handling-negative-change-orders.htm 

Where does the info come from?   A detailed overview of where all the information comes from that

appears on your final Application for Payment and Continuation Sheet.  This is a great aid for

troubleshooting "blank spots" in your reports, and is now available directly from the CAPS Help Menu.

This is a great aid for troubleshoot “blank spots” in your billings. 

Construction Application for Payment Solution Product Data Sheet

Construction Application for Payment Solution Design and Utilization of the QuickBooks® SDK

Construction Application for Payment Solution Whitepaper

Other items of interest on our website are:

Our reviews of the newest release of QuickBooks.

Links to our Newsletters containing QuickBooks tips & tricks for the commercial construction

industry, overviews of other 3rd party integrated applications, etc.

Articles & Resources of interest to QuickBooks ProAdvisors & CPA's

http://www.sunburstsoftwaresolutions.com/aia-billing-caps/
http://www.sunburstsoftwaresolutions.com/aia-billing-caps/
http://www.sunburstsoftwaresolutions.com/caps-errors/view-category.htm
http://www.sunburstsoftwaresolutions.com/caps-technical-training/view-category.htm
http://www.sunburstsoftwaresolutions.com/view-document-details/construction-application-for-payment-handling-negative-change-orders.htm
http://www.sunburstsoftwaresolutions.com/view-document-details/construction-application-for-payment-handling-negative-change-orders.htm
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7.2 80040408 - Resolving QuickBooks Connection Issues

There are a number of issues that can occur when ANY third party application attempts to connect

to QuickBooks.  The QuickBooks Error Description usually contains helpful information, and

sometimes, they may be vague, at best.

These errors usually occur when the third party application initially connects to QuickBooks, and basically

says; "Hi, my name is application X, and I'd like to work with this QuickBooks data file.  Cover the basics

first, double-checking the most simple things first.

The solutions below are used to diagnose and solve the following QuickBooks Error Codes:  80040401,

80040402, 80040403, 80040404, 80040405, 80040406, 80040407, 80040408, 80040409, 8004040A,

8004040B, 8004040C, 80040416, 80040417, 80040418, 8004041B, 8004041C, and 8004041D. 

Make sure you have the correct QuickBooks file specified.  All third party applications need to know, which

QuickBooks file it's supposed to be working with.  Perhaps, you initially created a test file to experiment

with, or you have recently upgraded to a new version of QuickBooks.

Open QuickBooks with the correct data file, and from the Construction Application for Payment

Solution System Setup Menu, choose Data Locations.  Delete all of the information in the white box

next to where it says "QuickBooks File"; click OK, and try again.  Making the QuickBooks File location

"blank", tells CAPS to work with the open company file.

         

Make sure you have the proper version of QuickBooks running.

Make sure you have the correct QuickBooks file open and with the proper version of QuickBooks.

Have you applied all of the QuickBooks Maintenance Releases or "patches"?

Make sure permissions are set, so the application can access the QuickBooks data.

Permission in QuickBooks are set by the QuickBooks Administrator in Single-User Mode under Edit-

>Preferences->Integrated Applications->Company Preferences; and, are further documented in the

manual provided with your software.  Users may have specific instructions depending upon the version

(Pro/Premier 2003 vs. Pro/Premier 2004-2011).

Do you have multiple versions of QuickBooks installed on your computer?  Having multiple versions of

QuickBooks installed on your computer causes problems with integrated applications, and is a known problem

at Intuit.

From Construction Application for Payment Solution, choose the Help Menu, select Repair, and Reset

QuickBooks, after update.

Once the basics are covered and the error persists; there are further steps that can be taken, each of which

has a good chance of solving the error.  Try each suggested resolution individually and in the order shown.

1. Close QuickBooks, the integrated application, and all other open programs.  Using "My Computer" or

"Windows Explorer" and navigate to the folder, where this QuickBooks version is installed.  By default, this

folder is C:\Program Files\Intuit\QuickBooks Pro (or whichever edition you originally installed).  When you

get to the Program Files Folder, you may need to click on the "Show Contents" option.  Once you have

found this folder which contains hundreds of files, scroll down to locate the file named "reboot" or "reboot.

bat", and double-click on this file.  A black box will come up, and after several seconds, disappears.  Once

it has disappeared, try the connection process again.
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2. Close all running programs, remove any diskettes or CD's from all drives, and reboot your computer.  While

your computer is starting up, press the F8 key (on the top row of your keyboard) every 2 seconds, until a

simple text menu appears.  If Windows boot normally, try again; this time, pressing the F8 key more

frequently than before.  Depending upon your version of Windows, 2 or 3 different menus will appear.

Using your arrow keys, select to boot in "Safe Mode with Networking".  You may, also, need to specify

which device you wish to boot to; and usually, the first or highlighted option, is correct.  Once Windows

boots in safe mode, start QuickBooks - giving it a few minutes to load completely; then close QuickBooks,

and reboot Windows normally.

3. Rebuild the QuickBooks data file.  In QuickBooks, switch to single-user mode, from the Window Menu,

choose Close All.  From the File Menu, choose Utilities, and Rebuild Data.  You will be forced to make a

backup of your data (save this somewhere that it can be easily found and deleted; like "My Documents"),

and then, the rebuild process will start.  This process may take quite awhile, depending upon the size of

your QuickBooks data file and the speed of your computer.

4. As the last resort; QuickBooks needs to be un-installed and then re-installed.  (This comes from Intuit

Developer Network Technical Support)

Backup your QuickBooks file

Un-install QuickBooks; by clicking on your Start Button, choose Control Panel, and Add/Remove

Programs

Using "My Computer" or "Windows Explorer", navigate to C:\Program Files\Common Files\Intuit folder;

right click on the QuickBooks Folder, and choose delete.

Reboot your computer

Install QuickBooks

Update QuickBooks with all applicable updates

Open your company data file

Try again
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8 Sunburst Software Solutions, Inc. Company Policies

8.1 Software Return Policy

Product returns are not fun for anybody, and we try to do everything we can to keep them to a minimum. 

Because we already know that all the products work as represented, the most common reason for a return

would simply be, that the software did not fit your needs.  Therefore, we encourage you to carefully review

the Product Detail pages for the software you are interested in, and view the appropriate on-line product

demonstration presentation available on this website, and try the product FREE for a full 30-days, before you

make your purchase.  In addition, you are encouraged to call us to discuss any product that you are

interested in but still have questions about.  We'll be pleased to answer any questions, and engage in an in-

depth discussion about how the products work, and how they might be of benefit to you.

RETURN POLICY

Since we offer a fully functional, time-limited trial version of our software, before any money is spent,

returns are expressly prohibited.  No Refunds under any circumstances.

DEFECTIVE CD'S

Defective CD's sometimes happen, and will promptly be replaced, by Sunburst Software Solutions, Inc. upon

notification by the customer.  ALL Replacement CD's will be shipped Priority Mail through the US Postal

Service.  

NOTICE:

This return policy has become part of our End User License Agreement, effective August 1, 2003 to comply

with VISA & MasterCard mandates that require proof of Return Policy Disclosure for all sales.  Our End User

License Agreement is displayed on our website, enclosed in printed form as part of our software manuals,

and must be accepted, prior to the ability to fully download and/or install the software; and as such,

constitutes signed proof of prior disclosure of the policy. 

8.2 End User License

TERMS OF USE:

Sunburst Software Solutions, Inc. grants you a non-exclusive license to use this copy of the program subject to

the following terms, conditions, and the proprietary notices, labels, or marks on the program, and the

accompanying documentation. 

You may: 

1. Use this program only for the Company or Companies that have been granted a license by Sunburst Software

Solutions, Inc.

2. Make a copy of the program in machine-readable form for archival purposes, as long as, all proprietary notices

are reproduced on each copy. 

You may not: 

1.  Modify, translate, reverse engineer, decompile, disassemble, or create derivative works, based upon this

program. 

2.  Rent, transfer or grant, any rights in this program or accompanying documentation in any form, to anyone else,

without the prior written consent of Sunburst Software Solutions, Inc. 

3.  Remove any proprietary notices, labels, or marks on the program or accompanying documentation. 

4.  Use this program, or permit this program to be used, for Companies that are not granted a license. 
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This software product is provided "as-is", and Sunburst Software Solutions, Inc. makes no warranty, either express

or implied, including but not limited to, warranties of correctness and fitness, for a particular purpose. In no event

will Sunburst Software Solutions, Inc. be liable for any indirect, special, consequential, or other damages, however

caused by the software or data produced by it. 

The software has been designed to operate on hardware with Microsoft® Windows® 95, 98, NT®, 2000 and XP®

based operating systems. Sunburst Software Solutions, Inc shall have no responsibility for use of the Program in

conjunction with other hardware or other operating systems.

The responsibility for testing for "viruses" shall be yours. Sunburst Software Solutions, Inc. applies virus testing to

the software product before it is released, but cannot guarantee that diskettes or CD's are virus free of random

strains, new evolutions not yet detectable, or inadvertent infections.

This license is not for sale, and it may not be assigned or sublicensed, to anyone else. Title and copyrights to the

program, and the accompanying documentation and any copies, remain with Sunburst Software Solutions, Inc. 

Any violations of this license agreement will subject the violator to injunctive relief in the State of Vermont,

County of Orleans. You agree to submit to jurisdiction in the Orleans County Court and by acceptance of the

Sunburst Software Solutions, Inc. products, agree not to contest or dispute, venue or jurisdiction of the action.

Acceptance of this license agreement is acknowledged when you enter a license code for your software. You

further understand that Sunburst Software Solutions, Inc. is entitled to seek both injunctive relief, and damages,

for proven violation of this license agreement in said Court. The prevailing party in any such action will be entitled

to recover attorney fees and cost disbursements. Sunburst Software Solutions, Inc. has the right to an automatic

temporary, preliminary, and permanent injunctive relief from said Orleans County Court, in the case of a breach or

any wrongful use of this license agreement. 

If you do not comply with any of the above restrictions, this license will terminate, you will be liable to Sunburst

Software Solutions, Inc.  for damages or losses caused by your non-compliance, and Sunburst Software Solutions,

Inc. will be entitled to a court order, which will require you to comply. 

This agreement is the entire agreement. If any provision of this agreement is held invalid, the remainder of this

agreement shall continue in full force and effect.

If you do not agree to the above terms, you must discontinue any further use of this product, and return to

Sunburst Software Solutions, Inc. any material (including any copies), which Sunburst Software Solutions, Inc. has

sent to you in connection with this product.

8.3 Privacy Policy

Your privacy is important to us.  It is our policy to give you notice of the information our office collects on

our website and notice of what we do with the information.  It is our goal to protect your privacy to the

extent possible under the law, and we will modify this Privacy Policy, whenever necessary, to reflect changes

to our web site or changes in our information collection practices.  This policy applies only to our website,

and not to any sites which may be linked to, from this site.

NOTICE:  Information We Collect and Store Automatically.

When you visit our website, we collect and store anonymous information about your visit.    This

information, which your computer automatically supplies to every website you visit, includes your computer's

Internet Protocol (IP) address, the name of the domain from which you gain access to the internet (aol.com if

you are using an AOL account, or mit.edu if you are using a Massachusetts Institute of Technology account),

the website from which you gained access to our website (www.google.com), and the browsing software that
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you are using (Microsoft's Internet Explorer or Netscape Navigator).

We create summary reports using this anonymous information to count how many people visit our website,

and to access what information is most interesting to our visitors.  We may store all of the information we

collect, indefinitely.  We do not try to match any personally identifiable information (from email

correspondence, for instance), with any of the anonymous information.  The only time that we will attempt

to trace the anonymous information to a specific individual, is when there are reasonable grounds to believe

that doing so, would provide information that is relevant and material, to an ongoing criminal investigation,

and requested by law enforcement.

Cookies:  Our website uses cookies only to track the movements of visitors among the pages of our website.

Information collected from emails:  We do not sell, rent, or divulge names, addresses, or other personally

identifying information for commercial purposes, or for any other reason.

CHOICE:  About What Information We Collect From You and How We Disseminate that information.

We do not sell, rent, lease or give out names, addresses, or other personally identifying information for

commercial purposes, or for any other reason.

The only personally identifying information about you that we collect through our website, is information that

you choose to submit to us.  You have complete control then, over the personally identifying information we

collect from you.

Once you submit the information to us, it will only be used by our company and never sold, rented, or leased,

to any other party.

If you have a concern, for any reason, about any correspondence that you have submitted to us, please do

not hesitate to contact us.

Security:  We do not currently offer secure or encrypted email, so we encourage you not to send us highly

sensitive information by email.  If you need to submit such information to us, please consider contacting us

instead, by telephone at 888-348-2877 or US Mail at 2378 Dane Hill Road, W. Charleston, VT 05872.

Access to Information We Collect from You:  Our website does not collect personally identifying information

except what you submit to us for demo requests, purchasing, and in any emails that you send.  We do not

match any personally identifying information with any of the anonymous information that we do record.  As a

result, we generally cannot identify, and therefore, are not able to provide any information about your visit

to our website.

Definitions:  Personally Identifying Information:

Any information that could reasonably be used to identify you personally, including:

    * Name

    * Address

    * Email Address

    * Social Security Number

    * Birth Date

    * Bank Account information

    * Credit Card Information

    * Any combination of information that could be used to identify you; such as your birth date, your zip

code, and your gender.
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Cookies:  Small files that websites store on your computer.  A cookie file generally contains an identification

number that allows the website to recognize you as you navigate through the site, and also, when you return

to the site at a later date.  Cookies allow a website to store your references and to tailor its offerings to you.

 Cookies can, also, be used to track your browsing behavior on the web.  You can prevent websites from

placing cookies on your computer by using your browser's preference menu, although, disabling cookies may

affect your ability to view or interact with some websites.

Changes to the Privacy Policy: We will post changes to this Privacy Policy at least 30 days before they take effect.  Any

information we collect under the current privacy policy will remain subject to the terms of this Privacy Policy.  After any

changes take effect, all new information we collect, if any, will be subject to the revised Policy.  This policy was created January

1, 2001, revised:  N/A.
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8.4 Support Policy

Since our inception in August, 2000, we have worked with thousands of customers, each with their own

preferred method of learning.

Because of this type of experience, we have literally spent thousands of hours compiling various types of

"Help" documents and training materials to meet the needs of our customers; ranging from printed manuals,

in-program Help, Flash demonstrations,.PDF demonstrations, Audio/Video Training, and even articles that

address high-end QuickBooks tips and techniques (which are published in a FREE Quarterly Newsletter

available upon request at http://visitor.constantcontact.com/email.jsp?m=1101296186686).

Each year, we spend over 100 hours just updating our manuals and in-program Help. In 2007, we spent well

over 300 hours, developing a total of 8 Audio/Video Training demonstrations - 4 for Certified Payroll Solution

and 4 for Construction Application for Payment Solution; which only take a total of 3 hours to view - that's 1

1/2 hours per program.

We have found that the customers who take advantage of these FREE training mechanisms are much happier

with their software; they end up really "knowing" how the program works by exploring all of the things that it

can do; as they actually get to see the programs in action, while the setup procedures are explained and

demonstrated. These same customers have felt like they have had personal one-on-one training through the

use of these videos, and that the videos were much more helpful than speaking with a Sunburst Support rep -

due to the fact, that they could really "see" the steps involved. 

Those customers who do not avail themselves of any of the training materials are often dissatisfied and

frustrated, because they do not understand how the program works - they only know what they have been

"told" to do when they call for assistance, on a specific matter. This is a very unsatisfactory feeling, for both

the user and our support staff.

Sunburst Software Solutions, Inc. defines Technical Support as "Knowledgeable people assisting the users

of our software products".  Our software  programs have been designed to be very user friendly and

straightforward - requiring you to only enter the information that QuickBooks is incapable of holding and

teaching the program about your company and how you operate, therefore, our technical support services

have been designed to help you solve a specific problem that you are having with a product - rather than

providing training, customization, or other support services (such as QuickBooks training, training new

employees, of what is really considered IT Services/Computer Consulting) - so, the word "assisting" in this

definition is extremely important.

If you call us and we "teach" you to use our software, "walk you" through setup which has been

documented in the "Training Demonstration" or in the manual, train new employees that you hire, or

provide QuickBooks training - that is indeed considered training - and is billable to you.  (See Paid

Training)

If you call us and we help you with an error code or a problem you have with our software, answer a

specific question that you have about setup, or listen to your feedback about our software - that is

considered "technical support".

Our Support Policy does include provisions for Free Support , Free Training , Paid Training , and

Program Maintenance .

Our staff leverages 75+ years of QuickBooks, bookkeeping, accounting, software development, and

construction experience.
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8.4.1 Free Support

The most important step that you would undertake to understand about getting help from technical

support people is the amount of detail that you will need to supply to them.  Whenever you get an

error message, be sure to "write down EXACTLY what is says".  Better yet, use ALT - Print Screen to

copy a screen to a clip board, and then use Paste (CTRL - V) to paste the screen into a Word

document.  "It doesn't work" or "It isn't right" will generally not get your problem solved quickly and

efficiently.

1. Initial support:  We offer FREE technical support covering installation, set-up, integration, and

implementation of the software with QuickBooks, valid for 30 days from the date of purchase OR trial

request - while these items are covered in the Audio/Video Training Demonstrations, we will be happy

to answer any questions you might have.  For Construction Application for Payment Solution

(CAPS), we offer 30 minutes of free initial support.  If you purchase both Construction Application

for Payment Solution and Certified Payroll Solution together as a package, we offer 1 1/2 hours of

free initial support.  Prior to contacting Support, and in order for our support team to better serve

you, as well as, for you to better understand resolutions that might result from this contact, we

strongly urge you to take the time and go through the FREE Training Demonstration(s) provided on

your installation CD or online, as they will cover most, if not all, of your questions.
2. Free full year product updates/enhancements:  Sunburst Software Solutions, Inc. will maintain your

existing product under the following conditions.  For the first year of use, you will receive free

upgrades to your product; including, but not limited to:  changes to reporting/billing formats,

compatibility updates for the newest version of QuickBooks®, and any product enhancements that may

result during this time.  You receive these updates by accessing the Web Service Center through the

doorway in your program and NOT through our normal website.  Your Key is in the Help Menu->About-

>Login....
3. Errors & Bugs:  It is through our customer relations that the products evolve with enhancements and

upgrades.  Known errors are documented in the On-line Support Area at http://www.

sunburstsoftwaresolutions.com/caps-errors/view-category.htm (this should be the first place that you

look); and those that are not, do have a solution.  We will find that solution for you!   Support applies

to the first year of ownership for the product(s) you have purchased and continues by maintenance

agreement for any year, thereafter.
4. On-line Support Area:  The On-line Support area http://www.sunburstsoftwaresolutions.com/

technical-support.htm is designed for user self-help and contains links to: common problems, common

error messages, troubleshooting resources, newsletters, etc.  In this area, you will find the most up-

to-date listing of all previously encountered problems and error messages.  The support area is fully

searchable using keywords, such as, an error code or message.
5. On-line Forum:  For basic ongoing free lifetime support, use our Support forum at http://www.

sunburstsoftwaresolutions.com/support-forum/.  Through the use of this forum, you may ask

questions, request enhancements, post problems about CPS, CAPS, Wage Manager, or QuickBooks,

that you are experiencing.  You do not need to use our products in order to use this forum.  Posts are

usually answered within a business day.
6. Another great aid for troubleshooting "blank spots" on your billing is provided in detailed

documentation. Read this "resource" to know where each piece of information comes from that is

required on the Application for Payment AND the Continuation Sheet, from the CAPS Help menu--

>Where Does Info Come From.

http://www.sunburstsoftwaresolutions.com/aia-billing-caps/
http://www.sunburstsoftwaresolutions.com/caps-errors/view-category.htm
http://www.sunburstsoftwaresolutions.com/caps-errors/view-category.htm
http://www.sunburstsoftwaresolutions.com/technical-support.htm
http://www.sunburstsoftwaresolutions.com/technical-support.htm
http://www.sunburstsoftwaresolutions.com/technical-support.htm
http://www.sunburstsoftwaresolutions.com/support-forum/
http://www.sunburstsoftwaresolutions.com/support-forum/
http://www.sunburstsoftwaresolutions.com/support-forum/
http://www.sunburstsoftwaresolutions.com/support-forum/
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8.4.2 Free Training

We realize how important it is for you to "understand" how your new software program works, not

only how it integrates with QuickBooks, but exactly what it does, and how it does it.  Because of

this, we provide a wealth of "Free Training Materials and Resources", not only in our manuals and in-

program help, but also, in our Construction Application for Payment Solution Online Training,

Support & Resource Center - http://www.sunburstsoftwaresolutions.com/aia-billing-caps/ 

1. Self-Paced Flash and/or .PDF Training Demonstrations:  Flash and/or .PDF Training demonstrations

are provided on your installation CD or on-line.  This training shows how Construction Application for

Payment Solution (CAPS) will interface and utilize your existing QuickBooks data.  These

demonstrations take you on a guided setup tour and an overview of how it all works, and will take

approximately 20-30 minutes of your time.  

2. Free Audio/Video Training (Plays with Flash OR Windows Media Player - requires sound):

 are available on your installation CD or in the Construction Application for Payment Solution On-line

Support area at http://www.sunburstsoftwaresolutions.com/construction-application-for-payment-

free-training/view-category.htm 

Construction Application for Payment Solution - Download & Installation - Provides a complete

overview of how to download the Construction Application for Payment Solution program

electronically from the Web Service Center, save it to the hard drive of your computer, and install

the program.  9 minutes.

 Construction Application for Payment Solution - Initial Setup - Walks you through entering

your license information, granting CAPS permission to access your QuickBooks file, and the initial

setup of CAPS, and various AIA Billing preferences, not handled by QuickBooks.  22 minutes.

Construction Application for Payment Solution - QuickBooks Setup - A review of your

QuickBooks company file setup and the information that CAPS "expects" to find there, in order to

accurately generate your AIA Billings.  30 minutes.

Construction Application for Payment Solution - Running CAPS - An overview of running your

first set of AIA draws, and the creation of one-time linked records to hold additional information

that QuickBooks has no means of tracking.  30 minutes
3. Whitepaper/Technical Documentation:  Available to download as a .PDF file from the Support Area.

The white paper, combined with the Demonstration, will provide you with a very thorough overview of

the setup and use of Construction Application for Payment Solution.
4. Quick Start Guide:  Each manual provides a Quick Start Guide that provides you with the specifics of

the setup required in QuickBooks, as well as, our programs.  Each item on the Quick Start Guide refers

you to a specific page in the provided manual for all the details.
5. Comprehensive Manuals:  We have made every effort possible to include a comprehensive manual

detailing setup, common problems, error messages, as well as, QuickBooks tips and tricks, to help you

utilize your accounting software to its fullest capacity.  These tips are provided as a "Free Added

Bonus", are specific to the commercial construction industry, and are not available in other

QuickBooks training manuals.
6. Program Help:  Additional QuickBooks tips, tricks, and useful memorized reports that are found in

either the CPS or CAPS Program Help file.  In Program Help is easily accessed from each screen, by

clicking on the big ?-mark in the lower right corner of each screen.
7. Free QuickBooks Training:  There are very few resources for contractors on "how to use QuickBooks

in the commercial construction industry".  We offer such resources in our Free Quarterly Newsletter -

QuickBooks for Contractors, and keep an archive of the articles from previous newsletters right here

on our site in the on-line support area.
8. Once you have applied all the FREE information available for your review in the Training

http://www.sunburstsoftwaresolutions.com/aia-billing-caps/
http://www.sunburstsoftwaresolutions.com/construction-application-for-payment-free-training/view-category.htm
http://www.sunburstsoftwaresolutions.com/construction-application-for-payment-free-training/view-category.htm
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Demonstrations, either from the CD or on-line, your Basic Training Questions and clarifications

will be handled by phone, email, or forum posts.
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8.4.3 Paid Training

It is understood that not all questions/problems can be addressed through free training avenues. 

Therefore, additional training options are available through the purchase of Paid Training/Support

Plans.

If you HATE reading manuals.  Feel that Audio/Video and Flash Training Demonstrations

are not enough.   Are Feeling totally overwhelmed by the software and want "personal

training".  Then, interactive installation, setup, and training for Certified Payroll Solution

and/or Construction Application for Payment Solution, are probably for you.  Interactive

plans, using a combination of teleconferencing and internet desktop sharing is available,

however, this is NOT included in your initial purchase price and is considered billable (see

below for pricing plans).  Contact us to schedule an interactive training session; 24-hour

advance notice is required.

1 hour training contract - good for 1 year:  minimum call will be billed at 30 minutes.  $100.00

2 hour training contract - good for 1 year:  minimum call will be billed at 30 minutes.  $190.00

4 hour training contract - good for 1 year:  minimum call will be billed at 30 minutes.  $360.00

*NOTE:  Training plans may be purchased directly from our Order Page http://www.sunburstss.com/order-

information.php 

8.4.4 Maintenance

We believe in maintaining your original program - it's easier for us and more affordable for you, therefore,

maintenance will be billed annually at the beginning of the month of your original purchase, and will be

effective for an entire year.  Basic Maintenance includes, but is not limited to:  compatibility updates for use

with new versions of QuickBooks, changes to reporting/billing formats, changes to reporting/billing

mandates, and product enhancements.  Your first year of maintenance is included with the purchase of your

product(s). 

Product updates are available from our Web Service Center which can ONLY be accessed from within the

program, by going to the Help Menu, choosing Check for Updates .  Maintenance pricing is as follows:

Construction Application for Payment Solution Maintenance:  $50.00 per year and includes the

above, plus 1 free support incident.

You will be notified via email when an update is available.  Updates on CD are provided for an additional fee

of $25.00 per year, and is available upon request.

Support Policy Last Updated on December 15, 2006 and made clearer on 9/05/07.
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